
PHOTO
STORY
 DELUXE

English language manual



 

2   

www.magix.com 

Copyright 
This documentation is protected by law.  

All rights, especially the right to duplicate, circulate, and translate, are reserved. 

No part of this publication may be reproduced in the form of copies, microfilms or 
other processes, or transmitted into a language used for machines, especially data 
processing machines, without the express written consent of the publisher. 

All copyrights reserved. Errors in and changes to the contents as well as program 
modifications reserved. 

Copyright© MAGIX Software GmbH, 2002 - 2018. All rights reserved. 

MAGIX is a registered trademark of MAGIX Software GmbH. 

Other mentioned product names may be registered trademarks of the respective 
manufacturer. 

This product uses MAGIX patent pending technology. 
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Preface 
MAGIX Photostory Deluxe gives your photos a new lease on life: Transform your 
photos and videos from digital cameras, smartphones and video cameras into fantastic 
slideshows. Add your own personal touch with text, music and cool effects in HD, 4K 
and 3D.   

Enjoy your photos together with your family and friends on TV or on your PC. Play your 
pictures just like a feature movie with great transitions and effects as well as narration 
and subtitles. Add intros and outros or invent your own closing credits. Transform your 
TV into the silver screen! 

Create attractive DVD menus that match the format of your slideshow. Burn your 
slideshow together with a professional menu to DVD, Blu-ray Disc or AVCHD. 

You can find a detailed PDF manual in the start menu of MAGIX Photostory Deluxe. 
The electronic manual can be opened using "F1" to provide a more detailed explanation 
of the options, dialog boxes, menus, and program interface.  

A word on terminology (view page 19): the terms "slideshow" and "photostory" mean 
the same thing. In the following, we'll use both the terms "slideshow" and "photostory" 
because they're used in MAGIX Photostory Deluxe. 

Have fun with MAGIX Photostory Deluxe! 

Note regarding special program versions: This documentation describes the full 
range of features in MAGIX Photostory Deluxe. The range of features may differ in 
the program version/edition you have acquired.  
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Video 360 
If you received MAGIX Photostory Deluxe as part of the Video 360 package, in 
addition to the other software components you also have access to a range of extra 
services: 

Catooh: Redeem your coupon at www.catooh.de and select $35.00 worth of MAGIX 
content. 

Premium telephone support: Use the Telephone Support coupon by contacting our 
MAGIX Technical Support Team (please refer to the section "Premium Telephone 
Support"). 
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Customer Support 
Dear MAGIX customer, 

Our aim is to provide convenient, fast and solution-focused support. To this end, we 
offer a wide range of services:  

• Unlimited online support: 
As a registered MAGIX customer, you have unlimited access to web support 
offered by the MAGIX service portal support.magix.net. You have access to an 
intelligent help wizard, high-quality FAQs, patches and user reports that are 
constantly updated. 
The only requirement for use is product registration on www.magix.com. 

• Online Community as an immediate support and exchange platform: 
The Online Community www.magix.info is available for free to all registered 
MAGIX customers without any limitations. The community includes approx. 
175,000 members and offers the opportunity to ask members questions 
concerning MAGIX products as well as use the search function in order to search 
for specific topics or answers. In addition to questions & answers, the knowledge 
pool includes a glossary, video tutorials and a discussion forum. The multiple 
experts, found round-the-clock on www.magix.info guarantee quick answers, 
which sometimes come within minutes of a question being posted. 

• Premium Telephone Support: 
If you have received MAGIX Photostory Deluxe as part of the Video 360 
package, you have access to Premium Telephone Support. During the Video 360 
subscription period you have two tickets per year which can be redeemed using 
the coupon code. 
The coupon code can be found in the Video 360 order confirmation. 
Use the Telephone Support coupon by contacting our MAGIX Technical Support 
Team at the listed number and following the instructions: 

Telephone: 0203 3183666 (UK and IE Costumers) 

1-775-562-0527 (US) 

AU and ZA Costumers: Please contact the office that is nearest to 
your location. International call charges may apply*. 

Accessibility: Monday - Friday (business days) 9:00 am - 4:00 pm 

 * Please remember to add the appropriate country code for the 
country you are dialling, 001 for the US and 00 44 for the UK 

Important Notice: The coupon code for Telephone Support can be used twice within 
one year after the conclusion of the contract. If the annual license is renewed, the 
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same coupon code can be used again twice within one year after conclusion of the 
contract renewal. 

• Email support for MAGIX products: 
For each new MAGIX product you will automatically receive 12 months free 
customer support by email. 

• Premium Email Support: 
For priority support, or if you want the support team to help with non-MAGIX 
related hardware problems you can purchase a premium email support ticket. 
Proceed as follows: 

1. Go to the MAGIX customer support page at http://support.magix.net. 
2. Sign in using your login details. 
3. Click on "Buy access code" in the navigation bar. 

Each ticket corresponds to a specific problem, it will remain valid until the 
problem has been solved. A ticket is not limited to a single email.Log in at 
http://support.magix.net and click on "Purchase access code". The ticket is 
not limited to one email, it corresponds to a specific problem and remains so 
until the problem has been solved.  

Please note: In order to be able to use the Premium email support and free product 
email support online, you have to register your MAGIX product using the serial 
number provided. This can be found on the CD case of your installation disc or on the 
inside of the DVD box. 

• Additional telephone service: 
As well as the large number of free customer service offers, we also offer a 
fee-based telephone customer service. 

Here you can find a summary of our technical support telephone numbers: 

http://support.magix.net/ 

Mail (Europe): MAGIX Development Support, P.O. Box 20 09 14, 01194 Dresden, 
Germany 

Mail (North America): MAGIX Customer Service, 1105 Terminal Way #302, Reno, 
NV 89502, USA 

Please make sure you have the following information at hand: 
• Program version 
• Configuration details (operating system, processor, memory, hard drive, etc.), 

sound card configuration (type, driver) 
• Information regarding other audio software installed 

http://support.magix.net/�
http://support.magix.net/�
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MAGIX Sales Department 

You can reach the MAGIX Sales Department workdays for help with the following 
questions and problems: 

• Orders 
• Product consulting (pre-purchase) 
• Upgrade requests 
• Returns 

Europe 
Monday - Friday, 09:00-16:00 GMT 

U.K.: 0203 3189218  

Denmark: 45 699 18763 

Sweden: 46 852 500713  

Finland: 35 89 42419023 

Norway: 47 210 35843 

North America 
9 am to 4 pm EST Mon-Fri 

Phone: 1-305-722-5810  
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Particularities for purchases made through 
Steam™ 
Different conditions apply if you have purchased the program through Steam™. You 
can find more information at https://support.steampowered.com . 

https://support.steampowered.com/�
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System requirements 
• For Microsoft Windows 7 | 8 | 10 
• 64-bit systems 

Minimum configuration & HD output 

• Processor: 2 GHz 
• RAM: 2 GB 
• Graphics card: Onboard graphics card with a minimum screen resolution of 1280 

x 768 pixels 
• Hard drive space: 2 GB free hard drive space for program installation 
• Optical drive: DVD drive 
• Burning: CD-R, DVD or Blu-ray burner 

Note: An Internet connection is required for program registration, validation and 
individual program features. HEVC encoding requires fee-based activation for copy 
protection reasons. MP3 export requires installation of Windows Media Player 
Version 10 or higher. 

Recommended configuration for 4K/HD editing 

• Processor: Quad-core processor with 2.8 GHz or better 
• RAM: 4 GB 
• Graphics card: Dedicated graphics card with at least 512 MB VRAM 
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Serial number 
A serial number is included with each product. This serial number is required for 
software activation. Please store this number in a safe place. 

What does a serial number do? 
With a serial number your program license is clearly assigned to you and only you. 
This allows you to use the free customer service via email.  

Serial numbers also help protect against software piracy. This makes it possible for us 
to offer our customers the most value for their money. 

Where is the serial number located? 
The serial number is on the insert card in the program box. 

If you have purchased the download version, you will receive a confirmation email 
containing the serial number that you can use to activate the program. This will be 
sent immediately following purchase to the email address you provided. 

When is the serial number needed? 
The serial number is required when you start the program the first time, as well as for 
program registration. 

Deactivate program... 
Using the serial number on another computer 

If you want to use the serial number on another computer or after reinstalling your 
operating system, you must deactivate (view page 183) the program on your current 
PC. 

This "releases" the serial number from the current computer so that it can be used on 
another. 

Note: You can also deactivate the program in the MAGIX Service Center, but it is 
much more convenient to do this with the integrated feature in MAGIX Photostory 
Deluxe. 
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Update Service 
We know that many of you find it frustrating to have to wait a whole year for our next 
update knowing that we are working on (and likely finished) creating new cutting edge 
features and additional content. For us it was also unsatisfying to wait twelve months 
before making the results of our hard work accessible to our customers. 

So we’re changing the model. From now on, we're no longer publishing in yearly 
intervals, but only when something new is finished. We believe this move away from 
once-a-year major updates and towards a more regular update process is better for 
our customers. 

To this end, we have developed the Update Service. For 365 days after the purchase, 
your get free access to all program upgrades, patches and program features for 
MAGIX Photostory Deluxe released in this period. 

After the expiration of this year period, you can decide whether on not you would like 
to renew your subscription to the Update Service for a fee. You can do this in the 
MAGIX Photostory Deluxe update dialog. 

It’s important to note that our update service is not a subscription. The program you 
purchased is your property. You can keep it, and it will continue to function, without 
your having to pay anything more. If after the expiration of 365 days you decide 
against prolonging the Update Service, you will simply lose access to additional 
updates, new contents and online services. 

Note: If you don't extend the update service, program updates will continue to work 
after the 365 day period. However, if you reinstall the program, updates from this 
period will no longer be included. The software will be reset to the state before the 
time of registration. 
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Introduction 

What is MAGIX Photostory Deluxe? 
The name says it all: MAGIX Photostory Deluxe puts your photos and movies onto a 
CD or DVD as a slideshow that can then be viewed on your PC screen or TV just like a 
movie. Along with "classic" DVDs, you can also burn Blu-ray or AVCHD Discs. 

A typical case: Your hard drive is full of digital photos from your camera or scanner. 
What to do with all those photos? MAGIX Photostory Deluxe will tidy everything up, 
put it together and add transitions, music or effects to create an exciting slideshow.  

What's so special? A personal slideshow is created, professionally arranged just like a 
feature movie. Then you can burn it to a disc and even include additional photos. The 
disc can be played back on any compatible player and you can enjoy it on TV. There 
are also many more possibilities for exporting slideshows as movie files or present 
them directly online. 

Note regarding special program versions: This documentation describes the full 
range of features in MAGIX Photostory Deluxe. The range of features may differ in 
the program version/edition you have acquired. 

What's new in MAGIX Photostory Deluxe? 
• New Photo Effects: Photo effects have been extended to include Add Noise, 

Cookie Cutter, LAB Color, Lens Flare, and Levels. 
• Full-screen editing in the main interface: The preview monitor can be set to 

full-screen mode, where you have quick access to the most important editing 
functions and effects. 

• Cloud import: (view page 46) With the help program Netsync, you can import 
images directly from the Google Cloud or your mobile phone into MAGIX 
Photostory Deluxe.  

• In-App-Store: (view page 49) You can purchase new content directly from 
MAGIX Photostory Deluxe via the store. 

Only in the latest version: 
• 360° footage (view page 78): Import and edit photos and videos taken with the 

latest 360° camera models. 
• Image edge effects: (view page 81) Remove black edges from photos. 
• Camera MX media transfer: (view page 93) Direct transfer of pictures from your 

smartphone to Photostory. 
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• Beat-based editing (view page 81): Easily create transitions that perfectly match 
the beat of your chosen music. 

• proDAD Mercalli V2 (view page 65): The Mercalli V2 plug-in provides perfect 
stabilization to fix shaky footage. 

• Brand new templates (view page 112): A wide selection of dynamic editing 
templates and effective presets for titles and text. 

•  Optimized Photostory Wizard: (view page 21) Takes you from your raw 
material to breath-taking slideshows in a few, easy steps. 

• Features a completely redesigned program interface for improved ease of use. 
• Automatic shot match: (view page 67) Apply the look of one photo to another. 
• Tons of new design elements, such as intros and outros. 

Properties 
Supported formats 
Import Formats 

Video: (DV-)AVI, HEVC/H.265*, MPEG-1/2/4, M(2)TS, MXV, MJPEG, MOV, 
WMV(HD) 

Audio: WAV, MP3, OGG, WMA, MIDI 

Images: JPEG, BMP, GIF, TIF 

Export Formats 

Disc: DVD, Blu-ray Disc 

Video: (DV-)AVI, HEVC/H.265**,  MJPEG, MPEG-1/2/4, MOV, WMV(HD) 

Audio: - 

Images: JPEG, BMP 

*HEVC encoding requires fee-based activation. 

Editing 
MAGIX Photostory Deluxe provides a large number of multimedia features that help 
you really get the best out of your photos and make fascinating slideshows from them. 
For example: 

• Photostory Wizard: The Photostory Wizard lets you edit your slideshows using a 
large selection of style templates and background music. A cinematic effect is 
added to your slideshow by timing the picture changes to match the music. Your 
photos and videos are transformed into spectacular visual stories that you can 
share with friends and family time and time again. 

• Camera MX media transfer: Use Wi-Fi project transfer to transfer photos from 
your Android phone to Photostory Deluxe for editing. You can turn live shots into 
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animated GIFs, add cool live effects and filters in the blink of an eye, and share 
them on Instagram and other platforms. 

• Multiple program modes:  
In Storyboard mode, several photos are listed in sequence. Zoom in to view all 
photos displayed in multiple rows with small preview icons to maintain an 
overview of all pictures.   
In Timeline mode, photos are displayed chronologically on 8 tracks. 
Template mode: 

• Image optimization: Fixes typical image defects (exposure, color, red eyes...). 
Picture size and position can be corrected by increasing the size, rotating, 
clipping, leveling the horizon, etc. Each edit is non-destructive, i.e. the original 
photos remain unchanged. 

• Zooms & camera pans: Zoom into the photo, then pan through the image. 
• 3D effect templates to reshape motifs and have them fly through the picture. 
• 1-click animations for transforming photos into videos (e.g. jumping, mosaic, 

kaleidoscope). 
• Decorative elements and superimposed videos with cartoons, speech bubbles, 

costume accessories, frames... 
• Multimedia opening and closing credits with video templates including sound, 

personal texts and motifs 
• Transitions: Alongside the many variations for "simple transitions" (e.g. soft 

fades, black fades, page turn, wave), there are also complex transitions like 
picture-in-picture fades or thematic 3D fade series (gallery, photo table, notice 
board). 

• Titles and title templates: Add texts to your templates, e.g. by displaying text as 
subtitles, captions or in speech bubbles.  

• Audio dubbing & Soundtrack: You can add audio files and CD tracks to the 
original soundtrack of your photos and videos, record your own speaker 
comments or use the integrated MAGIX Soundtrack Maker to add your own 
music to the soundtrack. Use one of the many professional audio editing effects 
to enhance the soundtrack further.  

• Slideshow Maker automatically turns tiresome photo series into spectacular 
multimedia shows. For particularly fast results. 

• Special features: Travel route animations, stabilize videos, picture-in-picture 
collages, assemble panorama images, and much more. 
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Burning 
You can use the "Burn" interface to burn a disc from your photos and slideshows. 
Before you do that you can design a professional menu screen for selecting your 
slideshows and photos using a remote control. 

The following disc types can be burned: 

• DVD: The slideshows are made into a classic movie DVD in excellent quality. 
• Blu-ray Disc: Also a high-resolution disc format for playback on a TV.  Requires 

a suitable player (Blu-rayTM player) to be connected to a TV. You also need 
special Blu-ray discs and a Blu-ray burner in your PC. 

• AVCHD: Similar to Blu-ray Discs but you can also use regular recordable DVDs 
for burning. You need an AVCHD compatible Blu-ray player for playback on a 
TV. 

Export 
The "export" dialog contains additional options for saving your slideshows. 

• Save on computer: Classic video file export for viewing on your PC, sharing or 
further editing with other programs. 

• Export to mobile device: You can directly transfer your slideshows to connected 
smartphones, digital picture frames, organizers, gaming consoles and other 
external devices. 

• Upload to the web: You can log in to YouTube, Facebook and Flickr to share your 
finished projects. 

• Archive project on hard drive or disc: This is a good final cleanup step after you 
are finished working on your project. 

Note regarding special program versions: This documentation describes the full 
range of features in MAGIX Photostory Deluxe. The range of features may differ in 
the program version/edition you have acquired. 
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Projects, slideshows and photos 
In MAGIX Photostory Deluxe you can work with "projects", "slideshows" and "photos". 
In order to work quickly and intuitively, is it important to know the differences between 
these three hierarchically-ordered terms. 

Project A "Project" includes everything that you want to include on a disc. This 
normally contains one or more slideshows and includes a menu 
structure/menu design which allows you to choose a slideshow later 
on the disc. Projects can be saved as "<Pojektdatei>" files on your hard 
drive and can be loaded later for further editing. 

Slideshow A slideshow is a multimedia presentation of photos which is played 
like a movie. Enjoy it on a PC or TV, since it offers maximum 
multimedia entertainment value from photos, videos, music, title texts, 
transition effects, and much more.  

Any slideshow can be exported individually as a video. The "project" 
can be considered a type of drawer into which you can put multiple 
slideshows for burning to disc later. 

Photos Photos are the main part of your slideshows. You can import photos 
and videos into your slideshow (the right video codec has to be 
installed on your system). Besides photos and videos, a slideshow also 
includes plenty of other elements: image titles, transitions, decorative 
elements, music, spoken commentary... 

Summary: "Projects" include "Slideshows", "Slideshows" include "Photos". 
Slideshows of a project appear as menu entries, photos (as well as videos) appear as 
sub menu entries of these entries for navigation on the finished disc. 
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Photostory Wizard 
The Photostory Wizard allows you to create complete slideshows quickly and easily. 
You can even apply sounds and effects. Here's how it works: 

Starting the Photostory Wizard 
Start MAGIX Photostory Deluxe by double clicking the program icon on the desktop or 
by accessing MAGIX Photostory Deluxe via the Windows Start menu. The first time 
the program is started, you will have to enter the serial number. More information 
about this can be found in the chapter "Serial number (view page 14)". 

 
• Select "Create Photostory" to start the Photostory Wizard. 

Under "More options" you can specify the settings for a new slideshow: 

• Crop photos to fill the frame or fit photos into a format. 
• Use 4:3 or 16:9 format. 
• Start manual editing in Timeline or Storyboard mode. 
• Copy all media in project folder. Select a project folder if you want to create 

copies of the photos you're using for your photostory. This option is available 
when you import objects from a removable disc. 
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Selecting photos 

 

 Tip: Click on the question mark to learn more about the basic functions in 
the Photostory Wizard. 

1. Select the folder containing your photos/videos. (1). All objects will be displayed 
in a list (2). 

2. Zoom out to get a better overview of more objects; zoom in for more details (3). 
3. Select an object by clicking on it. 

Keyboard shortcuts: Ctrl + A selects all displayed media, the spacebar selects the 
currently selected medium. 

 
Sort: Use this to sort the overview according to type, in ascending order or 
descending order. 

 

 Select: Click on "Select All" to select all objects in the current folder. If you 
have selected several objects, you can remove these objects by clicking 
"Reverse selection". "Clear selection" deselects all objects. 

 

 
Preview: Displays a preview of your photos/videos. 

 
Rotate: For rotating sideways photos. 

• To create a sequence with the photos you've selected, click "Sort" (4).  
This opens an overview page into which you can drag & drop photos into the 
position you want. 

• If you want to switch directly to the main program for MAGIX Photostory Deluxe 
without applying a template, click on "Direct import" (5). 

• Once you've marked and sorted all the photos you want to use for a slideshow, 
click on "Create Photostory" (6) to select a template. 
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Select template 
This opens the Photostory Wizard's templates and editing dialog. 

 

1. Select songs for your photostory (music template) or select a movie template with 
defined cuts, effects and background music (1). 

 

Music templates:  

All selected photos are played one after another with previously added and 
selected music. Transition effects are also added. To add a song, click on "My 
Music" and the large plus (+) button. 

 

Movie templates:  

Movie templates feature a limited number of placeholders. Media from your 
slideshow will be used to fill the placeholders of the selected movie template 
until all placeholders are filled. The length of the slideshow depends on the 
length of the movie template. 

 

 
Titles (only under music template): You can add an intro and outro text. 

 
Display duration under music template: Use the slider to choose a display 
duration value for photos between short and long. Play around with the slider 
to find a duration you like.  

Display duration under movie template: Select the slideshow duration. 
"Dynamic" automatically determines display duration according to the 
available media.  
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Effect intensity (only under music template): Set the effect intensity between 
subtle and strong. 

2. Click on "Generate Photostory" (2). MAGIX Photostory Deluxe will create a 
slideshow using the selected template and chosen settings and then play it (3). 

 
Show/hide arranger (4): The contents of the current slideshow can be 
displayed. All photos included in the slideshow are displayed and can be 
individually selected. 

 

 
Optimize object (5): With this button, you can select an object in the arranger 
(4) and open the standard options for optimization.  

 

 
Effects at random (5): If you aren't happy with the effects applied to a photo 
in the template, select the photo in the arranger (4) and click this button. This 
will apply a new effect at random. 

 

 
Delete: If you see a picture in the preview that you want to remove, select the 
photo in the arranger (4) and click the Delete button. The photo will be 
removed without leaving an empty space in the photostory. 

 

 
Fullscreen on/off: Switch into the fullscreen mode for the optimum preview 
experience. 

3. Click on "Generate Photostory" (2). MAGIX Photostory Deluxe will generate a new 
slideshow and then play it (3). 

Export or edit slideshow 
Once you're happy with the results, you can export your slideshow as a file (view page 
162), burn it to DVD (view page 139), transfer it to another device (view page 163) or 
upload it online. You can also save the project for further editing at a later stage. 

 
Finish: Choose what you want to do with your 
slideshow. 

or 

Edit manually: Click here to manually edit your slideshow and its contents in detail. 
This will take you to the main MAGIX Photostory Deluxe program interface with the 
open project from the Photostory Wizard. 
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Photostory quick start 

Program start 
Start MAGIX Photostory Deluxe by double clicking the program icon on the desktop or 
by accessing MAGIX Photostory Deluxe via the Windows Start menu. The first time 
the program is started, you will have to enter the serial number. Additional information 
can be found in the "Serial number" (view page 14) chapter. 

When you start the program, a welcome dialog will appear. 

 

Create Photostory: Starts the Photostory Wizard (view page 21). Create complete 
slideshows in a matter of clicks. 

Create empty project: Opens MAGIX Photostory Deluxe in the main user interface. 
Create slideshows completely manually. 

Load slideshows: Load saved slideshows and continue working on them. 
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• Choosing "Empty project" will open a new, empty project in the program 
interface which you can fill with your own pictures. 

 

Load photos 
The Media Pool is to the right.  

• Open a folder containing photos by using the navigation button.  

 

All photos, including all other useable files, will be listed in the Media Pool. Moving 
over the file list with your mouse will bring up a small selection box where you can 
either active a preview for the file in question or load the file directly. 

 

The right-facing arrow activates the preview. The 
downward-facing arrow loads the file into the project. 
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You can select and load all the photos you want to use one after the other. 

 

Are your photos upside down or sideways?  

• Use the rotation button on the preview image to rotate any photo until it is 
displayed properly. 

 

To play your slideshow, press the space bar or use the transport console below the 
preview window.  

 

Each photo is shown one after the other in the video monitor. 

Sorting photos 
Now you should put the photos in the right order. In a good slideshow, the pictures tell 
a story that has a beginning, middle and end and includes lots of dramatic tension that 
builds up to an exciting climax. 

This is easy to do with a slideshow about your last vacation because the dramatic 
composition is already there. It starts with pictures of the departure and then shows 
pictures of your arrival at the hotel and then the first adventure...  

This is not necessarily the case for other slideshows; in this case you should consider 
the order in which you present the photos. The question of selecting and sorting also 
depends on the purpose of your slideshow.  

Sorting the photos is easy: 
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• Drag each photo from the photo bar and drop it on the correct position.  

If you are working with a lot of photos, you should maximize the overview. 

 

 
Enlarge/reduce view: This lets you sort your photos more easily.  

If all photos don't fit into the list, you can use the zoom to reduce the size of the 
display. 

Editing slideshows 
MAGIX Photostory Deluxe provides many different editing features. 

Storyboard mode 

 

 

Each thumbnail has several settings for duration, 
transitions, effects, and text. 

 

 Set display time: Double-clicking on the time display under the preview 
image takes you to an input dialog where you can set the display time by 
number or by moving a slider. 

 
Transitions: The transition (fade) buttons are situated between the photos. 
You can now try out the available transitions in sequence and view the 
result on the video screen immediately. 

 
Add titles and text: You can easily apply titles (e.g. subtitles, 
opening/closing credits) to any photo by clicking this button. 
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Rotation: If a photo is on its side or upside down, click on the symbol with 
the rotating arrow. The photo will rotate 90 degrees. You can check the 
effects directly on the video monitor. 

 
Swap: Swaps the selected object with the object selected in the Media Pool. 
Length adjustment moves the objects following it correspondingly. If photo 
objects are removed/exchanged, then the display duration will remain. 

 
Image editing: Here you can access effects and image editing tools which 
can be used separately on each photo, e.g. optimizing image quality. 

Tip: MAGIX Foto Designer is an additional image editing program that is included for 
more complex single image editing. To load a photo into MAGIX Foto Designer, 
select the option "Effects" > "Image editing (external)" >.... "Start MAGIX Foto 
Designer". You can learn more about MAGIX Foto Designer in the program Help 
section which can be opened by pressing F1. 

Dubbing: If you would like to add spoken commentary to your slideshow, then use the 
record function for audio recording. You can also use audio CDs, records, or tapes. 
Audio CD tracks of non-copy-protected CDs and other audio files can be dragged onto 
the preview photo directly from the Media Pool.  

 
Opens the recording dialog. 

Timeline Mode 

 

The easiest way to access various modes is with the Tab key (you can also click on the 
corresponding icon). 

Timeline mode displays your photos in terms of time. The longer the object appears in 
the track, the longer the corresponding photo will be displayed during playback. 

 

There are eight tracks available.  

All of the material including photos, videos, background music, titles & text, 
transitions, decorative elements etc. appear as "objects" on a track when imported into 
a project. If photo or video files include an audio track, a combined object will be 
created which has image and audio areas. 



 

30   

www.magix.com 

Image objects can be placed on any track and can easily be moved around with the 
mouse. Audio objects can be moved to tracks 2 - 4. 

All objects can be resized using the “object handles” on the lower edges. Move the 
mouse over one of the lower corners of the object until the mouse pointer becomes a 
double arrow. You can now can shorten the object until it is the length you want. An 
object can be faded in or out with the handles to the top of the object. 

Effects are added as objects underneath the "related object" and create a group that 
moves along with the "related object". 

Divide slideshow 
Sometimes you might want to separate your slideshow into two slideshows. For 
instance, if you discover that you have loaded a certain number of images for a certain 
subject and would prefer to have this subject in its own slideshow. 

• Move the photos you want to sort out to the end of the slideshow. The best way 
to do this is to use the Storyboard mode, reduce the view size and zoom out. 

• Place the start marker at the position where you want to split the old slideshow. 
• Select "Separate slideshow" in the Edit menu. 

 

This creates a new slideshow starting at the position of the start marker which 
contains all the material from the old slideshow.  All contents are moved too: Titles, 
soundtrack, transitions, effect settings, object settings, etc. 

Finally, you should enter descriptive names for both slideshows. You can do this in the 
context menu of the slideshow tab.  
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Manage slideshows 
You can manage several separate slideshows in one project to burn them together to 
one disc. In the context menu of the slideshow tab you can add new slideshows or 
import existing ones as well as remove slideshows that should no longer be a part of 
that project.  

• To do this, right-click on the tab.  

 

You can also embed slideshows from an existing project into your project. Select "File 
-> Open", find the desired project on the hard drive, and then click "Open". 
MAGIX Photostory Deluxe will now ask you if you would like to close the current 
project or add the new project. Choose "Add new project" to add slideshows to the 
current project. 
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Create disc menu and burn 
Once you are satisfied with your slideshow you can burn it to a disc.  

Menu view and menu navigation 
To burn a disc, switch to the "Burn" view. 

 

• Click the "Burn" button to get started. 

MAGIX Photostory Deluxe automatically adds graphical disc menu. The menu is also 
burned to disc and appears when inserted into your player. Just like with a purchased 
DVD, you can easily select your slideshows with the help of preview pictures, or 
access particular chapters within a slideshow. 

In the "Preview" view in the "Burn" screen you can access complete menu templates 
and add them by double-clicking.  

If you want to adjust them, you first have to switch to the "Edit" view. 
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• At the center of the monitor you can see a preview of the selection menu. The 
editable elements are outlined. You can move them around or adjust their size 
with the mouse.  

• Double-clicking on an element opens an editor where you can adjust the titles or 
preview images. 

• There are buttons on the right side that can be used for additional editing of the 
menu properties. 

• Use the "Navigation" button to access the structure of the selection menu.  

 

Here you can switch off all chapters that should not be in the chapter menu. 
Deactivate the corresponding box. 

This way, the entry will be removed from the menu only; the related photo will not be 
removed from the slideshow. (More than 99 ticks cannot be made as the DVD player 
cannot list more than 99 entries.)  

In the lower section of the screen you can find a whole row of pre-made menu layouts. 
Use the scroll bar to view each template. There are plenty to choose from: 

• If you wish to fully apply a template, first click on "Templates" in the template bar 
and double-click on the template of your choice. The complete template will then 
be applied. 

• You can also combine the various elements of the individual templates. For 
example, if you want to combine the text format of a template with the 
background of another one, then select "Font" first and double click the template 
with the text of your choice. Then select "Buttons" and double click the button 
you like. The preview in the middle shows you the results immediately. 

• Double click the preview picture or a menu entry to change the movie or chapter 
name and select a different preview picture. 

• Back in the "Preview" view you can use the virtual remote control to test the 
functioning of finished discs to make sure that everything works as planned. 
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Disc selection dialog 

 

In the "Preview" view you can open the disc selection dialog by clicking 
the large "Burn" button. 

 
In the "Edit" view, you can access the same dialog using this button. 

 

 

Here you can select what kind of disc you would like to create.  

• DVD is the right format for projects that will be played back on a normal DVD 
player.  

• Blu-ray and AVCHD are good for playback on high-resolution screens. 

Note: Backup copies 
MAGIX Photostory Deluxe comes with a great feature (view page 170) to quickly and 
easily back up your entire project, including video objects, effects etc. It's 
recommended that you make regular backups, especially when working with very large 
projects. Doing this will allow you to quickly and easily return to "old" versions of your 
project if, for  example your hard drive crashes or there's a problem with your project. 
This feature can be found under "File" > "Backup copy" > "Copy project and media to 
folder". 
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Photostory program interface 
When you start MAGIX Photostory Deluxe you'll see a slideshow window. This is 
where you load photos and edit your slideshow. This screen provides access to almost 
all the features that are necessary for creating perfect slideshows.  

 

 Menu bar (view page 164): This bar contains all essential editing commands. 

 "Slideshow" interface (view page 35) for creating and editing your slideshows. 

Burn (view page 139) for burning slideshows to disc. 

Export (view page 162) for saving slideshows to your PC or mobile device. You can 
archive your project or share your slideshow by uploading it to Facebook, Youtube 
and Flickr. 

 Media Pool (view page 43) for navigating through the folders of your computer.  

 Video monitor (view page 36) with universal preview function so that you always 
see what the effects and settings do. 

 Video monitor transport console (view page 36) 

 Buttons for quickly toggling between Timeline mode (view page 55), and 
Storyboard mode (view page 53). 

 Arranger in Storyboard mode. The Arranger displays all the photos and videos in 
your slideshow via preview images. 
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Video monitor 

 

Use the video monitor to preview the current slideshow. With the "Full screen" 
button you can switch to full screen playback. Press the "Esc" key to return to 
normal playback. The transport console can be used to begin playback of the 
slideshow. This is located below the video monitor.  
 
 

 
Playback/Pause: The "Play" button plays the slideshow from the start 
marker until the end marker. Clicking on the play button a second time 
pauses playback. 

 
Stop: The "Stop" button ends playback. 

 
Back: This button moves the start marker to the previous picture. This is 
displayed in the video monitor. During playback you can use this button to 
rewind. 

 
Forward: This button moves the start marker to the next picture. This is 
displayed in the video monitor. During playback you can use this button to 
fast-forward. 

 
FX opens the video monitor in full screen mode and the features for effects 
editing in full screen mode. (view page 58). 
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Note: You can fast-forward or rewind using the arrow keys on your keyboard. You 
can also try out the functions of the CTRL or Shift buttons. 

 
Back to start: With this button, the start marker is quickly moved to the 
beginning of the slideshow. 

 
Recording: The "Slideshow" window offers options for audio recording. 
During audio recording, new audio material is inserted at the position of the 
start marker, e.g. commentary. 

 

 
Opens a menu with zoom functions for selecting a range of stereo 3D 
display modes. More information is available in Stereo3D (view page 132). 

 

Zoom: The video monitor includes a zoom feature which can be used to zoom in on 
specific points for more detailed editing (e.g. for selecting color ranges precisely). Use 
Ctrl + mouse wheel in zoom in and out in an image and drag the mouse while holding 
down the Ctrl button to move the visible image section. 

Dynamic resolution reduction:   renders photos in a lower resolution for previews so 
that the program runs more smoothly. Photos will appear in full resolution in the 
exported slideshow. 

 

Use the position slider to move quickly within the project. The current position of the 
playback marker is displayed numerically on the right. 
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Toolbar 
Important editing and effects menu commands are available as buttons in the 
slideshow window. There are different buttons available for each mode.  

Top toolbar 
This toolbar is located right beneath the video monitor in MAGIX Photostory Deluxe 
and is visible in all program modes.  

Create new project: 

 
This menu item opens the Program launch (view page 25) launch dialog. 

Keyboard shortcut:  Shift + N 

Load project 

 
This menu item loads a previously saved MAGIX Photostory Deluxe project. 
Please note that the related files must be accessible. 

MAGIX Photostory Deluxe searches for the used sounds, pictures and videos under 
the path to where you last saved the disc project. 

Keyboard shortcut:  Ctrl + O 

Save project 

 
The current disc project is saved with the name displayed in the project 
window. If you have not yet specified a name for your project, a dialog will open 
wherein MAGIX Photostory Deluxe asks you to do so. 

Keyboard shortcut: Ctrl + Alt + S 

Lower toolbar 
The following buttons are visible in all modes of the "Edit" surface directly under the 
video monitor. 

Cut button and editing menu 
The cut button and cut menu next to it can be found under the transport console. 

 
Use the cut button to cut a selected object in two at the position of the start 
marker. 
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With a click on the small arrow beside the cut button, you can access the cut menu 
which contains further relevant commands. 

Split object 
This command cuts a scene at the point where the start marker is positioned. This 
way, two free-standing objects are created.  

You can isolate a part of an object in order to delete it: 

1. Place the start marker where you'd like to have it by left clicking in the timeline. 
2. Select the video object by clicking on it and click on the cut button.  
3. Place the start marker at the end of the part you wish to remove and click on the 

cut button again. 
4. Select the middle object that was created and press the "DEL" key. 
5. Pull the object at the back to the front; it should automatically snap into place. All 

subsequent objects will be moved along in unison so that no gaps appear. 

You can also use this function to apply effects to a certain part of an object only. 

Keyboard shortcut: T 

Remove object start 
This command cuts a selected object at the point where the playback marker is 
positioned and removes the material located before the playback marker. 

Shortcut:  D 

Remove object end 
This command cuts a selected object at the playback marker position and removes 
the material behind the playback marker. 

Keyboard shortcut: U 

Hint: If the commands "Split" and "Remove beginning/end" are applied without a 
selection, all objects at the position of the playback marker are cut. 

Remove object 
The selected object will then be deleted from current project. The subsequent objects 
are moved forward so that there is no gap.  

Keyboard shortcut:   Ctrl + Del 
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Split slideshow 
This command splits the slideshow at the point where the start marker is positioned, 
making two separate slideshows.  

Note: You can use this function if you wish to include chapter menus and if your 
slideshow already contains over 99 photos. Otherwise, only every second or third 
photo (depending on the number of photos) in the chapter menu, as the number of 
menu entries is technically limited to 99. 

Keyboard shortcut: Alt + W 

Undo 

 
You can undo the last steps you made. This means that you can easily try out 
critical operations. If the result does not meet your expectations, then you 
can simply "undo" it and return to the initial status. 

Keyboard shortcut: Ctrl + Z 

Redo 

 
This function undoes the previous "Undo" function. 

Keyboard shortcut:  Ctrl + Y 

Delete 

 
This command deletes the selected photo (or selected object) in 
Timeline mode. 

Keyboard shortcut:  Del 

Cut 

 
This function deletes the selected photo (or the selected object in the Timeline 
mode) and copies it to the clipboard. You can then use the "Paste" command 
to copy it into any slideshow. 

Keyboard shortcut: Ctrl + X 

Copy 

  
This command copies the selected scenes (or the selected object in Timeline 
mode) to the clipboard. From there you can paste it into any other slideshow 
using the "Paste" command. 

Keyboard shortcut: Ctrl + C 
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Paste 

 
This command inserts the clipboard material (photo or object) at the current 
position of the start marker.  

Keyboard shortcut: Ctrl + V 

Title editor 
Opens the title editor (More information can be found in the section "Title editor" on 
page 104) for the selected photo or video object. 

Shortcut: Ctrl + T 

Rotate right 

 
Rotates the photo 90° clockwise. 

Keyboard 
shortcuts: 

Ctrl + Alt + F to the right 

 Ctrl + Alt + G to the left 
 

Exchange object 

 
Replaces the selected object with an object selected in the Media Pool. 
Length adjustment moves the objects following it correspondingly. 

If photo objects are removed/exchanged, then the display duration will remain. 

Add background 

 
Choose a color, picture, or any video on your hard drive to serve as the 
background for the selected photo. This feature is especially useful when 
photos have black bars around them, or if they are reduced in size. 

Automatic image effects 

 Camera movements, zooms and rotation effects are added to the current 
slideshow automatically. If you have already added effects and transitions 
manually, they will not be affected by this process. 

You can apply this function to the entire slideshow or to a specific range that you can 
select by setting the start and end markers. 
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Only in Timeline mode 
The following buttons are found exclusively in Timeline mode. 

Mouse mode for individual objects 

 
This mouse mode for individual objects enables free positioning of individual 
objects. 

 

Connect objects in all tracks 

 
In this mouse mode all objects located behind the one selected will be 
moved in unison. 

 

Optimize grid view 

 
The start and end markers are moved to the start or end so that all scenes are 
visible and the complete film can be played. Zoom is also set to 100% so that 
all objects are visible. 

Keyboard shortcut: Shift + B 

Set snap markers 

 
To set a snap marker, select an object and place the playback marker at the 
position where you want to place the snap marker. You can set as many snap 
markers as you like per object. You can move a snap marker with the mouse 
using drag & drop. 

Form group 

 
Orders all selected objects into groups. As soon as an object from the group 
is selected, all other objects in the group will be highlighted as well so that 
you can work on them collectively. 

Keyboard shortcut:  G 
 

Ungroup objects 

 
This turns all selected objects into free-standing objects again. 

Keyboard shortcut:  Shift + G 
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Media Pool 
The structure and functioning of the Media Pool is similar to Windows Explorer. The 
only difference is that the Media Pool only displays files that can be used in the 
slideshow. This is used to access and load multimedia files of all kinds: Photos and 
other image files, video files, audio files, transitions, effects, and also complete 
projects. 

 

Note: The Media Pool displays the data on your hard drive. Files that are deleted here 
cannot be recovered in Windows Explorer. 

If you hover the mouse pointer over a media file, two icons for the playback (preview) 
and import features will appear. 

• Preview: All available media can be previewed using the preview feature. If you 
click on the playback icon, the file will be played back in the preview monitor. 
Video and image files are displayed and audio files are played back through the 
sound card. There are previews for the templates and effects included to make it 
clear how they work.  

• Import: All media files from local drives or the Internet can be dragged and 
dropped into the project or loaded through the import icon. 

You can also load files from the Media Pool by double-clicking them. Selected entries 
(including entire folders) can be selected by holding down the left mouse button and 
dragging them into the slideshow (drag & drop). If you want to load several files 
simultaneously, you have to select them in the Media Pool first.  

• Click on the selected entries one after the other while holding down "Ctrl".  
• If you want to load a sequence of files, hold the "Shift" key and click on the first 

entry and then on the last. All entries in between will be selected.  
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• By holding down the left mouse button you can drag out a selection box over 
multiple image files to select them. "Ctrl + A" selects every entry contained in a 
Media Pool folder. 

Tip: Get faster access to the folder with your media files by creating a link in the 
"Import" area of the Media Pool. You can do this by right-clicking on one of the 
entries and selecting "Create link" in the context menu. Select the media folder and 
click "OK" to confirm. 
Note: All links are automatically deleted if the function "Reset standard program 
settings" ("Edit" menu > "Settings") is used. 

Replace existing photos 

Hold down the Ctrl key when dragging photos into the Timeline (view page 55) and 
place the new photo or photos on top of existing photos in order to replace them. 

Insert photos 

Hold down the Ctrl key when dragging photos into the Timeline (view page 55) and 
place the new photo or photos between existing photos in order to insert them. The 
photos following the inserted photo will move backwards. 

Media 

 

Navigation buttons 
The navigation buttons let you navigate through your computer’s drives and folders.  

Forward/back 
 

These buttons access the previously viewed folders.  
 

Up 
 

This button accesses the next highest folder level. 

 

Search 
 

The search function allows you to find specific files 
quickly. You may specify your search according to file 
type, date, or certain folders. 

 

Browse history 
list and path 
details  

The path information for the current folder is displayed 
in the center above. Use the arrow button to open the 
menu to find the folders you previously visited. 
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Options 
 

All functions of the context menu (switch views, 
rename, or delete files, etc.) can also be accessed using 
the options button. 

 

Display options 
 

Settings for how detailed the entries should be listed 
may be made here. 

 

Computer 
The link button "Computer" displays the drives in the Media Pool. All drives will be 
listed along with their drive letters and can be opened with a double click. 

User directory 
The second button featuring the user's name opens their personal folder in the Media 
Pool. 

MAGIX media 
 Animations (.xar): If you have an external editor such as Xara Designer Pro or 
MAGIX Web Designer installed on your computer, there are ready-made animations 
available that can be dragged and dropped into an object. The external editor will open 
to let you "fill" the animation. When the editor is closed, the animation will be inserted 
under the object. 

Manage...: This opens the database management program MAGIX Photo Manager. It 
creates and organizes the database, which can be easily accessed by 
MAGIX Photostory Deluxe. 

Note: If MAGIX Photo Manager isn't installed, a dialog will open where you can 
download the program. Following the download, you can install the program and 
open it here later. 

Downloads: Use this button to access the media files that you downloaded with 
Catooh. 
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Cloud Import 
Use the MAGIX Cloud Import function to import images from your Google Photos 
account to MAGIX Photostory Deluxe. To do this, click on "Cloud Import"  on the 
"Import" tab of the Media Pool. This opens the NetSync tool. 

 

Click "Connect to Google Cloud" and select the Google account that contains the 
photos you want to access. 
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If you are doing this for the first time, you need to grant NetSync permission to access 
your Google account. Log in with your email and password and then click on "Allow" in 
the following screen to authorize NetSync to access your Google account.  

 

Your Google photos will then be displayed. Select the photos you want to import. Click 
"Download" to download the photos you've selected. You can specify the storage 
location above in the dialog. 

 

Once you've finished, you can continue to download more images or close Cloud 
Import. You will return to the NetSync tool, where you can open the files with 
MAGIX Photostory Deluxe right away or display them in the folder. 

Note: The NetSync tool will start together with the system by default, in order to 
transfer images when MAGIX Photostory Deluxe is not running. To modify this 
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setting, you can deactivate the  option "Run NetSync at system start" in the 
settings. 

Travel routes 
Click here if you would like to create a travel route (view page 119).  

Movie templates 
Gives you access to all your MAGIX Photostory Deluxe movie templates (view page 
112), which could serve as a framework for your slideshow. 

Slideshow Music 
This folder contains various songs that can be used by Slideshow Maker. 

Display options 

 

To get a preview of the image files directly in 
the Media Pool, click on the display options 
at the top right and select "Large icons". 

Now all image files in the Media Pool will be displayed with a small preview image. 

 

Title 
This displays the title presets and the title editor (view page 104). The templates are 
sorted into various categories and can be loaded by double clicking or dragging and 
dropping them. The 3D templates are also located here.  

The text in title objects can be changed directly in the preview monitor (by double 
clicking it) or in the entry field next to "title". 
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Effects 
MAGIX Photostory Deluxe offers a wide range of effects and effect settings. The 
"Effects" (view page 58) chapter contains detailed descriptions of each of them. 

Templates 

 

In the "Templates" tab, you'll find all additional content that can be used for your film, 
including titles, transitions, intros/outros and film templates. In addition to the content 
installed alongside MAGIX Photostory Deluxe, you can purchase additional content in 
the Store from directly within the program. 

Following categories are available: 

• Movie and editing templates (view page 112) 
• Intro/Outro animations 
• Transitions (view page 101) 
• Title templates (view page 104) 
• Movie looks 
• Design and Decoration 
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 All Media Pool content is displayed by default. Here, you can filter the display 
according to category, e.g. title or transition. 

Hint: you can switch between List and Tile view odf any content at the bottom 
of this menu. 

 You can use the search field to search for templates by name. 

 Each category contains sub-categories. Click on one to open a detailed view that 
displays the contents separately. 

 

When you mouse over content, three symbols appear: 

 
Use these to load the content to your film. 

 
The preview monitor will provide you with a preview of the content. 

 
Click on the heart symbol to mark the content as a favorite. In the categories 
menu there is an option at the bottom whereyou can toggle the display to 
show only favorite content.  

Tip: You can set the size of the tiles under the three points above right in the detailed 
view. 

 

Audio 

 

Under "Audio", you'll find installed content and offers from the Store for background 
music and sounds. The tab functions the same way as the "Templates" tab. 
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Store 

 

In addition to the content installed alongside MAGIX Photostory Deluxe, you can 
purchase additional content in the Store from directly within the program. 

 

Buy new content 
If you click on a Store tile in the bottom section of the Media Pool, the details for a 
pack will display on the right. 
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The price and size of the pack will be shown, and you can preview the content by 
clicking the Play button. Click Purchase to open the Store window. 

When you make your first purchase, you will be asked to select a currency. Then, log in 
to your MAGIX account. 

 

In the next step, select the payment method and enter the required details. 
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This step will be skipped for later purchases and you will go straight to the "Purchase" 
window. You can also adjust the payment method afterwards by clicking on the pen 
icon next to "Pay with". 

 

Click on "Buy now" to complete the purchase. Your purchase will download 
immediately, as shown by the download progress on the tile. You can use the content 
you have purchased in your projects right away. 
 

Tip: You can download five content items of your choice in the Store. You don't need 
to provide any additional payment information.  

 

Simply try out the Store for free, without obligation. 
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Storyboard mode 
 Storyboard mode is used to view the layout of slideshows. All photos are 

displayed in linear sequence with preview images. It includes different 
buttons, text, effects, rotation, time settings and transitions. 

 
Maximizing the overview will give you the best view when working with a 
large number of photos. 

 

 
Text: The title editor is opened. Enter text, e.g. for subtitles or opening and 
closing credits. 

Texts can be displayed in all kinds of fonts and colors. To make your credits scroll 
down the screen, you can select different movements, effects, and designs from the 
template menu.  

 
Effects: In the "Effects" menu, or by clicking this button, you can select the 
effects for editing sounds and images. 

You can use the "Image editing (external)" feature to open the photo in the separate 
image editing program, MAGIX Foto Designer. After editing the image, it is transferred 
directly to the MAGIX Photostory Deluxe Storyboard. 

Note: For more info on using MAGIX Foto Designer, please read the help file, which 
you can open by pressing the F1 key. 

 
Rotate: If a photo is on its side or upside down, click on the Rotate button.  
The photo will rotate 90 degrees. 

Playback marker: The playback marker will show which object is currently being 
played. It is a vertical line that runs from left to right over the scene as it is being 
played back. 

 
Transitions (Fades): You can also set up the transitions from one photo to the 
next by mouse-clicking on the symbol.  A menu will open from which you 
can select different transitions. 
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Timeline mode 
 In "Timeline mode" your photos are displayed in order: The longer the object 

remains in the track, the longer the corresponding photo will be displayed during 
the slideshow. 

Unlike Storyboard mode, the speed of the playback marker does not change on 
playback.  

You also have direct access to all media files currently being used in the 
slideshow. 

 

Timeline 

  

The progress of the slideshow in the movie is displayed horizontally above the tracks. 
To structure this progression, the actual timeline is visible at the very top above the 
first track. The unit of measurement of the timeline is milliseconds.  

The range between the start and end markers in the timeline is played back as an 
endless loop.  

Tracks 
There are 8 tracks in total for arranging and editing media files:  
• Photos, videos and titles can be put on any of the tracks, even on top of one 

another, e. g. to create a picture-in-picture effect. 
• The fourth track is for additional audio material. Additional audio recordings 

(view page 107) (also called "overdubs") can be placed here, e. g. commentary. 
But audio objects can also be moved to tracks 2 through 8. 

• The remaining tracks sometimes need to be used by certain effects templates, 
but can otherwise be used freely. 
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Zooming 
Keyboard shortcut: The easiest way to zoom is by using the key combination Ctrl + Up 
arrow (for zooming in) and Ctrl + Down arrow (for zooming out).  

 

Zoom menu: Right-clicking on the start marker opens the context menu where you 
can select the most important zoom levels.  

 
Sliders: Use the slider ("fader") to adjust the visible 
clip on the horizontal time axis. Alternatively you 
can use the mousewheel to zoom in and out.  

 

Objects 

 

All of the material including 
photos, videos, background 
music, titles & text, transitions, 
decorative elements etc. appear 
as "objects" on a track when 
imported into a project.  

All objects can be cut uniformly, 
edited with effects and arranged.  

During playback all objects on all tracks are mixed together automatically. When 
moving a photo, all related objects will be moved along with it, for  example, audio 
recordings, frames and text objects. 

Combined objects 
If photo or video files include an audio track, a combined object will be created which 
has image and audio areas. The video's audio material is displayed in the lower 
section.  
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The audio track can be removed and reinserted into the combined object by 
right-clicking. The automatic volume reduction (view page 131) and sound 
optimization (view page 85) can also be started (in "Audio and waveform display"). 

Object cutting and fades 

 

All objects can be shortened with their lower edge “object handles”. 
Move the mouse over one of the lower corners of the object until the 
mouse pointer becomes a stretch symbol. You can now can compress 
the object until it is the length you want. 

At the top ends of every object you'll find two fade handles that can be 
adjusted to fade an object in or out. 

 

Context menu 
Right-clicking on an object opens the context menu with effects. It is equipped with 
the same effects as in the Storyboard mode and the Effects menu.  

Duplicate objects 
Small objects (for example, audio loops) can be duplicated very easily. First, the 
objects that need to be duplicated must be selected. Activate the copy command and 
then the Insert command ("Edit" menu or via the buttons in the Timeline mode). 
Speed up this process by clicking on the object to be copied with the mouse while 
holding down the "Ctrl" key. This generates a copy which you can immediately drag to 
the desired position.  

Mouse modes 
With these mouse modes you can specify various working methods of 
MAGIX Photostory Deluxe when moving objects. 

Mouse mode for individual objects 

 
This mouse mode for individual objects enables free positioning of individual 
objects. 

 

Connect objects in all tracks 

 
In this mouse mode all objects located behind the one selected will be 
moved in unison. 
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Effects in detail 

Full screen effects editing 

 
This button on the video monitor opens full screen effects editing. 

It allows you to configure the most important photo effects from the Media Pool in full 
screen mode via an intuitive graphic interface. Effects animation can also be modified 
via full screen mode. 

 

 
Use the double arrows to fade in or out the effects editing. 

The general control elements are located top right: 

  

 Use the arrow buttons to undo/redo the last effects edit.  

 Apply to all: Applies the selected effect to all images. 

 Apply to all subsequent images: Applies the selected effect to all subsequent 
images. 

 Reset: All effect editing in the selected image will be undone and the image will 
be reset. 
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All effects are applied in an identical manner, with some exceptions. Click on the 
thumbnail below to view a larger screenshot. 

 You can set effect strength using the 
slider. 

 Activate/deactivate effect: To compare 
the before and after images, you can 
deactivate the effect. 

 Remove effect: For removing the effect. 

 
 

Add keyframe: This button animates the 
effect by adding the current effect settings 
as a keyframe. See below for more 
information about effect animation. 

Differences: 

 
Under the "Brightness" effect, there's a button for Auto-brightness (A), which 
sets the optimal level of brightness for an image automatically. 

For the effects "Artistic filter", "Distortion" and "Focus", a submenu will appear in 
which you can select an effect: 

 

 
You can return to the main menu by using the arrow button. 

Some effects have two configurable effect parameters: 
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 Use the icon on the right to select the 
parameter that you can control using the 
slider. The name of the parameter will be 
displayed in the center. 

Open a "sensor pad" here for 
simultaneously configuring both 
parameters on a 2D interface. 

 
 

Note: "Position and size" requires 3 
parameters: define size using the fader 
and set position using the sensor pad. 

 

Sensor pads for position and color 
 

Keyframe animation 
Animation refers to a temporary shifting of effect parameters. You enter various effect 
parameters at certain points during the display time of a photo (keyframes) and the 
effect parameters then change gradually from one value to the next.  

Note: Keyframe animation here is the same as Animating effect parameters in the 
Media Pool (view page 82), but in a superimposed display that lets you see the effect 
used on the photo in full screen. 

Click the + button to create a keyframe. At the same time, the animation curve for the 
effect will be superimposed over the photo. Two control panels are also displayed at 
the start and end of the curve. 
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Move the control panel vertically (1) to adjust the value for the effect at the point 
which you have set on the curve using the horizontal position (2).  

Additionally, the control panel can be operated exactly the same as the fields on the 
right in the effects palette, e.g. you can set an effect using the sensor panel, deactivate 
it temporarily etc. The one difference is that the x button in the control panel does not 
delete the whole effect, only the corresponding keyframe.  Additional keyframes can 
be added using the + button. 

  

In the upper right corner you can use the 
pencil icon to fade in and out effect 
curves. This symbol also appears in the 
control panel for the effect if the effect 
has an animation curve.  

 

 If several curves are available, you can choose the one 
you want to edit here. 

 When switching between linear and Bezier 
interpolation, the latter is best for ensuring softer 
curve transitions. 

 Deactivates the effect.  

 Removes the effect. 

If you move the mouse over the curve, two handles and a frame appear around the 
curve to enable you to position the curve freely over the photo and adjust the size of 
the curve. 



 

62   

www.magix.com 

 

Image optimization 
Brightness & Contrast 
Auto exposure 

With this button you can automatically optimize brightness and contrast with a click. 
Use the fader in the dialog for finer adjustments. 

Brightness/contrast: Use the sliders to increase or reduce the brightness and the 
contrast of the picture. 

White level/Black level: With these controls, you are able to adjust the light and dark 
areas of an image seperately. A larger white level makes the light areas lighter and a 
larger black level makes the dark areas darker. 

Gamma: "Gamma" determines the mean gray value that can be calculated from the 
various color ranges. In the preset list, select various areas to edit only the dark, 
median, or brightest areas of the image. 
Using the fader, you can also set the level of brightening or darkening. 

HDR Gamma: Unlike "Gamma", very dark areas are selectively lightened. 

HDR Blur: This changes the transition between light and dark areas together with 
"HDR Gamma". 
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Curve 

You can adjust the selected object's brightness, contrast, saturation and temperature 
using the curve effect.  

• You can select individual channels: RGB for brightness/contrast and individual 
color curves Red, Green Blue. 

• Additionally, you can decide how these curves should behave: Standard mode 
draws soft curves. In manual mode, you will see handles on the curve points that 
can be used to draw soft, linear and freehand curves. In addition, you can 
individually set how the curve behaves at every location by going to "Selected 
point". 

Keyboard shortcut: 

• Mouse left click adds a curve point 
• Mouse right click deletes the selected curve point 
• Ctrl and selected point = movement along the x-axis 
• Shift and selected point = movement along the y-axis 
• Ctrl + Shift + click on curve point = switch between curve modes 
• Ctrl + Shift + click on curve handles = changes curve behavior of this curve point 

Color 
Color temperature 
With these slide controls, you can quickly correct color temperature to make an image 
appear warmer or cooler. This can also be used to correct for incorrect white balance 
(see below) if no proper white point exists in the image. 

Remove red eyes 
Using this photo feature, you can remove the unnatural red eye effect which results 
from using flash. Click on "Manual" and then select the red pupils in the preview 
monitor using the mouse.  

Hint: We recommend using MAGIX Photo Manager for photo optimization. The 
program is installed automatically and can be used for quickly and easily optimizing 
your photos. It has a tool for correcting red eye and setting auto color and white 
balance to control discoloration in pictures. 

For more complex editing like photo panorama and photo filter effects, a separate 
image processing program, MAGIX Foto Designer, is included. To load a photo into 
MAGIX Foto Designer, select the option "Edit (external)" in the FX menu of the photo 
box. Read more on this in the MAGIX Foto Designer Help. 
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White balance 
All light is not the same. Depending on whether it is sunlight or artificial light, this will 
have an effect on color variation. The human brain is able to compensate for this 
variation: A white sheet of paper will still look white under candlelight, although it is in 
fact much more yellow than by daylight.   

In order to imitate this filtering done by the brain, a camera must also analyze and 
correct the light. White balance does the same thing to a picture that the brain does by 
setting the camera to the so-called "color temperature" of the surroundings. 

If you do not possess a camera which performs this function automatically, you can 
apply the white balance function in MAGIX Photostory Deluxe. 

An incorrect white balance can lead to an unnatural blue or red hue. 

Directions: To use the white balance, click on the button to the right of the label 
"White balance" and then select a point which represents white or a neutral gray to 
the "outside world". The color temperature is then corrected automatically. 

Tip: Cool color effects can be achieved by setting a different color as the white 
benchmark. There is definitely room for experimentation! 

Color shade 
Select a color for coloring the image from the color chart. 

Red/Green/Blue 
Using the "Red/Green/Blue" slider, you can change the color portion mix for each 
color. 

Saturation 
You can increase or reduce the color portions of images with the “saturation” fader. A 
newly developed algorithm is applied which makes color changes related to other 
parameters (for example contrast settings) in order to achieve the most natural 
coloration possible. With just a little bit of experimentation, you can achieve 
astounding results – anything from turning summer snapshots into autumnal scenes to 
funky pop art! 
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Color changes 
Secondary color correction allows individual colors in video and image objects to be 
adjusted. Choose "Selected" or "Not selected" in order to edit the desired ranges 
separately. The entire image may also be influenced ("Complete image"). 

"Selected" corresponds with the mask created, and "Not selected" involves the rest of 
the picture. Here's how to create a mask: 

• Activate "Add". 
• Place the mouse over the preview monitor. The mouse pointer turns into a 

pipette tool. 
• Click with the pipette tool on the color in the program monitor that you would 

like to assign to the mask. Unwanted colors can be removed from the selection 
again by selecting "Remove" and clicking the corresponding color again. 

MAGIX Photostory Deluxe displays the mask in black and white stripes to highlight 
the current selection. 

• Adjust the color using the color selection slider until it is satisfactory. 

Sharpness 
Sharpen: The fader allows you to regulate the level of image sharpness or apply a soft 
filter. 

Blur: The fader allows you to reduce the sharpness of the image. 

Apply to: Allows you to set just how much the sharpness settings should be applied to 
surfaces or to edges. This enables you to effectively reduce ongoing image distortions 
(noise). 

Artificial blur: Here you can apply various soft filters. The achieved effects are much 
stronger compared to simply sliding the controller under "Sharpen". 

Tip: Artificial blur achieves good effects when used for transitions. To do so, you can 
edit the first image so that it is strongly blurred and let the second image begin blurry 
and slowly return to normal focus. 

Quality: Adjusts the strength of the artificial blur more accurately. 

proDAD Mercalli 2.0 
Remove shaking and jerking from your video recordings. Uneven panning and zooming 
shots can also be "calmed" and improved. 

Profile: Select the right camera type for analyzing and correcting your video data. It is 
necessary to select the right camera here to get the results you want, regardless of 
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how the original video was filmed. The universal camera profile will improve any video 
data, but try out different camera types to get the best result for your material. 

Run analysis... : Analyzing your video data is always the first step before starting 
detailed improvements. 

Rolling shutter correction: Balances any distortion (only with CMOS) that appears in 
moving images - in other words, videos. 

Note: For this effect to work correctly, the correct field setting for the video must be 
used. 

View camera dynamics: Activate this feature if camera movements have not been 
smoothed or stabilized. 

Enhance panning shots: Entire panning movements in a video can be balanced, 

Smooth zoom: This balances shaky zooms.  

Reduce tilting: This can be used to reduce horizontal and vertical tilting of the camera 
when the recording was made. 

Border editing: Through balancing unwanted movements in film footage, it's also 
possible to edit borders. Here, you can specify how to deal with borders: 

• Optimal stabilization: A black border appears in the stabilized video. This border 
can differ in appearance from image to image, depending on the extent of 
shaking. 

• Without border: No border appears in the stabilized video. A border can be 
avoided by zooming the video. This depends on the extent of shaking in the video 
and the desired level of correction. 

• Image area: A static border appears in the stabilized video. The form of this 
border is characterized by the strongest shaking in the video. 

Zoom: The border can be minimized by zooming in the video. 

Fill with edge color: This option lets you fill an existing border. However, this means 
that the video content will look slightly blurred.  

Comparison view: The stabilized video can be shown in the preview window. 

• End result: Only stabilized video will be displayed in the preview. 
• Vertical split screen: This vertical screen displays the source material and the 

stabilized video. 
• Horizontal split screen: This horizontal screen displays the source material and 

the stabilized video. 

Show evaluation grid: A grid to help you evaluate stabilization appears. 
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Shot match 
This feature allows you to apply the look of one video clip to another. The colors and 
tonal values of two separate photos are aligned fully automatically. 

You can do this in the following way: 

1.  Open the "Shot match" effects area in the Media Pool under "Effects" > "Image 
optimization". 

2.  Select the object whose look you want to change. 
3.  Place the playback marker on the photo in the slideshow with the look you want 

to use ("reference").  

Note: Make sure you don't change the object that is selected! You have to keep the 
selection on the target object. 

4.  Under "Target photo", click on "Select target photo". 
The selected position will be displayed.  

5.  Place the playback marker on the selected target object. This photo will be used 
to calculate the look that will be applied to the target object. 

6.  Under "Target photo", click on "Select target photo". 
The selected position will be displayed. 

7.  Click on "Match shot" to adjust the look of the object. 

You can adjust the strength of the effect by moving the "Intensity" slider. 

Shot match works best under these conditions: 

• The same object has been filmed with multiple (different) cameras from various 
perspectives. 

• The same object has been filmed in different lighting conditions. 

Different conditions can lead to suboptimal results. 

A note on multiple-selection: Selecting multiple objects will apply the effects of shot 
match to all selected objects. 

Noise 
Use the Noise filter to add static or noise to a video sequence. When applied to a 
simple background with a monochrome setting and then animated, it can produce a 
pattern similar to that on a television when no transmission signal is obtained. 

• Click on "Apply effect" to activate the Open FX plug-in. 
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Original 

 

Noise 

Noise level Determines the strength of the effect. 

Monochromatic Select this option to make the noise all one color. When 
this option is not selected, the static will appear with 
random colors. 

Gaussian noise A method for creating more intense noise. 

Animate Check this box to make the noise move randomly. 
 

Stamp forms 
Apply the "Stamp forms" effect to punch simple geometric shapes and create 
picture-in-picture effects in a video. 

• Click on "Apply effect" to activate the Open FX plug-in. 
The selected object will be punched in circular form as default. You can also 
customize these presets the way you want. 

  

Original 
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Stamp form (Preset=Circle, Center) 

Color Use the values r, g and b for red, green and blue to set the colors for 
the borders. (This is only visible when borders > 0; see below)  

Shape Choose a setting from the drop-down list to determine the cutout 
shape. 

Methods Determines what part of the video image is revealed/masked:  
• Cut everything apart from section:  The cutout shape forms a 

window which displays your video. 
• Cut section: The cutout shape covers your video and the area 

outside the shape is visible. 

Feather Drag the slider to determine how smoothly the cutout border fades 
into the background. 

Borders Drag the slider to determine the size of the border around the cutout 
shape. 

Repeat X/Y Drag the slider to repeat the cutout shape along the horizontal or 
vertical axis by the number of times specified. 

Size Drag the slider to set the size of the selected cutout shape. 

Center Drag the slider to set the center of the cutout within your project's 
video frame: 0.00, 0.00 represents the lower-left corner of the 
frame, 0.50, 0.50 represents the center, and 1.00, 1.00 represents 
the upper-right corner. 

 

LAB color 
LAB color allows you to manipulate colors in the Lab (L*a*b* or L*, a*, b*) color space. 
Adjusting colors in the LAB color space allows you to: 

• Adjust lightness (brightness) without affecting colors. 
• Perform luminosity inversion without affecting colors. 
• Change colors without affecting brightness. 
• Produce high-quality desaturation and black-and-white conversion. 
• Change subsets of colors without affecting their opponent colors. 
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Brightness The Brightness control allows you to gradually adjust the brightness of 
the image without changing the colors in an image. Drag the slider to 
the right to brighten the image, or drag to the left to darken the image. 

Channel a The a channel contains green and magenta color information. Moving 
the slider all the way to the left (-1) shifts the green and magenta 
colors to green; moving the slider all the way to the right (1) shifts the 
green and magenta colors to magenta. 

Channel b The b channel contains blue and yellow color information. Moving the 
slider all the way to the left (-1) shifts the blue and yellow colors to 
blue; moving the slider all the way to the right (1) shifts the blue and 
yellow colors to yellow. 

Invert 
luminance 

Select the check box to invert all luminance values, which creates a 
negative image. 

Desaturate The Desaturate control allows you to gradually adjust the a and b color 
channels to black and white. Moving the slider all the way to the right 
(1) removes all color from the image, converting it to gray scale. 

 

Lens reflection 
Apply the "Lens reflection" effect to simulate the light reflected by a camera lens. 

Light color: Set the color value to which you want to apply the effect. 

Light position: Set the position of the light source that creates the Lens Flare effect. 

Lens type: Click on a lens in the drop down list to select the number of light flares to be 
created. 

Tint:  Drag a fader or enter a value in the field to set the strength of the tint that will 
be applied to the light source. 

Intensity: Drag the slider or enter a value in the field to set the strength of the effect. 

Blend: Drag the slider or enter a value in the field to set the transparency for the light 
flare effect. Setting 0 is fully transparent; setting 1 is opaque. 

Size: Drag the slider or enter a value in the field to set the size of the light flare effect. 

Perspective: Drag the slider or enter a value in the field to set the angle of the light 
flare effect. 
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Levels 
Levels is a correction filter used to adjust color and brightness. By matching your input 
source with your output, you can precisely compensate for differences and standardize 
your video signals. This is a very effective method of remapping the total range of the 
colors and improving the overall quality of the video. 

 

Original 

 

Fixed 

• Click on "Apply effect" to activate the Open FX plug-in. 

Channel Select the particular color channel (red, green, or blue) or alpha 
channel that you want to adjust, or adjust all (which corresponds to 
adjusting the brightness). 

Input 
Start/End 

Use the slider to set the darkest and lightest values in the source 
material. 

Output 
Start/End 

Use the slider to set the darkest and lightest values for the output. For 
optimal contrast, leave the values at 0 and 100. 

Gamma Gamma compensates for difference in brightness between different 
sources and corrects the output brightness. 
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Distortion 
A large palette of effects for transforming your image material is available. 

Art filter 
Erosion: The image is broken-up by means of small rectangles and resembles a 
"patchwork". 

Dilate: This works like erosion, but uses light surfaces instead of dark ones to form the 
rectangle. 

Emboss creates a relief of the image edges, in which case strong contrast differences 
are interpreted as edges. 

Substitution: Using the rainbow scale red, green, and blue components are exchanged. 
Quickly create surreal landscapes or a green face! 

Move: The color values are inverted increasingly. Blue colors turn red, and green 
appears purple. 

Quantize: Depending on the setting, colors are either rounded up or down so that the 
overall number of colors is reduced. This creates interesting grids and patterns. 

Colorize: Using this slider, color in the video with red, green, and blue colors (the basic 
TV colors). 

Contour: The image is reduced to its contours in two sizes (3 x 3 or 5 x 5). It is 
possible to select either vertical or horizontal contours. 

Distortion 
Motion: Moving parts of the image are enhanced and warped. 

Echo: The moving images create an optical "echo"; previous images stand still and 
gradually turn paler until they completely disappear. 

Whirlpool: The image is twisted into an "S" shape. 

Fisheye: The perspective is distorted as if the image were viewed through a fisheye 
lens. 

Mosaic: The video is depicted as a mosaic. 

Lens: The image is dynamically distorted at the edges. 
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Sand: The image is depicted in a granulated manner. 

Kaleidoscope: The left upper corner is mirrored horizontally and vertically. 

Mirror horizontal/vertical center: The object is mirrored vertically or horizontally – it 
appears on its side or upside down. 

Speed 

 

The playing speed can be adjusted with the slider control. The range between 0 and 1 
plays the video slowly; values above 1 accelerate playback. If the playing speed is 
increased, the object length in the arranger is automatically shortened. 

Reverse: This button reverses the playback direction (with the same tempo). 

View & animation 
Section 
Cropped cutaways can be used to 

• display just one section of the photo. 
• to move the clip through the picture with the help of a movement effect – the 

result is a type of camera movement. Read more about this in the chapter 
"Movement (view page 74)". 

In the program monitor, you can set a picture section to serve as the basis for the 
movement effect. Press the left mouse button and drag out the section you want to 
use. 

In this menu, you can select the format for the 
section. 

The format of the original picture is used as the default. 
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Fullscreen: If this check box is selected, the opened section will be zoomed to 
fullscreen. If this option is switched off, it won't be possible to add movement to the 
section. 

Camera/zoom 

 

With this effect, you can move a 
previously selected frame inside the 
image, creating an impression of 
camera movement or zoom. 

 

Movement in direction 

 

Determine the direction in which the selected section or image will 
move in the process during the time selected under "time period". In 
addition to horizontal and vertical movements, diagonal movements 
are also possible. 

Preview: Displays a preview of the section at the playback marker location. 

Direction & time 
Zoom out: The selected picture section is displayed and then zoomed out to 
show the entire picture according to the value set in "Time". If no portion is 
previously set, a central portion of 50% of the picture is set. 

Zoom in: The entire picture is displayed and then zoomed in to show only a 
smaller picture section according to the time set in “Timeframe”. If no portion 
is previously set, a central portion of 50% of the picture is set. 
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Duration 
The option selected here sets the position where the keyframes of each movement 
effect are set by default. You determine the positions where a movements begins and 
ends. 

Note: Automatically placed keyframes may be edited retroactively, and the option 
will then be set to "Use custom settings". Read the section "Retroactively editing an 
effect's keyframes" in the chapter "Objects". 

 

 
Reset: This option applies a static zoom to show the selected section of the 
picture only. 

 

The size and the position of the image can be roughly entered in the program monitor 
by simply moving the image into it and dragging on the handles. The frame of the 
video monitor with handles can also be moved with the keyboard. 

Keyboard shortcuts for moving the edges of the frame that are visible in the video 
monitor: 

Nudge the screen 1 pixel: Arrow keys 

Nudge the screen 5 percent: Shift + arrow keys 
 

For animated movement effects, it often makes sense to zoom out of the video 
monitor and use the resulting workspace to, for example, let a minimized image or text 
object move through the picture. 

Keyboard shortcuts for the preview picture: 

Thumbnail zoom in/out: Ctrl + mouse wheel 

Move thumbnail: Ctrl + left mouse button + drag 

See the "Animation from outside of the image" section for more detail. 
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Size/Position 

 

Values in: Set whether the values are applied in percent or pixels. 

Position 
Left: Enter the start position from the left image border. 

Top: Enter the start position from the top image border. 

Center: Based on the current image size, the image starting points (left and top) will 
be positioned so that they are centered. 

Note: Negative values can, of course, also be entered. The image borders will then be 
outside of the visible area. 

Size 
Width: Enter the width of the image here. 

Height: Enter the height of the image here. 

Maximize: The image is maximized to the resolution of the film. 

Set original size: The image will be scaled to its original size. 

Fix proportions: This option makes sure that the image will not be stretched or 
distorted. The ratio between width and height will always stay the same. 
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Note: In the preview monitor you can use the object handles on the sides of the 
decorative element to adjust its size. The additional handles for rotation located at 
the top can be used to tip the element and align it with a background object. 

Mirror & Rotate 

 

 
This button resets all of the current settings. 

Note: If you animated the object using keyframes, resetting will affect the entire 
animation. Individual keyframes can be deleted during animation. 

Rotate 

 

Rotates the image on the horizontal axis. 

 

Rotates the image on the vertical axis. 

 

Rotates the image around its center point. 

 

Straighten horizon 
The image can be rotated around the axis using the slider. The image is automatically 
zoomed to avoid black edges. 
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Show guidelines: Activating this check box displays a grid in the program monitor for 
orientation during horizontal straightening. 

Zoom automatically: This function is preset to active. Unwanted black borders that 
result from horizon straightening are eliminated by zooming in on the image.  

Note: If the image format does not completely conform to the current movie format 
and already has black borders, these cannot be eliminated with the horizon 
straightening function. 

Mirror 

 Mirrors the image on the vertical axis. 

 
Mirrors the image on the horizontal axis. 

 
Rotates the image 90° clockwise. 

 
Rotates the image 90° counterclockwise. 

 

Angle & shape 
This makes real 3D positioning of images possible, letting you distort the image in 
space and move it. Here you can enter the individual corner points numerically or 
move them in the program monitor using the mouse. 

 

 
This button resets all settings. 

 

360° panoramas 
You will find options for 360° panoramas in the Media Pool under "Effects" > 
"View/Animation". 
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Note for Ricoh Theta camera users: Although 360° photos taken with this camera 
can be directly imported into MAGIX Photostory Deluxe, videos need to be 
processed first. Use the software that came with the camera to convert your 360° 
videos before importing them into MAGIX Photostory Deluxe. 

 

Panorama image: Select a type of panorama: 

• No panorama: The panorama effect is not active and the image is not unified. 
• Sphere panorama: An equirectangular panorama (or spherical panorama) , like 

one created with a Ricoh Theta camera, for instance, can be displayed as a 
sphere panorama.  
Imagine you are in a sphere and the panorama view is stretched around you. You 
can obtain an angle of up to 360° x 180°, for an all-round view. 

• Custom fit ...: If you have created a panorama with a standard camera or have 
compiled a panorama from images, select this option.  
Imagine you are standing in a cylinder that is open above and below and the 
panorama view is stretched around you. You can obtain an angle of up to 360° x 
120°. 

Recording angle:You must set the recording angle yourself in the setting "Custom fit", 
as this cannot be calculated. Test out the "exact" value by simply evaluating the result 
visually and adjusting the degree angle to correspond to this. 

Direction of view: Set the direction of view in the sphere or in the cylinder - what do 
you want to see? If the recording is slightly crooked, you can balance this out.  

In a panorama image, you can animate a movement with keyframes. Step by step, you 
can view your "surroundings" and re-imagine your "space" the way you want.  
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Perspective: Specify how much to zoom in on details in the space or how much to 
zoom out so you can see as much as possible. 

Fisheye: If you use a fisheye lens, the perspective will appear distorted. If an image 
already contains distortion as a result of a wide-angle shot, the fisheye effect can be 
used to correct this. For instance, a curved horizon can be "straightened". 

Stereo3D in the Media Pool 
This accesses the program's Stereo 3D functionality. Please read the corresponding 
chapter "Stereo3D". (view page 132) 

Design 
Decoration 
Under "Decoration" you will find plenty of choices for pepping up your slideshow. You 
will also find various categories of decorative objects which serve to orient you during 
selection.  

• Click on the respective element to start playback.  
• Double-clicking on the element will apply it to the selected object. 
• In the preview monitor you can use the object handles on the sides of the 

decorative element to adjust its size. The additional handles for rotation located 
at the top can be used to tip the element and align it with a background object. 

Style 
Below this point you can find all the styles from Slideshow Maker, which can be used 
on individual photos. Select the corresponding style by either double-clicking it or by 
dragging it onto an image whilst holding down the left mouse button.  

Background 
MAGIX Photostory Deluxe provides diverse backgrounds that can be used in many 
different ways. Simply drag & drop the desired background at the position you want. 

Upright-format effects 
Here you can select individual effects that are especially made for vertically formatted 
photos. 

Hint: This option does not appear for photos in horizontal format. 
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Intros / Outros 
These are beginning and end scenes for slideshows with various themes. 

Picture-in-picture collages 
These work similarly to normal picture-in-picture effects, but more objects are used. 
Depending on the collage, arrange the selected objects one after the other and drag 
the collage onto the first object. 

Image border effects 
Exporting projects for viewing  on a 16:9 television can cause black edges to appear 
around your photos. This always happens with upright photos and with photos that do 
not correspond with the 16:9 format. 

Using upright-format effects can help you avoid black edges. 

Sound effects 
Sometimes slideshows can benefit from special background sounds, such as adding 
the sound of the ocean to a slideshow with beach photos. Here you will find a range of 
sounds from blackbirds and hail to thunder, cafes and forests. Set the start marker at 
the position where you want the sound to play and import the template by double 
clicking. 

Snap markers and transients 
Objects, object edges, markers or the playback marker will jump automatically to 
particular "Key positions" when you move them close enough with the mouse. This is 
called "snapping".  

Select a location in the object with a snap marker to indicate where another object 
should snap in. This can be helpful, for instance, if you want a title to be shown at a 
specific position in a video object. 

You can find the "Snap Marker" in the Media Pool under "Effects". 

Set snap markers 
• To set a snap marker, select an object and place the playback marker at the 

position where you want to place the snap marker.  
• Now click on the button "Set snap marker". 
• You can move a snap marker with the mouse using drag & drop.  



 

82   

www.magix.com 

You can set as many snap markers as you like per object. 

Tip: It's also possible to set snap markers in selected objects during playback. This is 
particularly useful for marking points in the video material where you want to place 
cuts. 

Align snap marker with transients 
Transients are signal peaks in audio material that can also appear in video footage; e. g. 
a door slamming shut. 

Transients in video footage can be used as a starting point for editing - for instance, 
fading in a title or making a picture-in-picture effect appear. 

The "Align snap marker to transients" feature analyzes the signal peaks of the selected 
object and moves set snap markers to these locations. 

Extra effects 
Photo and video effect plug-ins are additional programs from third-party 
manufacturers that can be used to apply other effects to photo and video objects. 
MAGIX Photostory Deluxe supports selected plug-ins from NewBlue, HitFilm, ProDAD 
and selected OpenFX Standard effects. Install the plug-ins and click on "Scan" under 
"fx" > "Extra effects" in the Media Pool. Then restart MAGIX Photostory Deluxe. The 
plug-ins will appear directly below, ready for use. 

Looks 
These presets recreate the appearance of certain types of movies and can be applied 
to photos. 
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Animate objects 
Different kinds of animations are provided in the Media Pool. In the "Effects" tab, 
"Image optimization", "Distortion", "View and animation" and "Stereo 3D" (only in 
deluxe) provide you with the effects that can animated using keyframes. 

The following objects can be animated: 

• Image objects (still images) 
• Title objects 
• MAGIX 3D Maker objects (3D title) 
• Video objects 

Preparing animations 
• First, select the object in the arranger to animate. 
• In the Media Pool, open the "Effects" tab, and then click on the effect you would 

like to animate. 
• If necessary, set up the effect however you would like it for the start of the 

animation. 
• A timeline is located at the bottom of the Media Pool where keyframes can be 

set, selected, moved, and deleted. 

Note: The figure corresponds to the display in "Timeline" mode. 

Set keyframes 
Click the timeline to set the playback marker at the locations where a keyframe should 
be added. 

Note: You can also use the timeline in the arranger for exact positioning. 

 
• The button places keyframes for all parameters required in the animation. 

• Additional keyframes can be added simply by placing the playback marker at the 
next keyframe location and changing the effect accordingly. 

• The positioned keyframes can also be retroactively moved via drag & drop. 

Copy keyframes 
Select the keyframes to be copied by clicking them and then press the "Copy" 
button.  
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Next, set the playback marker at the location for insertion and the press the 
"Insert" button. 

 

Display keyframes of individual parameters 
Multiple keyframes are added simultaneously to effects if they include multiple 
parameters. 

 

Click the small arrow beside the name of the animated 
effect to display all of its parameters. 

 

Now all keyframes of the effects parameter can be 
individually moved, deleted, activated, and 
deactivated. 

Note: Only those parameters are listed which are used for the animation. As soon as 
another parameter is required for editing the effect, it becomes visible to you here. 

Retroactively editing an effect's keyframes 
Previously set keyframes can be retroactively moved and their values can edited. 

Keyframes can be moved via drag & drop. Simply click on the keyframe to be moved 
and drag it to the desired position. 

To change an effects setting for an already positioned keyframe, click the keyframe 
and adjust the effect in the Media Pool. 

Soft movement 
The automatic Bezier interpolation applies an approximation curve at the 
keyframe. 

This makes the movement progression softer and more natural.  
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Delete keyframe 

 

Select the keyframe to be deleted by clicking it. 

 

 
This button removes the selected keyframe. 

 

Sound optimization 
This option opens an editor for correcting audio material discrepancies. 

Select the cleaning function you desire from the upper part of the dialog: 

• The equalizer (on page 87) allows you to manipulate the frequency spectrum – 
perfect for cleaning up muffled dialog.  

• The compressor is a dynamic volume control that lends the overall sound a 
deeper, richer quality. 

• The stereo FX processor justifies the position of the sound in the stereo 
panorama. 

• DeNoiser, DeClipper, and DeHisser are professional noise reduction tools that do 
exactly what their titles say they do. 

Presets: You can try out the suitability of a number of presets in the preset menu. 

Temporarily deactivate all effects: Switches all the effects off. 

Apply to all: Applies the current settings of all effects to every photo in the selected 
slideshow. 

Declipper 
Should the input level of an audio recording be too high, overmodulation may result at 
the louder parts (the signal peaks). This digital distortion is also called "clipping": At 
the overmodulated area, the values that are too high are simply cut off, and typical, 
quite unpleasant-sounding crackling and distortion appear. 

MAGIX Photostory Deluxe contains a special function for dealing with digital clipping 
and analog distortions. Of course, this only works to a certain degree. 

Using the fader you can set at what level the Declipper should register a signal as 
being overmodulated and, if required, correct it (Clip level). This is important, as 
different sound cards show different clipping methods. The more the fader is turned 
up, the lower the level recognized by the program as overmodulated. If the clip level is 
set too high, unwanted sound modification may occur. 
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Get clip level: The clip level is gaged automatically. 

Noise Reduction: Denoiser and Dehisser 
DeNoiser 

The DeNoiser is especially useful for clearing long-lasting disruptive noise like mains 
humming, hissing, noises from sound charts, disturbance noise from ground circuits, 
interference from audio-equipment with high mic outputs (record players), impact 
noise, or the rumbling of records.  

The DeNoiser requires a noise sample. Some typical sounds are at your disposal.  

Set the degree to which the noise should be reduced with the fader. It is often better to 
reduce interference signals by 3-6 dB rather than as much as is possible so as to keep 
the sound "natural". 

Another possibility is to create a noise sample yourself. You need a short sample from 
the sound track in which only the background noise can be heard. Then switch to the 
DeNoiser dialog with the "Advanced" button. 

Step 1: Select noise sample 
First you have to select a noise sample of the noise you want to remove.  

You have two options: 

Pick out typical background noise: You can select and use a number of typical 
background noises from the flip menu. Select one and listen to it via the "Play" button. 
If it is similar to the background noise in your sound track, go ahead and use it (see 
"Step 2: Removing background noise"). 

Extracting a new noise sample from a sound track: You can also pick out a short 
passage (from the existing sound track) in which you can hear the background noise.  

Automatic search: Searches especially quiet passages in which background noise 
most probably resides. 

Previous/play/next: These buttons allow you to play all of the passages found for 
easy comparison. 

Save as: Once found, you can save noise samples on the hard drive which then appear 
as an entry in the "Typical background noises" drop-down menu to be used in other 
projects. There's no need to save it if you only want to use it once, and in this case 
switch to "Remove background noise". 
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If you only want to use the noise sample in the current project, then you don't have to 
save it. You can immediately switch to the "Remove category".  

Step 2: Remove background noise 
Noise level: The level of the noise reduction function should be set as precisely as 
possible. Low settings result in incomplete deletion of the hissing. An incomplete 
deletion of the hissing produces artifacts and should be avoided. High settings produce 
dull results and useful signals which are similar to hissing (woodwinds, for example) 
are also filtered away. It's worth your time to find the best setting. 

Reducer: Here you can set the balance between the original signal and the signal with 
depressed interference. It is often better to reduce interference signals by 3-6 dB 
rather than as much as is possible so as to keep the sound natural. For buzzing it's best 
to apply complete removal. 

Dehisser 
The Dehisser eliminates regular "white" noise typically produced by analog tape 
recordings, microphone pre-amplifiers, A/D converters, or transformers. 

Noise reduction can be regulated in decibels with the fader. It is often better to reduce 
interference signals by 3-6 dB rather than as much as possible in order to keep the 
sound "natural". 

Noise level: You can choose between different noise levels. The level of the noise 
reduction function should be set as precisely as possible. Low settings result in 
incomplete deletion of the hissing. Incomplete deleting of hissing produces artifacts 
and should be avoided, since high settings will produce dull results and some useful 
signals (i.e. woodwinds) which are similar to hissing are also filtered away. 

Equalizer 
The 10-track equalizer divides the frequency spectrum into 10 areas (tracks) and 
supplies them with separate volume controls to allow you to achieve many impressive 
effects, from the simple rising of the bass to total sound transformation. If you raise 
the low frequencies too much throughout the whole level, it might cause distortions.  

Fader: The volume of each of the 10 frequency bands can be set separately with the 10 
volume controls. 

Link frequency bands: The frequency fields can be bundled together flexibly in order to 
avoid artificial-sounding exaggeration in individual frequency fields. 
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Compressor 
The compressor is an automated, dynamic volume controller. Loud passages become 
quieter and the total value is raised. This makes the volume more consistent and 
speech easier to understand. A compressor is mainly useful in case background noise 
or music interferes with speech and simply increasing the volume of the individual 
objects or tracks does not result in any significant improvement. 

Level: Regulates the level of compression applied (the "ratio"). 

Function: Defines the compressor depending upon the sound material. 

Stereo FX 
The stereo FX processor provides adjustment of the alignment of the audio material in 
the stereo balance. If the stereo recordings sound weak and undifferentiated, an 
extension of the stereo base width can often provide better transparency. 

Bandwidth control: Adjust the bandwidth between mono (on the extreme left), 
unchanged base width (center) and maximum bandwidth ("wide" on the extreme 
right). 

Reducing the bandwidth can raise the overall level. In extreme cases, when the left and 
the right channels include identical material and the bandwidth control is pushed to 
the extreme left on "mono", the result can be a level increase of 3 decibels. 

Raising the bandwidth (values of 100) diminishes the mono compatibility. 

Slideshow effects 
In the slideshow Effects menu (view page 175) you can recall the slideshow effects by 
clicking on "Slideshow effect settings". The dialog is almost identical to the Optimize 
photo (view page 62) dialog. 

The slideshow effects apply to the entire slideshow and are intended to regulate the 
color saturation in the slideshow as a whole. 

You can find special TV screen size (view page 90) options for cropping the screen 
edge, since the image usually exceeds the screen size for a normal TV set.  
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General use 
Presets: Try out the presets from the preset menu. 

Temporarily switch off all effects: With this option, you can temporarily deactivate all 
effects. This way, you can quickly compare the original with the edited version. 

OK: The adjustments made to the settings will be applied. 

Cancel: Closes the dialog, the settings will not be applied. 

Help: Opens the program's help file. 

Exposure 
Brightness/contrast: Use the sliders to increase or reduce the brightness and the 
contrast of the picture. 

Selective brightness (gamma): "Gamma" specifies the mean gray value  that is 
provided by the various color ranges. "Selective brightness" is the most important 
function for image improvement. In the preset list, select the various envelope curves 
to edit only the dark, median, or brightest areas of the image. 
Using the fader, you can also set the level of brightening or darkening. 

Adjust colour space: This option is effective for correcting extreme colors that violate 
TV standards and can no longer be displayed properly on-screen. The color saturation 
of the affected material is thereby reduced until the maximum permitted value is 
reached. 

Color 
Saturation: Use the saturation slider to increase or reduce the hue proportions in the 
image. A newly developed algorithm is now used, which carries out color changes in 
relation to other parameters (for example contrast settings), in order to get the most 
natural coloration possible. With some experimenting, you can achieve some amazing 
results – such as turning summer images into autumnal pictures, or creating funky pop 
art... 

Hue: Use the palette to select a hue for coloring-in the picture. 

Red/Green/Blue:  Changes the color portion mix. 
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Image sharpness 
Use the slider to adjust the sharpness or blurriness of an entire slideshow. 

Apply to: Set whether the sharpness should only affect edges or whether the 
blurriness should only affect surfaces. This enables you to effectively reduce ongoing 
image distortions. 

Anti-flickering filter intensity: The anti-flickering filter affects only still images. It is 
especially intended for zooms in images with many edges and transitions with high 
contrast (e.g. fences, bars, brick walls). High-frequency images such as these begin to 
flicker when they are reduced in size. This filter smoothes these edges somewhat. 
You should set the intensity of the anti-flickering filter according to your preferences, 
because smoothing is always a compromise between good contrast and fluid image 
sequence during playback.. 

TV image size (Slideshow master effects) 
This option ensures that the image size is adapted to fit the real television picture (anti 
cropping). Without adjustment, the television might otherwise crop the image 
borders.  

The four input fields also enable the borders of the four sides to be adjusted freely in 
percent. It is important to find the optimal balance between distortion, reduction, bar 
formation, and image cropping: 

• If the same value is entered for every margin the image size is reduced 
proportionally. In this case no distortions will occur, but there will be bars along 
the edges. 

• If different values are entered for the 4 fields the image size will not be reduced 
proportionally. This will distort the image. 

Use edges on: This option enables the input values for the four image borders to be 
applied to all photos, videos or titles in reduced form. The result can immediately be 
viewed on the preview monitor. 

Tip: In order to limit individual objects to the visible range, please select the option 
"Edge cropping balancing" in the menu "Effects -> Image optimization -> TV image".  

Fade in TV display area in the preview monitor: This option displays the image 
borders of the television as lines in the preview monitor. The four image borders of the 
TV display area can be set using the four input fields. Here, it is of course necessary to 
know the actual size of the TV picture. To determine it, proceed as follows: 

Determining the visible TV frame size 
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To determine the picture properties of your television as well as optimal image size 
editor settings, you should perform a test run:  

1. Load the Visible TV picture.mvm movie from the "My projects > visible TV 
picture" folder. 

2. Play back the movie and read the instructions on the video monitor. 
3. Burn the slideshow to a disc. 
4. Place the disc into your player and play back the movie. Compare the TV picture 

to the picture displayed on your video screen by MAGIX Photostory Deluxe. 
5. Determine the proportional value of the borders cropped by the television with 

the 4 measurement scales along the edges of the test picture. 
6. Enter the values in the “Full TV size” editor. 

The image size is now optimized to your TV picture. Please note: Depending on device 
settings and disc carrier type, the cropping values may vary slightly.  
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More functions and dialogs 

Import files from camera, tablet or smartphone 
The "Import from camera" feature is located under "File". This will open the following 
dialog. 

 

Source: Select the path for your digital camera's memory card or connected device. 

Save in following folder: Here you can specify where the imported files will be saved.  

Select: Specify which files should be imported: "All", "New only" (since the last import) 
or "None". Click on the recycling bin to delete the selected files. 

Import individual images by ticking the box next to 
the image in the selection field. Doing this will 
display the image above in the video monitor.  

Display filter: The display filter can be used to define whether certain files should be 
hidden. When you uncheck a box, the corresponding files will be hidden. 

• Movies: Hide all video files. 
• Photos: Hide all photo files. 
• Selected files: All files selected for import will be hidden. Only the files which 

have not been selected will be displayed. 
• Not selected files: All files which have not been selected will be hidden. This is 

useful if you want to check your selection before importing. 
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• Imported files: All files which have already been imported by MAGIX Photostory 
Deluxe from the specified device will be hidden. 

 
Adjust the preview image size using the slider. This option is only available if 
"Large icons" is selected in the view menu.  

 
Select whether you want to see "Large icons" or a list with "Details" on the 
files.  

Import options: Here you can define what happens after importing. 
• Insert into slideshow: The media will be directly inserted as an object into the 

open slideshow. When inactive, they will be simply copied into the target folder 
and can be selected from the Media Pool at any time. 

• Delete all media after camera import: This option deletes the selected media 
after importing from the camera. 

• Close dialog after import: The dialog closes as soon as the import has finished. 

Once you have entered all settings, click on "Import". 

Transfer media from CameraMX 
You can transfer photos and videos from your Android device to your PC and 
MAGIX Photostory Deluxe using CameraMX. While MAGIX Photostory Deluxe is 
running, the selected media will be transferred and made available for further editing 
as a stand-alone slideshow. 

What you'll need 
• Your Android device and the PC that MAGIX Photostory Deluxe is installed on 

must be connected to the same network! 
• Your Android device should be running Android version 4.1 or higher in order to 

install CameraMX. 
• You must have CameraMX installed on your Android device. 

Do this 
1.  Start MAGIX Photostory Deluxe and go to the main user interface. 
2.  Start CameraMX on your Android device. 
3.  Open the media manager in CameraMX (gallery). 
4.  Use the multi-selection tool to select the media you want to transfer. 
5.  Go to advanced features and select the data transfer feature. 

CameraMX will search your network for MAGIX Photostory Deluxe in order to 
carry out the transfer. 
The dialog for receiving data will then be opened. 

6.  Select a storage location and confirm the data transfer. 
The data transfer will begin. You can continue to use MAGIX Photostory Deluxe 
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while your data is transferring. 
After the data has been successfully transferred, the "Receive media" button 
appears above in the menu bar with further options. This will remain on screen 
until you click it, including after restarting MAGIX Photostory Deluxe. 

You can choose from the following options:  

• Load to Photostory Wizard: This opens the wizard and displays the folder 
containing the files. 

• Import to project: Inserts the files to the end of the current slideshow. 
• Display in Media Pool: Displays the folder with the files that have been received. 

Problems and solutions 
CameraMX can't find MAGIX Photostory Deluxe: 

• Check the network connections for your Android device and your PC. Both 
devices need to be on the same network. 

• Make sure that the following ports in the network are accessible: 
- UDP-Port 6666 
- The HTTP Port can be dynamically assigned through the Android device. 

Settings 
All settings dialogs can be accessed through "File -> Settings". 

Slideshow 
The dialog with the settings for the current slideshow are displayed here.  

Select preview image automatically: MAGIX Photostory Deluxe uses an 
automatically-selected preview image. 

Use image file: With a mouse click on the folder button you can open a dialog for 
loading image files. In this dialog you can navigate to the folder where the image file is 
found and select it with a double click. 

Use preview image from slideshow: Select a frame from the current slideshow using 
the slider. 

Effect settings for the slideshow (view page 88) can be found in "File" > "Settings" > 
"Slideshow effect settings. 

Project 
When creating a new disc project, you can specify multiple settings that will continue 
to apply to the related slideshows. 
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Project name:Give your disc project a name. This name will be used as a preset title for 
the disc you are going to burn. The slideshows will also be given this name. 

Use 16:9 aspect ratio for current disc project: This option lets you edit the slideshow 
from the very beginning in 16:9 format. The video monitor's size adjusts to correspond 
to this. 

Cut new images to fit screen automatically: Images that do not correspond to the 
slideshow's ratio are adjusted automatically. The zoom factor is set in such a way that 
there are no black bars to the left or right or top and bottom. 

Program 
You can access the project-independent MAGIX Photostory Deluxe settings this way. 
These settings are also global. 

Playback 

Audio playback 
Driver selection: You can set up "DirectSound" here. DirectSound is a component of 
DirectX that is installed automatically on your PC during program installation (if 
necessary). If the DirectX system is no longer installed on your PC or no longer works 
properly, there is a DirectSound installation routine for reinstallation to be found in the 
"Addon" folder of the MAGIX Photostory Deluxe program disc. 

Output device: Use this option to specify which sound card plays the wave audio 
objects. This is especially important if you have multiple sound cards installed on your 
computer. 

Audio buffer size: Here you can specify the buffer size that should be used for 
playback of the entire arrangement or for previewing audio files in the Media Pool. 

Arranger 
Autoscroll during playback: The screen playback does not follow the playback cursor 
if it has reached the end of the screen. 

Fast: If autoscroll is activated, the screen view automatically shifts when the playback 
cursor reaches the last quarter of the screen during playback. 

Slow: If autoscroll is activated, the screen view automatically shifts when the playback 
cursor reaches the right edge of the screen during playback. This is particularly useful 
for longer disc projects 
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Warning: Scrolling requires constant recalculation of the screen view, which may lead 
to interrupted playback if the amount of system RAM is too low. If this happens, 
simply deactivate the autoscroll feature.  

Image material playback 
Resizing high-quality image material: Use this feature to improve the quality during 
resizing, particularly when downsizing to less than half of the original size (e.g. for 
picture-in-picture effects). This, on the other hand, requires more processing power. 

Note: Switching off this option has no effect on quality during exporting/burning. 

Load image material in background: Image material will be loaded in the background 
so that it can still be edited during the loading process. 

Paths 
Projects: The standard path for all projects (*.<Pojektdatei>) 

Exports: The standard path for all file exports via the command "File" > "Export" 

Audio import: The standard path for all imported (music) files. 

Disc images: Specify the path for the folder where MAGIX Photostory Deluxe saves 
the temporary files required for creating a disc. 

Menu Editor: Determines the Menu Editor path, which can be started using the "Burn" 
interface. 

Options 
Here you can specify the most important options for the behavior and display of 
MAGIX Photostory Deluxe. 

Keyboard shortcut: P 

Video standard 
PAL is used in Europe; the US and Japan use NTSC. This setting should not be 
changed. 

Program interface 
Hide news: This option deactivates the MAGIX News Center (view page 210) in the 
main interface of MAGIX Photostory Deluxe. 
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Activate touch optimization in the Storyboard: Automatically activates touch support 
when you connect a touch-enabled device. You can also deactivate this option to go 
back to using the mouse. 

Note for using the mouse when touch support is activated:  To drag and drop a clip 
into the Storyboard, you have to hold down the left mouse button until the photo is 
released from the series and can be moved. 

Activate animations: Deactivate the program animations for a smoother editing 
experience.  

Reactivate hint dialogs 
Once installed, MAGIX Photostory Deluxe displays a number of safety queries and 
instructions at various points in the program. These may be switched off by clicking 
the small box at the bottom that says "Don't show this message again". To display 
these warning messages again, select the "Reactivate hint dialogs" option. 

Export 
Automatic preview of export clips: If you export a slideshow as a video file, it will be 
played immediately after being created. 

Hardware acceleration during MPEG-4/AVCHD export if possible: Here you can 
activate Hardware acceleration during MPEG-4/AVCHD export if your system 
supports it. 

Import 
Fade photos automatically with dissolves: When loading photos, they will 
automatically fade from one into the other using a dissolve effect. 

Automatically create frame table during import: Sometimes, rebuilding a frame table 
can get rid of problems in certain MPEG files. For example, problems can arise if the 
navigation (positioning of the playback marker, transport) is bumpy or doesn't function 
at all. Normally, when loading MPEG video, a frame table is not created in order to 
speed up the loading process. If you do create one anyway, MPEG files are normally 
noticeably faster and easier to edit. 

Import CD tracks through record dialog: If this option is activated, you can record 
audio CDs using the record button in the transport console. When dragging & 
dropping from the File Managers the record window where recording starts will be 
opened. This option can be used if drag & drop through the File Manager is not 
working properly, or if you want to record the first bars of an incomplete CD track in 
the arrangement. You should note that the digital track data from the digital analog 
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converters of the CD-ROM drive have to be converted into analog signals and then 
into digital data by the analog-digital converters. Depending on the quality of the 
converter used, this can lead to a loss in quality. 

Image length: Adjust the default display duration for photos. This can be changed 
again at any time. 

Other 
Project setting "Cut to fit monitor automatically" affects videos: If this option is 
active, then videos will be cut to avoid black edges. The property "Cut to fit monitor 
automatically" must be activated for the project. 

Preview images in the background: The update if the object display after move and 
zoom operations in the arranger is performed in the background in order to let you 
work smoothly. 

Relocate memory for bitmaps to other process: Activating this option will improve 
handling of bitmaps as they will be processed differently. 

High output quality for dynamic zoom and combination effects: If this option is set, a 
newly developed zoom algorithm will be used that provides results that are much 
more accurate. You should, however, only use this option if you own a PC that is 
capable of handling processor-heavy tasks. Otherwise the export (and invariably the 
creation of a disc) can take much longer. 

Automatic preview when changing transition: When this option is activated, a short 
preview of the transition effect will be quickly played between the two objects you 
selected. 

Display 
Video mode: Set up the playback mode in the Arranger here. You have the choice of: 

• Compatibility mode: This mode works on all systems. Activate this mode if there 
are problems with playback. 

• Standard mode: This mode offers extreme speed boosts by letting the mixing, 
many effects and various transitions be calculated directly on the graphics card. 
Depending on the graphics card, performance can increase by 300%. The 
graphics card will not be used during export. 

Warning! To use this mode the graphics card must posses at least 128 MB memory. 
You will need to install Direct 3D 9 or higher, and the graphics card driver must 
support "High Level Pixel Shader Language 2.0". MAGIX Photostory Deluxe checks 
the corresponding properties when this mode is selected, and switches it off if 
necessary. 
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• Alternative mode 1: This mode performs hardware-based deinterlacing for output 
onto a PC screen or a projector, whereby the playback quality is significantly 
better than with interlaced analog video recordings. 

• Alternative mode 2: This mode uses the hardware de-interlacing function of 
modern graphics cards together with DirectX 9. Make sure that you are using the 
most recent version of your graphics card driver, which must be compatible with 
DirectX 9 to function properly. This mode is only superior to "Overlay mixer" 
mode with a limited number of graphics card models. 

Deinterlacing: In the DirectShow modes "Overlay Mixer" and "Video Mixing Renderer 
9", you can activate hardware de-interlacing with your graphics card. For general 
information about de-interlacing and the options "Top/bottom field first", please read 
the corresponding article "De-interlacing (view page 202)" in the manual. 

Image formation in the Vertical Blank Interval (VIB): Image formation takes place in 
the vertical blank intervals of the monitor signal (or the connected TV signal). This 
helps avoid image interruptions.  

Warning: Because of waiting time required for the next VBI, this process adds 
significant computational time!  

For digital displays like the TFT monitors you can deactivate the option. In the Overlay 
mode image formation occurs exclusively in VBI. 

Use high resolution for fullscreen playback:  

Note: This option is available only in the standard mode (hardware acceleration 
Direct3D). 

If the option is activated, image resolution during preview will be increased. This 
demands more computer resources, but is not a problem for most graphics cards. You 
should deactivate this option only if you have problems with fullscreen playback. 

Playback in arranger 
Video mode: Set up the playback mode in the Arranger here. The following choices are 
available: 

• Compatibility mode: This mode works on all systems. Activate this mode if there 
are problems with playback. 

• Standard mode: This mode offers extreme speed boosts by letting the mixing, 
many effects and various transitions be calculated directly on the graphics card. 
Depending on the graphics card, performance can increase by 300%. The 
graphics card will not be used during export. 
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Note: To use this mode the graphics card must posses at least 128 MB own memory. 
You will need to install Direct 3D 9 or higher, and the graphics card driver must 
support "High Level Pixel Shader Language 2.0". MAGIX Photostory Deluxe checks 
the corresponding properties when this mode is selected, and switches it off if 
necessary. 

• Alternative mode 2: This mode uses the hardware de-interlacing function of 
modern graphics cards together with DirectX 9. Make sure that you are using the 
most recent version of your graphics card driver, which must be compatible with 
DirectX 9 to function properly. This mode is only superior to "Overlay mixer" 
mode with a limited number of graphics card models. 

Deinterlacing: In the DirectShow modes "Overlay Mixer" and "Video Mixing Renderer 
9", you can activate hardware de-interlacing with your graphics card. For general 
information about de-interlacing and the options "Top/bottom field first", please read 
the corresponding article "De-interlacing (view page 202)" in the manual. 

Image formation in the Vertical Blank Interval (VIB): Image formation takes place in 
the vertical blank intervals of the monitor signal (or the connected TV signal). This 
helps avoid image interruptions.  

Warning: Because of waiting time required for the next VBI, this process adds 
significant computational time!  

For digital displays like the TFT monitors you can deactivate the option. In the Overlay 
mode image formation occurs exclusively in VBI. 

Always use DirectX9: Normally DirectX11 is activated for the preview in the project 
window. DirectX9 can be activated for graphics cards that don't support DirectX11. 
You can also activate it if you are having general problems. 

Use high resolution for fullscreen playback:  

Note: This option is available only in the standard mode (hardware acceleration 
Direct3D). 

If the option is activated, image resolution during preview will be increased. This 
demands more computer resources, but is not a problem for most graphics cards. You 
should deactivate this option only if you have problems with fullscreen playback. 
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Video output to external device 
Activate video playback: With this option, you can display the project window view on 
an additionally connected monitor. Without additional hardware, you can play a 
preview in any mode in order to see how the final material looks. 

Turn off Windows AERO for smoother playback: Deactivate the Aero interface. 
Windows uses the classic interface instead. Deactivating the processor-heavy Aero 
design is recommended, especially for weaker PCs.  

Transitions 
In the Media Pool tab "Templates", you can find all transitions from 
MAGIX Photostory Deluxe sorted into various categories. Click on a category to see all 
the fades in a list. 

• To load a fade, drag it with a held-down mouse key onto the object, into which 
you would like to fade. 

In detail: 

Transitions are stylistically a very important element for breathing life into your 
slideshow. With MAGIX Photostory Deluxe, there are many ways to fade from one 
picture into another. This means that for the duration of a transition, two photos are 
being shown at once and they can be mixed together in different ways. These types of 
transitions are called "fades". You can find plenty of fade types in the Media Pool fade 
folder. 

Using transitions 
Use drag & drop to place a transition at the end of an object so that it appears between 
this object and the next one. 
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Settings 
Some transitions include settings which allow you to adjust the behavior and 
appearance of the transitions. 

 

The corresponding settings for a transition appear automatically in the Media Pool 
when the transition is activated. You can also click on the transition symbol on the 
object and select "Settings..." in the menu that appears. 

3D transitions 
3D effects offer exciting and varied opportunities to create transitions between two 
videos.  

The following transition settings are available: 

Anti-aliasing: An undesirable step effect is usually created at the borders of 3D 
objects. Anti-aliasing reduces this effect, but also requires more computer power. The 
setting applies globally to all 3D fades, switching on anti-aliasing during 3D fades has 
the effect that all other 3D fades are also affected by this setting. 

Horizontal/Vertical Mirror: Use these options to influence the path of the 3D objects 
within the fades. "Horizontal" mirrors the movement of the object horizontally, i.e. 
along the X-axis. "Vertical" mirrors the movement of the object vertically, i.e. along the 
Y-axis. 

3D series 
The 3D series are an advanced development of the 3D transitions (view page 102) and 
open up new thematic possibilities.  The spatial effect and a sensible sequence of 
transitions are the most important things here. For instance, you can let photos pop up 
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and disappear on a notice board or make it look as if the photos were hung on the 
walls of a gallery. The series stretch out over several photos or even entire slideshows. 

Using a 3D series: 

1. Click on Transitions -> 3D -> 3D series in the Media Pool.  

2. Select a 3D series and drag it onto the photo where the 3D series should start. A 
dialog opens in which you can select how many of the subsequent transitions should 
be replaced by the 3D series. 

Stereo3D fades (deluxe version only) 
The fades in the Media Pool feature the category "Stereo3D". This includes transitions 
that create slideshows with "real" 3D effects from regular 2D photos. 

These transitions feature a selection of familiar transitions from MAGIX Photostory 
Deluxe that have been prepared especially for real 3D. These are displayed 
stereoscopically in the respective 3D playback modes (view page 135). 

Warning! These transitions may not be applied to 3D photos, since this makes them 
very unpleasant to look at and can cause serious headaches! 

Transitions in Storyboard Mode 

 
You can open the transitions menu by simply clicking on the transition 
symbol between two individual photos. 

 Here's where you'll find all of the transitions that MAGIX Photostory Deluxe has to 
offer. Simply select a transition.  

You can also choose the length of the transition. "Apply to all" applies the setting to 
your entire slideshow. Additionally, you can set random presets for each transition 
("Random Transitions") or apply the selected preset to all. 

Simple crossfade in Timeline Mode 

 

A simple transition can be created in the Arranger of 
the Timeline mode by dragging one object over 
another. A crossfade is automatically created. 
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Using this basic transition the brightness of both images will be added together, and 
then one will be faded in as the other is faded out simultaneously. The duration of the 
crossfade is displayed in the Arranger by white crossing lines. You can adjust the 
length of the crossfade by dragging the upper object handle of the second object to 
the left or to the right. 

 
To select a transition type click on the transition symbol displayed on each 
selected object, and then choose your favorite from the menu.  

The transition icon will change depending on your selection.  

Title editor 
Titles can be used for many applications: as a running text (ticker), subtitles, speech 
and thought bubbles, to display date and time, and much more. 

Creating titles using a template 
In the Media Pool, there are a wide range of title templates for fonts, opening and 
closing credits, captions and much more in the "Templates" tab in the "Titles" section. 

• Open one of these entries and select any title template. Start a preview or add a 
title to a playback marker location using the quick access feature. 

Note: Templates may be applied to an existing title object. Only the text will remain 
when the template is applied. All other formatting settings will be lost. 

Create titles without a template 
1. Select the object you would like to give a title. 
2. Place the start marker in the project window at the point where you want the title 

to be inserted. 

Note: You can always change this position afterwards by dragging and dropping 
the title. 

3. Open the title editor: 
- When working in Storyboard mode: Click on the T (for title editor) in the 

object that you would like to give a title to. 
- When working in the Timeline-mode: Click on the T in the lower toolbar (view 

page 38). 
A title object will be created and the "Title" area will open in the Media Pool. Simply 
enter your text or change the text at a later dater by going to "Title". 
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Texts can be displayed in all kinds of fonts 
and colors. 

If you want to format individual words or 
letters, select them with the mouse and 
choose a different format or color. 

Without any selection, the entire text in 
the object will be formatted. 

 

Position titles 
• Click once on the title in the preview monitor and a positioning frame will appear. 

Simply move the positioning frame using drag & drop. 

 

• The size of the positioning frame can be adjusted at the corners. If "Adjust font 
size to title field" is activated, the text size will also change. 

Edit titles retroactively 
• Double-click on the title in the preview monitor. Now change the text any way 

you like.  
• You can also go to the Media Pool area "Titles" and enter your text in the input 

field there. 

Font 
Font: Select the font used to display the text. 
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Font style: Choose here whether all of the text or parts of it should 
be shown bold, in italics, or underlined. 

 
Font size: Set the size of the text here. 

 
Alignment: Select whether the text should be justified on the left, 
centered, or on the right within the positioning frame. 

 

 
Color: Use this button to color the font. 

 
Wrap text automatically: When activated a break 
will be inserted automatically after each line.  

Important: The result will be seen once you have 
confirmed the entered text by ticking next to the 
selection box or by pressing the Enter key.  

Adjust font size to title field: If this function is 
activated, the font size will automatically increase 
when the title field is enlarged by adjusting the 
handles. 

 

Title object 

Center   
Clicking this button will position the title back in the 
middle. 

Delete Deletes the whole title object (i.e. text AND all 
settings). 

 

Other text settings 
You can edit titles precisely with different text effects: font, font size, justification, 
spacing etc. 

Line spacing: Cannot be applied to only one line. When applied to multiple lines, this 
alters the spacing between the lines. Line spacing always applies to the entire line. 

Tracking: This controls the spacing between characters. Negative values move the 
characters closer together, positive values move them apart. 

Transparency:  Controls foreground transparency levels. 

Soften: Makes the edge of the shadow harder or softer. 
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Width: Enter the width of the frame in points. 

Filled in: The text will be filled with the color selected in the Title Editor. If the option is 
deactivated, only the frame will be visible, and the background will appear instead of 
the color fill. 

Outline: A border appears around the letters in the text. 

Shadow: The position of the shadow may be set on the horizontal and vertical axes.  

3D: The text appears with a 3D-style outline. The width and thickness of the 3D 
contour (H) can be set in points. 

Color: Clicking on this button opens a color selection dialog, where you can set the 
frame color. 

Animation: Make your credits scroll down the screen or select one of the many other 
text movements from the menu. You can also set the display duration for the title here. 

Background: Specify here whether the text's background should appear black or white. 
This is only meaningful if no other video or image object is in the background. 

Wrap text automatically: When activated a break will be inserted automatically after 
each line. 

Adjust font size to title field:  The text size will be adjusted to fit the size of the 
positioning frame. 

Only use visible TV area: The text will be zoomed so that it will always be within the 
TV's screen area, which is specified in the Movie effect settings (view page 90). 

Audio recording 

 
Songs, noises or instruments can be easily recorded in MAGIX Photostory 
Deluxe using the recording function. The created wave file will be inserted on 
track 2 in Storyboard mode. 

The corresponding sound sources have to be connected and calibrated (view page 
110) for the recording to be correct.  
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Recording dialog 

 

Add sound to entire slideshow: Use this option to begin playback of your slideshow 
from the start marker while recording in order to be able to comment on each photo 
one after the other. At the same time, the recording is cut after every photo. This way 
you can move your photos after recording; the corresponding comment is moved 
automatically.  

Add sound to selected photo: Use this option to play the selected photo and position 
your commentary precisely. If your audio recording lasts longer than the duration set 
for the photo, the display time for each photo is automatically extended.  

Note: When track 2 already has an audio object, the next free track will be used for 
recording. 

Audio driver: Selects the sound card for the recording. 

Save audio file as/ Save in folder: Here you can select the title of the audio file you 
wish to record. You can also select the folder where you wish to store the file. 

Recording quality: Sets the sound quality of the recording. In the preset menu you can 
choose between medium wave radio ("AM tuner"), UKW ("FM Radio"), DAT (Digital 
Audio Tape) and CD quality. 



 

 

More functions and dialogs 109 

 

Display Volume control: Using the peakmeter, you can monitor the level of the 
incoming signal. Please read more on this in the chapter "Adjusting levels" (view page 
110) 

Record: This button starts the actual recording. 

Stop: Click this button to stop recording 

Note: To remove noise that developed while recording, you should try out the effects 
in the Audio Cleaning dialog (view page 85). 

Advanced audio recording settings 
Driver info 
Shows the name of the chosen recording device. 

General options 
• "Mono"  can be activated for recording in mono. This reduces the required 

memory space in half. This is useful for spoken commentary as the microphone 
only communicates a mono signal. 

• "Real-time sample rate adjustment" automatically matches the sample rate of a 
new file to be recorded with the sample rate of the selected slideshow (set in the 
video recording). 

• Automatic damping of volume levels on other tracks ("Ducking"): If you 
slideshow already has a well-modulated soundtrack, and you would like to add 
some spoken comments or other sound material, activate "Automatic damping 
of volume level on other tracks" in the record dialog. This automatically lowers 
the volume of audio objects in the arranger during the recording session. This is 
achieved using an automatically configured volume curve: Before and after the 
recording other tracks will be faded in or out, resulting in a homogeneous total 
volume level. (Lowering of volume level during spoken comments is also called 
"Ducking".) 

Track damping options 
Intensity of damping: Here you can determine by how many dB (Decibels) the volume 
should be lowered. A signaled lowered by about 6 dB will be perceived by the human 
ear to be about half as loud.  

Tip: Depending on the kind of music or original sound, different settings should be 
given a try. If the music is already soft, lowering by 6 dB will probably be enough; a 
hectic original audio track or loud rock music damping should be stronger. 
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Cross fade duration [sec]: Here you can enter, in seconds, how quickly the signal 
should be lowered or raised before and after the recording. 

Hint: Volume damping can be edited later on in the track. You can read more about 
this topic in Volume curves (view page 131). 

Connecting the recording sources 
First, the recording source must be connected to the computer. There are several 
possibilities depending on the equipment you are using: 
• If you would like to import music from a stereo system, use your sound card's 

line-in input. If the stereo system amplifier comes with separate line-out or AUX 
out connectors, they should be used. In this case, they have to be connected to 
the computer's line-in. Hi-Fi amplifiers usually have RCA (composite) connectors 
and the computer has mini stereo connectors. You need to then get a suitable 
cable with two small RCA (composite) connectors and a mini stereo jack. 

• If the amplifier comes without separate outputs (other than the speaker 
connectors), you can also use the headphone jack for recording. Normally, you 
will require a cable with stereo or mini stereo jacks. This type of connection has 
the advantage of a separate volume control to set the headphone input signal 
level. However, headphone jacks are often not very high-quality. For this reason, 
you should use line-out outputs whenever possible. 

• To record cassettes from a tape deck, connect the tape deck’s line-outs directly 
to the computer's line-in. 

• When recording LPs, the record player's outputs should not be connected 
directly to the computer because the phono signal has to be pre-amplified. In this 
case, connecting through the headphone jack or an external preamp is 
recommended. Some record players also have normal line-out connections. 

• If you would like to make recordings with a microphone, connect it to the 
computer using the microphone input (usually a red jack). 

Adjusting the Signal Level 
Adjusting the signal level to the sound card is also recommended to get the best 
sound quality during digital recording. 

Once a recording source is connected to the sound card, the "Record" button opens 
the recording dialog and starts the recording source. 

You can now adjust the recording level with the help of the LED display in the 
recording dialog. For this, you must first check off "Show Levels". 

If the adjustment is set too high, distortion occurs and the incoming signal must be 
reduced. If you have connected the source through either an amplifier or tape deck 
output to the sound card, you can only reduce the signal level in your sound card’s 
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software mixer interface. You can access the mixer directly from within the recording 
dialog via the “Recording Level” button. 

If you reduce input sensitivity by using the input fader, the resolution at which the 
analog signal is digitized is also reduced. Try to set these automatic controllers to the 
loudest sound level possible. 

The maximum setting for an optimal level is the loudest part of the material. The 
loudest part should be adjusted to be the maximum. The actual recording begins when 
you press the "Record" button.  At the end of the the recording you will be asked if 
you want to use the recording. Upon confirmation, the newly-recorded material will be 
placed at the next free position of the start maker in the arrangement. 



 

112   

www.magix.com 

Special functions and wizards 
In this chapter, we will introduce you to some of the especially useful special functions.  

Movie templates 
MAGIX Photostory Deluxe includes ready-made trailer projects for a range of styles 
(e.g. action, documentary, travel...) in which you can replace the integrated 
placeholders with your own photos. This way selected photos are bordered with 
music, intros and titles and are presented in a way that creates powerful trailers. 
Movie trailers can be directly selected when creating a new project or controlled in the 
Media Pool under "Movie Templates". Double-clicking on a template will open it in 
Storyboard Mode.  

Load movie templates 
The movie templates are located under "Import" in the Media Pool.  

 

Some of the templates are available in various lengths. 
Click on a length to see all the templates available in 
that length. 

Double-clicking a movie template opens it in the Movie 
Template Wizard. 

When you play back the empty template, the so-called media placeholders will be 
highlighted in different colors: 

 

 Placeholder for your own title Selected placeholder 

 Additional placeholders for photos 
and videos 

Editing area for active placeholders 
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Insert your own material 
Manual filling 

You can insert your content anywhere you see a media 
placeholder (see illustration). 

The specified length will be displayed on the media 
placeholder. The length cannot be changed. 

The placeholder icons indicate which type of material 
should be inserted here (e. g. group shot, landscape, 
close up). 

1. Drag the desired image or video from the Media Pool or the project temp folder 
in front of the placeholder to be replaced. 
If your inserted video is too short, it will be rejected by MAGIX Photostory Deluxe. 

 
Images always have the length of the controlled media placeholder. 

2. If the video is too long for the media placeholder, move the position of the video 
in the editing area. 

 

Automatic filling 
To add content quickly, use automatic filling.  

Select multiple media items in the Media Pool or in the project temp folder and drag 
them over the movie template. A field will appear where you collect your media. The 
movie template will now be automatically filled. The order of the media items in the 
template determines the date of the files; the sections are selected at random.  
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Note: Depending on the template, either the entire template will be filled with the 
video footage or individual placeholders will each be filled with a video from the 
selection.  

If you do not like the compilation, click on "Reapply" and the program will select new 
video sections. 

Design title 
• To customize the text, click on the corresponding placeholder and enter the 

desired text to the right of the editing area in the text field. 

Further use of movie templates 
Burning (view page 139) and Exporting (view page 162) a filled template works just 
like with any other project. In the "Burn" screen you will find menu templates that are 
specially adjusted to menu templates in the "Menu templates" categories. 

Divide slideshow 
You can divide up your whole slideshow into several individual shows using this 
Wizard. This can be particularly useful if you want to add photos from vacation to one 
slideshow, and photos of the arrival and departure to another. This allows you to 
customize the material and makes navigating through the DVD menu easier.  

There are three available options: 

Group photos according to date: The photos are divided into sections according to 
when they were taken (e.g. days or weeks). A slideshow is made up of one or more 
sections depending on the minimum number of photos specified for a slideshow.  

Create slideshow according to number of images: Enter the number photos a 
slideshow should contain.  

Separate the photos onto the specified number of slideshows: Enter how many 
slideshows should be created. Note that there will only be a few images in a slideshow 
if there are lots of them.  
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Search empty sections 
With these Wizards you can spot gaps in your slideshows quickly.  

Go to next empty range: Moves the view to the next range that doesn't contain image 
or film material.  

Keyboard shortcut: Shift + 5 

Go to previous empty range: Moves the view to the previous range that doesn't 
contain image or film material.  

Keyboard shortcut: Shift + 4 

MAGIX Soundtrack Maker 
The MAGIX Soundtrack Maker automatically generates music tracks corresponding to 
the specified mood. Open the MAGIX Soundtrack Maker using the Edit > Assistants 
menu. 

Choose music style 

 

First choose a music style. Clicking on "Buy more styles" will open the MAGIX Online 
Content Library. Here you can buy more music styles for MAGIX Soundtrack Maker. 

The option "Apply only between start and end marker" lets you limit the length of the 
background music you want to create. You can also set the start and end markers with 
the left and right mouse key if MAGIX Soundtrack Maker is open. 

Set mood change 
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Select a mood from the list. 

Preview: Here you can preview your selected emotion.  

Position: With the position slider you can move to a certain position to set the 
emotions at a certain position. Instead, you can also move the start marker with the 
left mouse button. The preview will be displayed in the video monitor. 

Add emotion: This button inserts the emotion at the current position. MAGIX 
Soundtrack Maker will then suggest a new position for the next emotion by 
repositioning the position slider. Of course you can also put it elsewhere and insert 
further moods. 

Delete emotion: Deletes the current emotion. 

Generate background music 

 

One click on "Create soundtrack" creates a new soundtrack. "Progress" shows the 
current status. 

Variations 

If you don't like the background music that was created, then you can create 
variations. You can do this for the entire background music as well as for individual 
emotions.  

• If you want to vary the entire background music, then simply click "Create 
variations". 

• If you only want this to apply to a certain emotion, then you should first go to it 
with the position slider in the dialog (or the start marker on the main acreen). 
Then activate the option "Vary only selected emotions" and click on "Create 
variations". 
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Musical Cut Adjustment 
Musical cut adjustments gives you the option of automatically displaying the photos 
and videos to the beat of the music, e. g. to sync the picture sequence with the music 
for a music video.  It can be activated through "Edit" > "Wizards". 

To perform musical editing adjustment the music must have tempo and bar 
information. To do this you can use the Tempo and beat recognition which analyzes 
the music and generates the information. The basis for this analysis is the rhythmic 
speed measured in BPM (Beats per Minute). 

Preparation - Setting the start marker and object end 
Before opening the Auto Remix Assistant, you should set the start marker at the 
position in the song object in the project window where you want detection to start. If 
the song contains a long intro without beats, set the start marker after the intro. As a 
rule of thumb, the Auto Remix Assistant should always be "fed" dance music.  

• The start marker should be set before a quarter note beat or, better still, briefly 
before a beat at the start of a bar. 

• If the start marker lies before the song object, the object is examined from the 
beginning.  

• If detection is not performed by the end of the song, the object can be shortened 
accordingly with the object handle at the end of the object.  

Checking the automatic tempo and bar recognition 
The analysis takes place in four steps: 

Step 1: Checking the start marker 

Step 2: Tempo recognition 

Step 3: Specifying beat starts 

Step 4: Application of BPM and beat recognition 

Step 1: Checking the start marker 
Before you start the analysis you should set the start marker at the position where the 
rhythmic music begins. This means that if the song has a long ambient intro, the start 
marker should be set after the intro. If the wizard can't detect any rhythm it will ask if 
the start marker has been set after the intro. If not, you can move it to a better position 
in the dialog. 

If the beginning of the song does not have a definite rhythm, you will be asked if you 
want to move the start marker. 
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Step 2: Checking the automatic tempo recognition 
The Remix Agent will analyze the audio material and try to determine the tempo. The 
object is played back while a metronome click can be heard and numbered green beat 
lines appear in the waveform. 

Under the waveform on the left side the established tempo is displayed in BPM. There 
is a small transport console in the middle to make navigating easier. The slider serves 
as a position controller. To set the metronome volume, an additional fader and mute 
button are provided on the right-hand side. 

The automatic tempo recognition doesn't always work right away. If you don't hear the 
metronome clicking in time with the music, click the "No" button in the upper section 
of the dialog in order to access the manual tempo input dialog. 

To correct the metronome speed and any timeshift that may occur between the 
metronome clicks you can use the tempo correction as well as the "Tap tempo" 
button: 

Tempo correction: The Remix Agent offers various speed settings. The most probable 
tempo detected by the Remix Agent is preset. If this tempo isn't correct, you can 
choose another one from the list. The next time you play back the song it should be in 
sync with the metronome. 

On/Off beat correction: Now it may happen that the tempo is right, but the beats 
have been displaced. "On/off beat correction" provides a number of alternatives for 
moving the beats according to the complexity of the rhythm. Try out various 
alternatives until the metronome clicks are in sync with the beat. 

Tap tempo: Instead of selecting the tempo under "Change Tempo", you can click 
rhythmically on the "Tap tempo" button or press the "T" key. Additional blue lines are 
displayed in the wave display. After at least four taps, the Remix Agent attempts to 
select the correct tempo from the list in "Tempo correction". The display next to the 
"Tap tempo" button displays the current status. Keep tapping until the red display 
showing "Unlocked" changes to the green "Locked" setting. 

Use the "0" key to manually set the quarter beats while the music plays. Surrounding 
markers will automatically be removed to ensure that the set tempo remains intact.  

You can move the markers with the mouse. If you hold down the "Ctrl" key 
simultaneously, the subsequent markers are also moved. 

If the metronome clicks now correspond with the music, you can continue to the next 
step. 
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Step 3: Determining the start of a bar: 
Next you can set the time signature. The default setting is 4/4 but you can adjust this 
if necessary. The beat at the start of the bar should coincide with the high sound of the 
metronome, or the red line in the waveform display. 

It can now be corrected in one step: If the start of the bar can be heard, click on "Tap 
One" once using the mouse or press the"T" key on the keyboard. 

Alternatively, select how many quarter notes the "One" is to be moved back. 

Use the "0" key to manually tap the position of the beginnings of the bars during 
playback. This allows you to correct the beginnings of the bars in longer sections. 

Continue to the last step if the starts of the bars are now correct. 

Step 4: Applying BPM and bar recognition 
Select which action should take place: 

• Create remix objects mode: The object is positioned in the remix object 
according to bar length. What "Audio Quantization" is activated, remix objects 
are precisely arranged on the bar grid. The remix objects can then be 
re-organized in a different rhythmic sequence, mixed with loops or remix objects 
from other tracks etc. 

• Tempo adjustment: If the object and arrangement tempo are to be aligned, you 
can either adapt the object tempo to that of the arrangement via timestretching 
or, vice versa, you can change the arrangement tempo to that of the object. As 
most music has slight tempo fluctuations, the time synchronization is often not 
perfect: After some time the arrangement and the music "drift" apart. If the 
object tempo is to match the arrangement tempo, this can be prevented using 
audio quantization. 

• Save only tempo and beat information: Tempo and beat information will be 
added to the audio material, object and VIP are unchanged. The images on track 1 
will be repositioned according to this information. 
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Travel route animation 
You can use the travel route animation to quickly create maps with animated travel 
routes. You can start travel route animation by going to "Edit  > Wizards > Travel 
route animation" or "Media Pool > Media > MAGIX Tools > Travel route...". 

If you have imported photos with GPS geotags into your movie, you can create a route 
that will appear as transitions between the photos.  

• Position the photos from the start of the trip and the end of the trip directly 
beside each other and select the first photo. 

• Start the travel route animation. The locations will automatically be entered on 
the map. 

• Click on "Animation", save the route as a video and close the travel route 
animation feature. The travel route video will automatically be inserted between 
the photos with transitions included. 

If there are no photos with GPS information, the travel route animation will start 
without locations. Select the locations on the map yourself to export a travel route. 

Program interface of the travel route animation 

 

 Map: Displays map material from openstreetmap.org. 

 Selected locations: All locations, searched using geonames.org or selected 
manually on the map, will be shown on the list and marked using pins. 

 Map section + zoom: The map may be moved by pressing the arrows. "Zoom" 
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enables you to zoom into the current section (+) to view more details or to zoom 
out (-) for a better overview. 

 Show lines: If at least 2 locations are marked on the map, then this function will 
be available for linking the locations. The line color and thickness may be 
changed. 

 Animation: You can animate your travel route and save as video in WMV 
format. 

 Save as image: The current map section may be saved as an image in the format 
PNG, BMP, JPG, or TIFF. 

 

Select locations on the map 
There are several options for selecting locations on the map for creating a travel route. 

Note: The map section will adjust itself depending on how many locations you select 
and where they are. If you would like to view details about a location, simply zoom 
via "+" on the number block or mouse wheel into the detail view. 

Search and select locations: 

 
1. Click on the "+" button below "Edit destinations" to add an entry. This new 
entry will appear blue below existing locations. 

2. Assign the new location a name and press enter. The destination will be added 
to the map. An additional marker is set for the start and end of a route. 

Note: If there multiple locations could be possibly indicated, a list with possible 
choices will open. You can determine the destination by picking one from the 
list with your mouse.  

 

 

If important intermediate stages of the route should also have a 
marker, click on the marker symbol in properties (arrow down) of the 
destination. 

Set destinations manually: 
 1. Move the map boundary by clicking on the map and holding down the mouse 

key so as to make the desired destination visible. 
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2. Click on this button under "Edit destinations" to activate manual entering of 
locations, or use the keyboard shortcut "M". 

3. Click the target destination on the map. The new entry to the list will be 
created. 

Search destination anew: 

 

If the destination is incorrect, you can search the location again in 
order to adjust the position of the marker. 

Enter a new name in the entry field and click on the magnifying glass or 
press enter. 

Rename destinations: 

 

You can rename a destination without changing it by going to its 
properties (arrow down). 

Object follows route: 

 

Various objects can follow the route from 
destination to destination. 

Import GPX file: 

 If you have created a route with a GPS device and saved it as a GPX file, you can 
import it and show the route on the map. 

Note: Depending on the length of the route, it can take some time for the file to be 
imported and displayed. 

Adjust & delete keyframe 

Change the sequence of destinations: 
The order of destinations in the list corresponds to the sequence in which they were 
created. You can edit the order of the destinations by clicking on a location on the list 
and dragging it to a new place with the mouse key held down. The route on the map 
will be adjusted. You can see this especially well if you've activated the line (view page 
124) in order to optimize the travel route display. 
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Adjust the position of the destination: 
You can adjust the position of a destination by grabbing the marker on the map with 
your mouse and dragging it with the depressed mouse key to a new position on the 
map. The marker will be moved, the travel route adjusted and the new name of the 
destination will be automatically changed in the list. 

 

Note: If the destination marker doesn't appear, you can activate it in 
the properties (arrow down) by clicking on the marker symbol. 

 

Hide destination: 

 

Click under properties (arrow down) of a destination on the eye 
symbol. The destination will remain in the list, but will be hidden on 
the map and will not appear in the route. Click on the eye again to 
display the location again. 

Remove destination from the list: 

 
To delete a destination from the list and the route, click on this button next to 
the destination. 

 

Save and load routes 
The entire list of marked locations may be saved to load it later - without having to 
search for and select all of the locations again. 

Save as file: 
 • Click on this button under "Edit destinations" or use the keyboard shortcut 

"Ctrl + S". 
• Enter the save location and name of the location list in the dialog that 

appears. 
• Click "Save" to back up the list and quit the dialog. 

Open list: 
 • To load a saved location list, click this button under "Edit destinations" or 

use the keyboard shortcut "Ctrl + O". 
• Navigate to the save location and select the location list in the dialog that 

appears. 
• Clicking on "Open" closes the dialog and opens the list with saved 

destinations. 
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Adjust map section 

 

Use this button to move the map section upwards (north), to the right 
(east), downwards (south), or to the left (west).  
The arrow keys on the keyboard may also be used to move. 

Click on the point between the arrows to move the map window in order 
to center the selected destination. 

 

 

Use this controller to zoom out of the map (-) or into it (+). The keys "+" and 
"-" on the keyboard or the mouse wheel may also be used to zoom in and out. 

 

If you would like to show all marked locations and reveal as much of the map 
as possible, click this button and the map will be adjusted automatically. 

 If you would like to display only the route without the location markers, click 
here and the pins will be hidden. A repeat click will display them again. 

Show lines (connect locations) 
For two or more marked locations, the function "Show lines" will appear. This function 
connects destinations on a map with a line in order to better visualize the route. 

 
Click this symbol to show lines connecting selected locations. The functions 
responsible for line transparency, thickness, and color are to the right. 

Tip: The order of destinations in the list corresponds to the sequence in which they 
were created. You can edit the order of the destinations by clicking on a location on 
the list and dragging it to a new place with the mouse key held down. The route on 
the map will be adjusted and the line will follow a different course. 

Hide line: To hide the line, click on the "Lines" button again. 

 

Transparency and line thickness: Use the controller to change 
the transparency (left controller) and the thickness of the lines 
(right controller). 
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Line color: Set the desired line color using the color field and 
slider. 

Tip: You can also create animations for the connecting line in the "Animation" (view 
page 125) section and save it as a video. 

Animation 
For two or more marked locations, the function "Animation" will appear. 

 

This enables you to display your travel route in motion and even save it 
as a WMV format movie, e. g. to integrate it into vacation movies or to 
send it. 

Scroll map: Activate "Scroll map" and the map will move from location to location 
when the animation is played back. 

Animate line: The connecting line slowly connects all selected locations, from the first 
to the last. It moves at exactly the same speed as an animated object. 

Soft animation: The animation starts slower, speeds up, and then slows down before 
each location. 

Animate object: You can select an object to follow the route, such as an auto or an 
airplane. This function is used when no particular object has been selected in the "All 
destinations list". 

Duration (seconds): You can adjust the duration of the animation however you like, 
depending on the length of the route. Enter the duration of the animation in seconds. 

 

Preview: Before you save an animation as a video, test it to see if it looks the 
way you want. 

 

 

Click on this button to save the animation as a video. Enter the 
save location and name of the video in the dialog that appears. 

Note: This button indicates the height and width of the future 
image. These values are adjusted as soon as window sizes are 
adjusted or when the location list is shown (arrow next to 
"Destinations"). 
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Close: Click this to leave the animation area. 

Create a picture of a map 
You can create a picture from a section of a map (including location markings), e.g. to 
print it. 

Step 1: Zoom into the map until you have reached the desired level of detail. 

 

Step 2: Click this button (shortcut "Ctrl + E") and enter the save 
location and the name of the image in the dialog that appears. You 
may also select the format for the picture. 

Note: This button indicates the height and width of the future image. These values 
are adjusted as soon as window sizes are adjusted or when the location list is shown 
(arrow next to "Destinations"). 

Step 3:  With one click on "Save", the image is saved and the dialog is closed. 

 
If you want to, you can hide the list of locations to the left to show a larger 
section of the map. 
Another click on this symbol will show the list again. 

Options 
Benchmark: The map legend appears/disappears and also appears on the image or in 
the video. 

Mouse position: The GPS coordinates for the current mouse position appear in the 
lower right-hand corner on the map when this option is activated. Use this option 
together with the "Set destinations manually" function to set destinations precisely. 

Distance:Calculates the total length of the route. 

Map: Specify which maps you want to use. Use the "Shift + M" shortcut to change 
maps when the focus is on the map. 

Hide: Click this to leave the options. 
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Shortcuts 
Manually mark locations M 

Zoom into map "+" on the number block 

Zoom out of map "-" on the number block 

Save location list Ctrl + S 

Load location list Ctrl + O 

Save map section (with location markings) as 
image 

Ctrl + E 

Move map section north (upwards) Up arrow 

Move map section east (right) Right arrow 

Move map section south (downwards) Down Arrow 

Move map section west (left) Left arrow 

Cancel video export Esc 

Change map  Shift + M 
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Create panorama images 
This special function can be selected for highlighted photos under "Effects > Create 
panorama". Using it, you can combine several photos into a wide panorama photo. 

Tip: Optimize you photos beforehand, so that the transitions are not to be seen in the 
finished panorama. 

Select pictures for panorama 
The images that should make up the panorama should be selected one after the other 
while holding down the Ctrl key. Then select the option „Create panorama photo“ in 
the „Effects“ menu (view page 175). 

Invert image sequence for panorama image 
Sometimes photos are accidentally loaded in the wrong sequence.  To sort the 
photos properly, click on the "Invert sequence" button. 

Panorama settings 
Don't use camera movements on panoramas: The panorama image will be displayed 
in your slideshow in its entirety. This option is less effective than a camera pan across 
the image yet well suited for capturing the sheer size of a landscape or city panorama. 

Automatic camera movement from lefts to right / from right to left: The finished 
panorama will zoom in when viewing the finished slideshow. Additionally the camera 
position pans from one edge to another. On one hand this means that no whole 
panorama image will be displayed, on the hand you will be every detail.  

Calculating the panorama image 
If you click "Create", the panorama image will be processed. Depending on the 
resolution and number of original images included, this may take some time. The 
original photos are replaced in your slideshow with the panorama image you've 
created, but the original files on the hard drive will remain intact. 

Hint: You can create a panorama image from a maximum of six images. Click on 
"More options" for more information on the upgrade. 
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Finished panorama (2 images) 

 

Finished panorama from 2 images 

Adjust loudness of all selected objects 
This function adjusts the loudness values of all selected objects according to the 
"reference object". The object that has just been activated is used as the reference 
object. 

Requirements 
• Objects need to be at least 5 seconds long for a reasonable calculation. An object 

length of 10 seconds or longer will provide better results. 
• Background music provides the best results. In the vast majority of cases, music 

provides a homogeneous sound image and minimal volume changes (of course, 
very good results can also be obtained with video material). 

Open 
1. Set the object loudness of the reference object to the desired value. 
2. Select all objects (including the reference object) whose loudness you would like 

to adjust. 
3. Right click the reference object to open its context menu. Select "Adjust loudness 

of selected objects" (for Combo objects in the submenu „Audio functions“). 
or 
Press the Shift key and click on the reference object. Then go to "Effects > Audio 
object effects" and select "Adjust loudness of selected objects". 
Result:  
- MAGIX Photostory Deluxe determines all loudness values for the selected 

objects und adjusts them to fit the reference object. The object loudness of 
the remaining objects will also be adjusted accordingly. 

- If the adjustment results in an object loudness which is so high that it could 
possibly cause clipping, MAGIX Photostory Deluxe will provide an automatic 
correction. This will lower the volume of all objects (including the reference 
object). 
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Problems & solutions 
For objects containing large loudness differences or noises (e. g. in video camera 
recordings) the result may not always be satisfactory. Prepare these objects as 
follows: 

1. Split the object at the corresponding transitions before carrying out the 
function.Loud 

2. Open the function (see Open). 
3. Afterwards transition the objects with simple crossfades (view page 101).Loud 

Automatic volume damping 
If you have added background music to your slideshow or created a collage of several 
videos that will be played back simultaneously, you can specify the "foreground audio" 
by reducing the volume of all other audio tracks. To do this, use the volume decrease 
option in the "Effects" menu.  

1. Select the video that should be heard above the others. 

2. Select "Volume decrease" in the "Effects" menu. The "Volume decrease of other 
tracks" dialog will open.  

• Choose between weak, moderate and strong to decide how much the volume 
should be reduced. 

• Enter the length of the transition: This sets the length of the range for the volume 
decrease of the other tracks and when they will return to normal volume. 

• If only the video sound of the other tracks should be reduced and not an audio file 
such as background music, place tick in the box marked "Only decrease video 
sound". 

• Confirm your entries with "OK". The audio track of the selected video will now be 
heard above all the others. On pure audio tracks on track 4 a volume curve is 
displayed where you can see the decreased range. You can use the handles to 
adjust the decrease manually. 
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If you want to reset the decrease completely, select the adjusted object and go to 
"Effects" > Volume curve > Reset". 

Manual volume decrease 
1. Select "Display volume curve" in the context menu of an the audio track. It will be 
displayed as a colored line. 

2. Double-click on the point in the curve where you want to set an automation point. 

• For a simple volume progression, e.g. a volume decrease, 2 automation points 
(beginning and end) are required. To bring the volume back up to normal after a 
reduction you will need to set 4 automation points. 

• Curve points can be easily moved by drag & drop, during which the mouse 
pointer turns into a cross. 

• An additional double click on an automation point deletes it. 

Note: During audio recording, volume curves can be automatically created if the 
Volume decrease ("Ducking") (view page 109) option is activated. 

Clean-up Wizard 
The Clean-Up Wizard helps you delete projects from your hard drive, including all 
movies and the audio, video and picture files used in them. Use this function to free up 
disk space for future projects. 

Caution: If the files you used in the slideshow have also been used in other 
slideshows (like trailers, opening music, etc.), then you should make backup copies of 
these files beforehand.  

There are two available options: 

Delete certain files: Choose this option if you would like to select certain files for 
deletion. You can select the desired files in the "File selection" dialog. In the next step, 
the Cleaning Wizard automatically looks for other files which belong to your selection. 
Using this method, you can delete an entire slideshow with all of its accompanying 
media, help, project, and backup files. Before they are deleted, you receive relevant 
information in a dialog and a confirmation request. 

Find and delete unnecessary files: Choose this option if you want to find unnecessary 
files or free up some space on your hard drive. The Clean-Up Wizard then 
automatically looks for extraneous files created during use of MAGIX Photostory 
Deluxe. Before they are deleted, you receive relevant information in a dialog and a 
confirmation request. 
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Stereo3D 
MAGIX Photostory Deluxe enables the editing and creation of "genuine" 3D videos 
and photos. First, let's create an overview of this complex topic by familiarizing 
ourselves with the most important principles and the golden rules that are involved. 
Next, we'll look at the individual steps of the workflow in more detail. 

Note on using 3D content: Some people experience unpleasant symptoms (e. g. 
headaches, overexertion, eye strain or nausea) when they are exposed to 3D video. 
We recommend taking regular breaks for this reason. In case of problems, the user 
should immediately stop use and refer to a doctor or optometrist. Incorrect production 
of 3D-content may also produce these symptoms. 

Warning for small children: The sight of small children (especially those younger than 
six years old) is still developing. We recommend referring to a doctor or optometrist 
prior to allowing your child to view 3D-videos. 

3D basics 
Human eyes perceive objects from 2 different angles and our brain "calculates" images 
from this information. This way we can tell the distance and position of an object. For 
this reason, 3D material should be shot according to this principle. 

Viewing 3D 
A regular screen or TV can show images only in 2 dimensions, and various 
technologies have been developed to enable perception of images in 3D. To this day, 
all technologies share the following: You need special glasses to deliver different 
information to the left and right eyes. We will examine these technologies in detail 
later. 

The three golden rules 
• Stay within limits during recording: To make a 3D recording (view page 133) with 

realistic depth information, certain limits must be respected. The most important 
rule is not to go below the point of minimum distance. Minimum point is the 
point in the picture, where the camera is the closest. 

• Frame closest point: In order to place the 3D effect behind the imaginary frame, 
both image components must over lay each other exactly at the closest point. At 
the same time, the same objects must be visible at the edges of both partial 
images, for which, if needed, you can use the Cropping function in the Media 
Pool. 
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Note: The imaginary window is a type of a plane, behind which the 3D movie plays. 
You select the closest, frontmost point. Not keeping up with this rule can result in the 
object to "jump out" of the imaginary window, which when used too much, can cause 
headaches. 

• Maintain realistic eye angles: Object with a 3D depth effect viewed as a red/cyan 
image (Anaglyph) without glasses will appear displaced. This displacement 
should, if possible, take up less than 1/30 of the entire image. Otherwise, it will 
appear that the eyes are looking in different directions. 

Notice: Displacement may only occur along the horizontal axis. Displacements on 
the vertical axis and rotated portions must be adjusted. 

Record 3D 
The distance between eyes in humans is ca. 65 mm, which forms the so-called "stereo 
base width". But because our eyes are dynamic and we can even "cross" our eyes, it is 
possible to focus on objects that are closer. 

Various techniques exist for 3D recording. Each method has its advantages and 
disadvantages: 

• 3D cameras with two lenses: The advantages are obvious; these cameras 
produce 3D material without excessive work involved. The disadvantage is that 
the stereo base width (lens distance) cannot be changed. 

• Two cameras on a special mount: This involves a little more work. Two cameras 
are mounted on a special support to record material for the left and the right side 
of the 3D image simultaneously; microphone booms for stereo recordings may 
also be used for this purpose. 
The disadvantage in this case is that the shutter releases have to be pressed at 
exactly the same time if there are moving objects in the picture. In case of video, 
both movies must be synchronized before being edited. 
Advantages: Stereo base width may be changed by adjusting the distance 
between the cameras; larger selection of camera models. 

• Two photos via the same camera: This technique only allows still images. The 
camera is simply used to record two images from different perspectives, and 
these are used as the right and left images. For best results, use a tripod. 

• Consistently fast camera movement, e. g. along a street: Only a single 
conventional camera is required in this case, but the range of applications is very 
limited. This is the most cost-effective method for creating 3D videos. Material is 
filmed at a speed of circa 6-to 15 km/h. During editing, the edited video object is 
duplicated and one of the videos is played back with a time lapse. The movement 
direction determines which is the right and left image. 3D photos may also be 
created using this method. 
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Warning, minimum distance! 
The position of the object closest to the lens is designated as the minimum point. This 
minimum point may not exceed a specific minimum point; this is easy to calculate via 
the following formula: 

Note: Lens focal point (e. g. 25 mm) x stereo base width (e. g. 65 mm) x 1.5* /1 mm= 
minimum point (2437.5 mm ~ 2.44 m) 
*1.5 is a factor derived from the cut-off appearing when filming through a lens. 
**1 mm is the so-called "deviation" or "spatial dimension". This only involves a rough 
value in this case. 

Examples for 3D cameras: 
Panasonic HDC-SDT750 ( base width 12 mm): minimum point is approx. 1.5 m. 
Fuji REAL 3D W3 (base width 75 mm): minimum point at approx. 3 m; for 
long-distance recordings as much as 8 m. 

This so-called minimum point has an important role in other aspects of 3D editing. 

Prepare 3D editing 
3D videos are filmed and saved by different cameras, which means: depending on the 
camera model or recording method, the videos or images vary. 

In one file 
Many cameras, especially for photo recordings, create one single file containing the 
left and the right image next to one another. 

• Drag these files from the Media Pool directly into your arrangement.  
• Select the created objects. 
• Select the "Side-by-Side (left images left/right)" entry in the Media Pool under 

"Effects > Stereo3D > Properties > Create stereo". 

In multiple files 
Some 3D cameras create a file for each the left and the right side. This working 
technique works also if you simply take 2 pictures with a regular photo camera. 

• In the Media Pool, open the folder in which the desired file can be found. 
• Sort the files in increasing order according to the date. This way, all files will lie in 

pairs one below the other. 
• Now, select the files and drag them from the Media Pool directly into your 

arrangement. 
• In the Media Pool select "Side-by-side (left image right/left) under "Effects > 

Stereo 3D > Properties > Create stereo" for material with halved width. 
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Note: If you have created side-by-side material yourself (e.g. placed two photos next 
to each other in an image file), proceed as described, but at the end select the 
"side-by-side (left image left/right)" for material with full width. 

Note: To load MVC material into MAGIX Photostory Deluxe, you must first activate 
this codec for a fee.  

Set playback mode for 3D 
There are various techniques available for playback of 3D videos on the computer. 
Depending on the technology used, the corresponding playback mode may be 
activated in MAGIX Photostory Deluxe. 

 
Select the 3D mode you want to work with in the lower right corner of 
the video monitor. 

Here is a list of available techniques and the corresponding requirements: 

3D mode Technical Requirements 

View partially interlaced Polarizing filter • Polarizing filter glasses 
• A special monitor, usually 

referred to as a 3D monitor.   

 

Note: You can choose between right or left image first, depending on which type of 
display produces better results on your monitor. 

 

Shutter export Shutter mode • nVidia 3D Vision Kit 
• 120 Hz monitor/projector 

Side-by-side 
Display 

Side-by-side • 3D TV 

 

Note: You can choose between right or left image first, depending on which type of 
display produces better results on your monitor. 

Note: These two modes should only be set if the preview image is displayed on a 
separate monitor. Shutter mode also requires a 3D-capable graphics card. 

Anaglyph display Color anaglyphs • Red/cyan glasses 
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Align videos and images for 3D 
Anaglyph display is recommended for this and can be set in the preview monitor (view 
page 135). Precise geometric alignment of images is only possible in this mode. 

Note: If you want to edit 3D video material, it is recommended to conduct scene 
recognition and split the video into individual scenes. This is necessary because the 
left and right side of each scene must be arranged individually. 

The so-called minimum point is the point in the 3D picture that is closest to the lenses. 
This forms the "center" of the 3D image and must be defined as such in 
MAGIX Photostory Deluxe. 

To do this, go to "Media Pool -> Effects -> Stereo 3D" > "Alignment".  

 

Move both images, one over the other so that the minimum point of both sides is at 
the same location on the screen. 

You should first see whether automations for spatial adjustment and synchronization 
deliver the desired results. Click on the button "Automatic". 

If this does not produce the desired effect, proceed as follows: 
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• Find the minimum point in the image. 
• If the images are offset vertically, they need to be balanced using the lower of the 

two slide controllers under "Spatial alignment". 
• If the images have rotational differences, you have to adjust these with the knob. 
• Try to position the minimum points of both sides precisely on top of each other 

using the upper slider. 
• To test the results, put on the cyan/red glasses. In case the image has an 

exaggerated spatial depth, try to position the left and right sides closer to each 
other using the controls under "Spatial alignment". 

Turn camera movements into 3D videos 
Camera movements may be transformed into 3D videos by being duplicated and 
converted via time displacement. To do so, you can simply record on the right or the 
left side while, for example, driving along a street. 

The speed should be set between 6-15 km/h (approx. 4-10 mph) and depends on the 
frame rate, the focal point, and the distance of the objects being filmed (among other 
things). At increased speeds, it may occur that the spatial impression is too strong and 
the filmed material seems unnatural and unpleasant. 

• If the video is in the arrangement, the stereo depth for the 2D object may be set 
in the Media Pool via "Effects -> Stereo 3D --> Properties". 

• Depending on the direction of the recordings, you will have to move the control 
either to the right or the left.  

• Check the results in the anaglyph display with red/cyan glasses 
• Correct any unrealistic effects by adjusting the controller in the opposite 

direction. 
• If the spatial depth is exaggerated, reduce the changed parameters. 

Note: Not only camera movements, but also other 2D materials may be arranged 
spatially. 

3D material may be edited with the same functions as 2D material. 

Export and burn 3D videos 
There are no special requirements for export and burning. Only the desired 3D 
technique is specified. 

Anaglyph: This technique is recommended for uncomplicated playback of finished 
videos or playback with conventional TV sets or projectors. Viewers must simply put 
on a pair of red/cyan glasses to be able to enjoy a 3D movie. 
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Side-by-side: Create 3D movies for a 3D-capable playback device without having to 
compromise the quality. It doesn't matter initially whether your video is viewed in 
"Shutter" mode or in "Polarized filter". 

• Depending on your playback device, you should set double resolution in order to 
produce full resolution for both the right and the left image. 

• Not all playback devices are capable of double resolution. If this is the case for 
your device, 50 % pinched images will be displayed. The quality is nevertheless 
higher than output using the anaglyph technique. 

Note: When exporting to side-by-side-formats, make sure that the vertical resolution 
is the sum of both images, but the aspect ratio (e. g. 16:9) is based on a cropped 
image.  

Only left/right side: This settings exports only one side of your 3D video instead of the 
entire 3D video. 

Lenticular image: This allows you to view 3D footage without 3D glasses. The footage 
is displayed interchangeably to give the impression that it is wiggling or shaking. 

Superimposed: This export option is similar to „Side-by-Side“. The images are 
superimposed during output. 

• Depending on your playback device, you should set double resolution in order to 
produce full resolution for both the upper and the lower image. 

• Not all playback devices are capable of double resolution. If this is the case for 
your device, 50 % pinched images will be displayed. The quality is nevertheless 
higher than output using the anaglyph technique.  

Note: When exporting to superimposed-formats, make sure that the vertical 
resolution is the sum of both images, but the aspect ratio (e. g. 16:9) is based on a 
cropped image.  

Export files/upload movies to the Internet 
The standard path for all file exports is "File > Export" or "File > Internet". Depending 
on the export format and destination, the export dialog also allows the 3D technique to 
be used to be selected. For direct selection as Windows Media Video 3D, click 
"Output" and select "3D movie" from the dialog. 

Burning 
When burning a Blu-ray Disc or DVD, you must first open the encoder settings in the 
burn dialog and set the desired 3D technology. Next, you may proceed to burn the disc 
as usual. 
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The "Burn" interface 

 
Click on the displayed button to go to the "Burn" screen. 

Here you can burn your slideshows to DVD, Blu-ray Disc or AVCHD including a 
selection menu. All slideshows loaded into the project are taken into account. If you 
want to remove some of the loaded slideshows, switch to the "Slideshow" screen and 
delete the unwanted slideshows from the project there. 

Note: At a screen resolution of 1280 x 1024, the program display changes. This 
makes the program more manageable and easier to use. The work steps remain the 
same in spite of the different display. 

 

 Views: Here you can switch between the „Preview“ and „Edit“ (view page 142) 
views. 

 Preview: This shows you what your disc will look like when you put it into a player. 

 Remote Control for testing the menu function. 

 Categories: Here you can open (view page 141) various types of menu templates. 

 Menu Templates: A selection of designs you can use for your menu. In "Edit" view 
you can combine various elements for different templates to create your own 
design. 
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 Burn: Here you can open the disc selection dialog (view page 34). 
 

Preview and editing 
MAGIX Photostory Deluxe provides two different modes for designing and previewing 
the disc menu. 

 
The preview mode is mainly intended to behave like a DVD 
player or Blu-ray player for checking the disc menu under 
realistic conditions.  
Only templates may only be used; more detailed editing of the 
disc menu is not possible at this time. 

 
During editing, you may adjust many features of the disc menu. 
There are many templates available for this that may be changed 
flexibly once loaded. 

 

Remote control 
The virtual remote control is an important helper when it comes to checking how the 
disc will perform later. 

This remote control works just like a normal remote control and can be used to 
navigate through the disc just like you would on a normal player. The DVD menu 
navigation can now be initiated with the arrow keys or the "OK" button. Activated 
buttons are highlighted. 
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The number keys select the corresponding entry on the menu 
page. All menu entries are marked with a corresponding 
number. Within a chapter menu, playback is started from the 
particular chapter. In the movie menu, the corresponding 
chapter menu (if available) is changed or slideshow playback is 
started.  

Navigation buttons: These buttons can be used to navigate in 
the menu of the disc that will be burned. The entries can be 
changed and confirmed by clicking "OK". The remote control 
works just like the remote control for your home DVD player. 

Skip/move forward/back: This allows you to skip to the next or 
previous scene while playing back your movie. In the menu, you 
can skip forward or back from one menu page to another. 

Play: Starts the first entry in the menu. In case chapter menus 
are available (see menu modes), the chapter menu will be 
displayed first.  

Pressing the Play button again starts playback. 

Stop: Pressing stop halts playback. 

Disc switches to the first page of the movie menu. 

Sub switches into the chapter menu (if available) of the currently selected slideshow. 

Menu 
MAGIX Photostory Deluxe can add selection menus to your slideshows. The menu is 
also burned to disc and appears when inserted into your player. Just like with a 
purchased DVD or Blu-ray DiscTM, you may easily select your movies with the help of 
preview pictures, or access particular chapters within a movie. 

Menu templates 
At the bottom of the screen, you'll see an array of preset menu templates. A tree 
structure is located on the left-hand side for you to choose the type of menu template.  

• Animated: These templates contain background and introductory videos as well 
as music. The DVD menu tools are displayed in various modes (e.g. selected 
buttons). These templates are designed for DVDs. 

• Static: Here you will find templates that are also designed for DVDs. They consist 
of normal background pictures and elements 
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• Unique: These templates adjust to your disc project; the photos you use are 
integrated directly into the menu. 

Note: For these menus both the „Movie menu“ and „Chapter menu“ modes have to 
be activated in „Menu design“. 

• HD (DVD, Blu-ray, AVCHD): These menus contain razor sharp high-resolution 
background images that look especially god on HDTVs.  

If you've selected one of the menu templates, you can use the horizontal scroll bar to 
view all the others available. There are lots of options when using the templates:  

• If you wish to apply a template to all menu pages, click on "Complete" in the 
template bar and double click on the template of your choice. The complete 
template will then be applied.  

• You can also combine the various elements of the individual templates. If, for 
example, you wish to combine the text format of a template with another 
background, select "Text" and double click on the template with the desired text. 
The preview in the middle shows you the results immediately.  

You can load the layout (or individual layout elements) for the current menu (movie or 
chapter) as well as for all menus. 

 
Click on this button to load the current selection for the 
entire disc menu. 

Clicking on the small arrow next to the button opens a 
menu containing additional options for applying the 
current selection to the disc menu or current menu page. 

 
Here you can set the screen format for the disc menus 
(widescreen or 4:3).  

 
Starts the preview of the menu animation 

 

Edit disc menu 
The preview pictures and the menu title can be moved freely in the preview monitor. 
The menu may be edited very flexibly. 

Activate the "Edit" button to do this. 

 

Edit menu elements 
Hold down the left mouse button and drag text boxes or graphical elements to the 
desired position. You can adjust the size by dragging out the corners and edges of the 
frame. 
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You can undo the last steps you made. This means that you can easily try out 
critical operations. If the result does not meet your expectations, then you 
can simply "undo" it and return to the initial status. 

Keyboard shortcut: Ctrl + Z 

 
This command cancels a previous "Undo" command. 

Keyboard shortcut: Ctrl + Y 

 
Set aspect ratio: To avoid distortion, use this button to set the aspect ratio 
for the menu elements.  

 
Group: Menu elements are moved or resized simultaneously as a group, 
including the description text and number. 

 
Fade in TV display area in the preview monitor: This option displays the 
image borders of the television (view page 90) as lines in the preview 
monitor.  

 
Grid: You can precisely align the frame positions with one another using 
the grid button. Using the small arrow next to the button you can open a 
dialog to fine tune the grid settings. 

PSD Import / Export: Clicking on this button imports/exports a 
self-created menu template as PSD file (for further use in Xara Xtreme Pro, 
Photoshop...) 

 

Navigation 

 

• All movies are listed as first entries. The 
corresponding menu level is the film menu. 

• All scenes are listed as second entries next to it to 
the right The corresponding menu level is the 
chapter menu. 

Removing the red check deactivates the corresponding 
entry in the chapter menu. The scenes are still played, 
but you can no longer select them directly from the 
menu. 
• If you click a film entry, then the film menu will 

open in the preview.  
• If you click one of the chapters listed, then the 

chapter menu will open in the preview. 
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Disc options 
Here you can activate or deactivate certain elements or even complete menus. 

Intro video: Press this button to load videos to be used as introductions to your discs. 
The following formats are supported: "*.avi", "*.mpg", "*.mxv", "*.vob". The intro is 
played immediately after the DVD has been inserted into the player. The DVD menu 
will then appear. A check mark "Do not skip" ensures that the intro video must be 
played completely each time the disc is inserted and that it may not be skipped with 
the remote control or otherwise. 

Slideshow & photo menu 
The disc menu essentially consists of two layers: 

Film menu: The upper layer includes the film menu, which is only used if a project 
contains multiple slideshows.  

Chapter menu: This is the lower layer of the disc menu, which takes the photos (in the 
first track of the timeline mode) into the slideshow as chapter entries. 

Note: A chapter menu cannot contain more than 99 entries. If your slideshow 
contains more photos, you should either burn the slideshow without the chapter 
menu or split your slideshow into several parts. 

Preview pictures: Shows/hides the preview pictures in the disc menu. 

Numbering: The numbers beside the menu entries can be selected directly using the 
remote control, but they be disrupted from time to time. Use this option to show/hide 
them. 

Frame: A frame borders the preview pictures. If this is unwanted, it may be removed 
easily using this option. 

Designing a page 

 
Background: Here you have three options for creating a static background 
image for the menu: 

• You can set a certain color value for the background. 
• You can select an image saved on your hard drive or use one of the 

background provided. 
• You can select a frame from your project. 
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Edit menu templates: In the path settings (view page 96), open the PSD editor 
to customize the menu templates. 

 

 
Apply to all pages: Applies changes made on the current menu page to all other menu 
pages.  

 

Only in the deluxe version: New menu pages may also be added or irrelevant pages 
may be removed. 

 Adds a new menu page. 

 Removes the selected menu page. 
 

Animated selection menus 
You can also add audiovisual animations to the disc menus. As required, background 
videos are played as endless loops while the menu is shown on the screen. You can 
also set up background music in various formats or any background picture for each 
menu. 

Sound/music: You can load a music file for the menu background animation. 

Video: Here you can load a video or graphic file for menu background animation. In 
addition to the options for the background graphic (see above), you can also use a 
sequence from a loaded slideshow or from a different video file. 

Background video options: 

• Create animated menu buttons: The preview images for the individual slideshows 
on the movie menu will be displayed as small videos. Set the starting point and 
length of the animation using the sequence option sliders. 

• Use the audio track of the video: The audio track of the background video is used 
with the menu. 

• Play menu animation as an endless loop: The background movie (audio and/or 
video) will be played back as a loop. 

• Length of the menu view is set by: Audio/video or whichever medium is longer. 
Here you can determine the length of the background video. The other medium 
will be played as a loop. 

Create a button design 
MAGIX Photostory Deluxe enables easy editing of all buttons together with their 
menu entries. 
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You can edit menu entries that you created using this 
button or with a double click on the menu. The dialog with 
the properties of the menu entries (view page 147) will 
open. 

 
Edit in MAGIX Foto Designer: You can open MAGIX Foto 
Designer for additional editing of elected menu elements. 

 Apply to all objects: Applies the properties of the selected 
button to all remaining buttons. 

 

New menu items can also be added and irrelevant items can be removed. 

 Adds a new menu entry. 
 

 Removes the selected menu entry. 

Tip: You can deactivate unused menu items in Navigation (view page 143). 

Jump to linked page 

 
To test the targets of menu entries, select the desired 
menu entry and click the button. 
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Menu entry/menu page properties 
Double clicking the preview picture or a menu entry opens an editor for you to adjust 
the preview picture or menu entry.  

 

Menu text 
In the text input field, you can enter any text to match the chosen menu entry. 

 

Set the vertical direction of the text (upwards, centered or 
downward). 

 

Set the horizontal direction of the text (left, centered or 
right). 

Font size: Set the height of the text in pixels. 

Font color: Define the foreground color of the text. 

Font: Set which font and which style (bold, italic, etc.) should be used. 

Shadow: Set the color and size of the shadow that will appear underneath the text. 
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3D effect: If you would like to make your text appear three-dimensional, you can set 
the width, height, and color of the 3D effect. 

Apply to all: Except for the text, all settings are applied to all entries in the current 
menu. 

Menu image 
Use frame from movie: Use the fader to set which frame should be used in the video 
as a preview picture. The numerical input fields are sorted as follows: 
Hours:Minutes:Seconds:Frames. 

Use different graphic: You can also load your own bitmap images to be used as menu 
pictures. 

Hint: It may be the case that there are no menu pictures in some menu templates, so 
changing the menu picture won't have any noticeable effect. 

Actions at the end of the slideshow (Slideshow menu only) 
Here, you can enter which action should be carried out once the slideshow has 
finished playing. You have the choice of:  

Stop playback: This option depends on the DVD player being used. Most DVD players 
show the DVD player's own menu (or background picture) after playback. 

Jump to movie menu/chapter menu: Jumps back to the previously shown menu. 

Tip:  Should one of the two options not be available, please check which menu 
mode is set. 

Jump to next film: The next slideshow will be played without having to do anything 
else. 

Play slideshow as an endless loop: You can burn every slideshow onto a miniDVD or 
DVD as a loop as well. This means that the slideshow is played as a endless loop until 
the next menu entry is accessed using the remote control or playback is stopped. This 
way, you can transform your TV into an aquarium, a train journey, a fireplace or 
anything that you could watch over and over again.  

Note: This option only works with DVDs or miniDVDs. 
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Memory 
Disc type Data storage 

medium 
Menu Quality Length (optimal quality) 

DVD DVD Yes  *** 98 min. 

Blu-ray Disc 
(view page 209)

Blu-ray Disc Yes ***** 110 min. 

AVCHD (view 
page 209) 

DVD/Blu-ray 
Disc 

Yes ***** 30 min./DVD 

160 min./Blu-ray Disc 

*  The display time for some DVD players can be determined in this menu. The 
amount of image material that can be put onto a CD or DVD depends on the sizes of 
the picture files. 

It is difficult to acquire reliable information regarding required memory, especially with 
the MPEG-2 encoder. If the “Variable bit rate” of the MPEG-2 encoder is activated, 
encoding will occur according to the movements in the picture. The required memory 
depends on the film material; an action film would need more memory than a drama, 
for instance. 

In the MAGIX Photostory Deluxe burn dialog there is a display of remaining capacity, 
which estimates directly how much space remains on the selected disc type with 
current settings. As soon as you change Encoder settings (view page 160), the 
capacity display will be updated. 

Tip: The capacity display is only an estimate. For this reason, always make sure that 
you never completely fill the disc space. Instead, leave a buffer in case the files end 
up being larger than the provided estimate. 

If you cannot save your disc project on a single blank CD, you will have to divide it up 
into various parts. 

Note: Further information on MPEG compression and formats can be found in the 
chapter PDF manual in the chapter "Video and data formats" (view page 206). 

Test series with variable encoder settings 
If you would like to know how much memory space you require for various encoder 
settings, you should run some simulations before burning. 
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So you don’t waste any blank CDs while testing, you should activate the “Simulate 
first” option. 

Then create, for example, a short (ca. 5 min.) disc project and simulate burning in 
multiple cycles with various settings. 

After every simulation you can access the created file on the hard disk to check how 
large the file has become. 

From the results, you can extrapolate how much disc space your disc project will 
require. The memory requirements of a 5-minute disc project would have to be 
multiplied by 20 in order to estimate the space required for a 100-minute movie. You 
should also add buffer for the selection menu. (view page 141) 

Separate project onto multiple discs 
Automatically: If the disc project requires more memory than is available on the disc, a 
dialog will appear before burning asking whether the disc project should be 
automatically segmented for multiple discs. Confirm this by clicking “Yes”. The disc 
project will then be automatically divided into individual disc projects and burned 
sequentially onto multiple discs. This is the easiest method as everything is automatic 
and all you have to do is insert a new blank CD when required. 

Manual 

Case 1: If several slideshows do not fit onto a single disc. 
In this case, delete as many slideshows as is needed until the remaining slideshows fit 
onto the disc. You can create a new disc project and load and burn the other 
slideshows afterwards. 

1. Switch back to the "Slideshow" interface. 
2. All slideshows which shouldn't be burned at this time must be placed into a 

project of their own. Save them separately to your hard disk (“File > Manage 
slideshows > Export slideshow file, for example, as “Part 2” and “Part 3”). 

3. Remove the desired slideshows (e.g. "Part2" and "Part3") from the project (menu 
"File > Manage slideshows > Remove from project" (view page 165)). 

4. Switch to the "Burn" interface and burn the first slideshow ("Part 1") to disc. 
5. Create a new disc project (“New” button), switch to the “Edit” view and load it 

into the second slideshow (“Part 2”). 
6. Switch to the "Burn" interface and burn the second slideshow to disc. 
7. Repeat the last two steps for each separately saved slideshow. 

Case 2: If a long slideshow doesn’t fit onto a disc.  
In this case, the slideshow has to be split into two or more parts that will be burned 
separately onto disc. 
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1. Switch back to the "Edit" view and place the playback marker to the position 
where you want to divide the slideshow. Select "Separate slideshow" in the Cut 
menu in the toolbar. 

2. All passages behind the playback marker will be removed from the overly long 
slideshow and made into a separate slideshow. Both slideshows can be 
controlled through the slideshow tab in the arranger. Save both of them 
separately to your hard disk (“Slideshow > Manage movies > Export slideshow 
file” menu option, for example, as “Part 1” and “Part 2”). 

3. Remove one of the two slideshows (for example, "Part 2") from the disc project 
("Manage slideshows -> Remove from project" menu option (view page 165)). 

4. Switch to the "Burn" interface and burn the first slideshow ("Part 1") to disc. 
5. Create a new disc project (“New” button), switch to the “Slideshow” view and 

load it into the second slideshow (“Part 2”). 
6. Switch to the "Burn" interface and burn the second slideshow to disc. 

Edit DVD menus with MAGIX Photo & Graphic 
Designer 
Besides the option of editing the menu template directly in the preview, menu 
templates can also be exported as a Photoshop file (*.psd) and edited in MAGIX Photo 
& Graphic Designer. This provides complete control over the appearance of your menu 
including complex text effects and the design of highlights. 

Export menu 
The transfer of the menu templates to the graphics program takes place in one of two 
ways: 

 

If a complex, longer edit is required or if you have created a menu without a 
template, then use the PSD import/export function in the menu editing 
functions. 

Next, open the PSD file in the graphics program of your choice. 

For smaller changes, you can also shorten this process: click the button "In external 
editor" in the "Disc options" on "Design page".  

 

A temporary PSD file will be added and opened in the program that has been selected 
in the program settings as the menu editor. After editing has been completed and 
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saved in this external program, the temporary PSD file will be imported again and the 
menu page will be updated immediately. 

Menu text with external menu editing 
Menu elements are transferred as a bitmap during PSD export as well as during import 
of the edited PSD. This also applies to the text displayed in the menu. This text may 
also normally be changed in the "Menu entry properties" dialog. The menu text are 
adjusted if movies or chapters are added or removed.  

The PSD contains these texts as a bitmap and cannot be changed. During importing, 
the bitmaps replace the original text entries. By the way, this is maintained, and the 
font will only be set to a size of 0 so that texts are not displayed in duplicate; the menu 
will therefore look identical after external editing. 

It is important that no more movies or chapters are added to the menu. Otherwise the 
preview images, that have also changed along with the menu structure will no longer 
match the bitmap text, since the bitmap text will not match the changed references in 
the menu structure! 

An example 

A chapter with two entries is present. Entry 1 is named "travel preparations". Entry 2 
is named "arrival". A chapter named "the trip" is going to be added between chapter 1 
and chapter 2. The second chapter now becomes chapter 3 and moves to the next 
menu page. 

Normal text behavior: The second entry (now with preview image for the newly 
inserted chapter) receives the new title "the trip". The next menu page features 
chapter 3 as the first entry with the name "the trip". 

Text after external menu editing: The second entry will feature the title "arrival" (as a 
bitmap, as a component of the button), but the preview image will feature the new 
chapter "the trip"! The next menu page now features the preview image for chapter 3 
(formerly chapter 2, "arrival"), this is now called "travel preparations"! The name is a 
component of the button as a bitmap for the first menu entry on the page, and this is 
"travel preparations" on the first menu page. Completely out of order! 

If the number of menu entries displayed is increased, this results from copying the 
layer groups in the PSD (see below). Of course, the rendered text layers are also 
copied into the layer groups, which results in incorrect text again.  

The best way to proceed is to edit the text entries at the very end, since changes 
normally will not follow at this point. If changes are required nevertheless, then 
proceed as follows: 
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1. Restore the "correct" chapters or movie names by resetting the font size in the 
dialog "Menu entry properties" to the default value. Two texts will be displayed; 
the incorrect bitmap and the correct one. 

2. Export the menu template as a PSD. 
3. Delete the incorrect bitmap object in the corresponding layer and re-import the 

PSD. 

Of course, the menu text may also be added from the start via an external graphics 
editing program only (in order to take advantage of the additional options provided in 
this case). Delete the corresponding bitmap objects in the PSD immediately after 
export and replace these with your own text objects. 

Structure of a PSD file 
MAGIX Photostory Deluxe produces a PSD file during export that contains a layer for 
each object of the menu entry. This uses a naming scheme that enables assignment of 
the objects in the file to their contents. Individual layers feature mathematical signs 
that indicate their function. This naming scheme is similar to that featured in Adobe 
Premiere and which is only expanded occasionally in MAGIX Photostory Deluxe to 
describe additional mechanisms.) 

This is how these mathematical characters are used: 

Characters for layer groups 

(+-) or (+) Play button/start film 

(++) Chapter menu button 

(+>) Next page 

(+<) Previous page 

(+^) Root menu button (jump back from chapter menu) 

(+*) Menu title: 

(^^) Layer group is ignored 

Characters fro individual layers 

(-) Layer contains text 

(=1) Layer contains a bitmap with a highlight of the menu element. 

(%) Preview image/thumbnail from the movie to be referenced 
Bitmap information will be ignored during import and only the size and 
position will be exported. 
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Edit externally 
Step 2: Edit menu in MAGIX Photo & Graphic Designer: The created PSD file will now 
be loaded in the external applications.  

Editing a menu for 3 to 5 movies 
Once the PSD file has been loaded in MAGIX Photo & Graphic Designer, the pages & 
layers gallery will open. Each layer of the PSD file will be created with the contained 
objects via the corresponding Photo & Graphic Designer layers. The layer groups are 
represented by the names of the individual Photo & Graphic Designer layers, with PSD 
layer names separated by backslashes (\).  

Find the layers of the group, which you would like to duplicate. In the example, this 
refers to the 4 layers on the movie button ad two layers of the chapter menu button. 
You will have to work a little to ensure visual assignment of the objects to the work 
area, since the program does not select the corresponding objects when a layer is 
selected, and conversely it doesn't select the layer when the work area with objects is 
selected. Open a layer in the pages & layers gallery and select the contained object. 
The selection is displayed in the work space. 

Clicking "duplicate" copies the 6 layers individually with the corresponding objects in 
the pages & layers gallery. The created layers will always be placed at the top position, 
so it makes most sense to copy the existing layers from the lower level to the top. 
Otherwise, the correct order of the new layers may be restored using drag & drop. 

Next, select all of the button's objects while holding the "Shift" key to move them to a 
new position. Normally, the frames and chapter menu objects behind the highlight 
layers also need to be selected and dragged. Multi-selection in the object gallery is not 
possible since the objects are in different layers, and the program will prevent you from 
selecting them together. 

These steps must be repeated for each additional button. 

Finally, the changes must be saved as a PSD file. Select "Export" in the "File" menu to 
do this ("Save as..." does not allow this). 

Add new font to text 
In MAGIX Photo & Graphic Designer, activate the text tool after loading the PSD file, 
and write the desired text next to the movie button. 

Next, localize the existing text layer for the individual movie buttons (page & layer 
gallery, see above). Drag and drop the text object from the background into the 
desired layer and delete the previous text object ("Del" key or "Delete" in the pages & 
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layers gallery). Since naming takes place in the surrounding layer and the objects in 
program themselves don't have names, you don't have to rename anything. 

Repeat this process for every movie button and "Export" the result. 

Adjust background and buttons 
In this case, MAGIX Photo & Graphic Designer features a workflow similar to creating 
new texts.  

For example, when the menu template is open, drag and drop two graphics for 
navigation buttons into the existing PSD. Two new layers will appear in the menu 
template with two new graphics objects. Drag these into the layer with the bitmap 
graphics to be replaced. Renaming them is unnecessary, since the surrounding layers 
take care of this.  

Localize, scale, and move as follows: Create graphics for your new menu, e.g. for "Prev" 
and "Next" buttons, by dragging them into the open PSD. This includes a total of 4 
layers, two button graphics, and two highlights. The highlight layers must be renamed 
and scaled and placed on the screen using the mouse. Move the layers into the "(+>) 
next button" or "(+<) prev button" layer set using drag & drop. 

Import menu back into MAGIX Photostory Deluxe 
After editing, a PSD file is created, which is imported into MAGIX Photostory Deluxe 
again and must then be assigned to a menu page as a template. 

 
If access takes place through "Edit externally" see "Export menu" (view page 
151), this is done automatically during saving and closing of the graphics 
program. Otherwise, use the button "Import PSD" to do this. 

This imports and converts the PSD (saved to an automatically generated folder in the 
folder Content\DVD\Layouts, with TPL files and the generated bitmap files). 

Create DVD menus without a template 
It is recommended that an existing menu template is adjusted first with a graphics 
program. This exercise will help you learn about the functions and structure of a DVD 
menu as a PSD file to create menus without using any templates. 

You can create PSD files without templates if the following is observed.  

• MAGIX Photostory Deluxe can only use bitmap layers from the menu PSD file. 
Text layers are read as a bitmap (graphic) so that MAGIX Photostory Deluxe 
cannot make any changes to the text. Layer effects, etc. cannot be read by 
MAGIX Photostory Deluxe. For this reason, all layers featuring additional 
features in the graphics program need to be reduced/combined to bitmap level. 
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• The correct naming of layers is very important! MAGIX Photostory Deluxe 
assigns the layers and layer groups to the menu items via their names, which 
makes their correctness important. The characters added in front (view page 151) 
of the layer names should therefore be observed. 

A correct menu PSD contains the following elements: 
• background 
• menu title 
• x movie buttons with preview image, frame bitmap, text for menu, text for 

numbering, highlight 
• one chapter menu button per movie button with bitmap and highlight 
• 3 navigation buttons: in front, in the back, and the root menu 

Background: The background utilizes all layers from the PSD file from the very back to 
the foremost "usable" layer groups. All of the layers up until this are combined via 
alpha layering. If the appearance of the background in the graphics and in 
MAGIX Photostory Deluxe is different, then this step may also be made in the graphics 
program. In Photoshop, all associated layers would be combined with the background 
layer. 

Menu titles: In the next step, the layers of the menu title are added and combined into 
a single layer group. This must feature a name that begins with "(+*)". Besides the text 
layer, additional layers such as text background, shadows, etc. may be present. All 
layers are unified as a single layer via alpha layering. 

Film buttons: Layers for film buttons are each combined as a layer group that features 
the prefix "(+-)" or "(+)" at the beginning of its name. The layers themselves have 
different functions that are kept together via this naming prefix. 

Preview image: The name of the layer for the preview image begins with "(%)". In this 
case, MAGIX Photostory Deluxe only reads the position and size of the layer and uses 
this range to generate the preview image. In case multiple preview images are present, 
their right corners will be combined during importing.  

Text layer: This includes text layers beginning with "(-)". "(-) index text" serves as an 
identifier for the naming, all other text layers will bear the name of the button label. 

Highlight layer: The highlight layer is the top of the layer groups. Its name begins with 
"(=1)". This should contain a highlight version (e.g. altered color) of the frame bitmap. 

All other layers will be combined into a frame bitmap. 

Chapter menu buttons: The last portion features the layer groups for the chapter 
menus and navigation buttons. These are named variously ("(++)" or "(+>)","(+>)", 
and "(+^)"), by they feature the same principle the structure. All highlight layers 
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(beginning with "(=1)") become the highlight bitmap; all other layers become the 
buttons bitmap via alpha layering. 

The sequence of the layer groups from the PSD file is basically not considered by 
MAGIX Photostory Deluxe. Characterization in the program takes place in the order 
outlined here, even if the associated layer groups in are saved in a different order in the 
PSD file. 

An exception is formed by movie and chapter menu buttons: arrangement in 
MAGIX Photostory Deluxe takes place in the sequence featured by the PSD file. The 
first chapter menu button detected belongs to the detected movie button, the second 
to the second movie button, and so on. 

Disc selection dialog 

 

In the "Preview" view you can open the disc selection dialog by clicking 
the large "Burn" button. 

 
In the "Edit" view, you can access the same dialog using this button. 

 

 

Here you can select what kind of disc you would like to create.  

• DVD is the right format for projects that will be played back on a normal DVD 
player.  

• Blu-ray and AVCHD are good for playback on high-resolution screens. 
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Burn dialog for DVD player 
Here you can select 
your burner and the 
type of disc.  

If you know 
something about 
encoders, you can 
also adjust the 
encoder settings if 
the preset is not 
sufficient. 

When burning a Blu-ray Disc, go to "Data carrier format" and select whether you want 
to use the MPEG-2 codec or the advanced, but computationally more intensive H.264 
codec. If activated (view page 189), H.264 is set by default, otherwise the MPEG-2 
codec. 

Proceed as follows to burn a disc: 

• Set up burner and burn speed: If multiple burners are installed, you may select 
which device you wish to use in this menu. 

• Encoder settings: Use the "Encoder" button to access the selection dialog to 
specify settings for the MPEG encoder (memory requirements, quality, and 
duration of the MPEG conversion). "Advanced settings" accesses a dialog 
featuring additional options. You can adjust all the fine settings for the MPEG 
encoder here. 

• Burning disc/starting video encoding: The button "Burn disc" starts the disc 
burning process. Every time you burn and every time a simulation is carried out, 
the disc project is encoded. Please note that the MPEG file is not deleted from 
the hard disk after the burn process has finished. Depending on the length of the 
project, encoding and burning may take some time. The time required can be 
seen in the dialog. 
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Creating an ISO image 
The simplest way to create an ISO image is to select "Image recorder" under "Burner". 
When starting the "Burning process", you have to specify a name for the image file you 
wish to create. 

Options 
Simulate first: If you are not sure about the write speed or memory requirements of 
the selected disc, you can simulate the write process before burning.  

Activate buffer underrun protection: Many disc drives support technology that 
prevents the dreaded "buffer underrun". Use this option to activate this protective 
feature and burn your files at higher speeds without risking making a coaster out of 
your blank disc. 

Completely format DVD/CD-RW media: This option reformats the RW media and 
deletes all existing file material. 

Shutdown computer after burning: Activate this option to automatically turn off the 
computer after encoding and burning has been completed. You could, for instance, 
start the encoding and burning process in the evening, and then you don't have to wait 
for the process to finish to switch off your computer. 

DVD-compatible write at least 1 GB: Some DVD players have problems reading DVDs 
which contain less than 1 GB of data.  This option fills the DVD to the 1 GB limit with 
"empty data" so that this problem doesn't occur. 

Burn standard video DVD onto same disc: You can use this option with a WMV HD 
disc to burn an additional normal DVD video. This ensures that your discs can also be 
played back on standalone DVD players. See Multi disc. 

Activate the burner's defect management option: If a certain section of the disc is 
defective, this will be recognized by the burner and labeled. No content will be saved 
there as a result. 

Check data after burning disc: The finished disc will be checked for any mistakes after 
burning. 

CD/DVD title: This is the title of the DVD which is displayed as the disc name on the 
PC. The disc project name is displayed here by default. 
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Encoder settings 
Use the “Encoder settings...” button to access the selection dialog to specify the 
properties of the MPEG encoder (memory requirements, quality, and duration of the 
MPEG conversion) 

Preset: Here you will find useful presets for the selected disc type. Here are some of 
the presets for a DVD: 

Longplay DVD Video DVD with extra-long playing time. The bit rate is reduced, 
which compromises image quality. 

Longplay music DVD DVD with extra-long playing time for music. The bit rate for 
the soundtrack remains at the highest quality level. 

Standard DVD Normal DVD 

Widescreen DVD Normal DVD in 16:9 format 

Note: For all settings, you can choose between NTSC (USA and Japan) (Europe). 

Bitrate: Bitrate determines the size on the disk that the finished video will take up. The 
greater the bit rate, the larger the file, and the shorter the maximum playing time of the 
movie that fits on a disc. 

Adjust bit rate: The expected file size of the finished video is estimated, depending on 
the set bit rate. If the movie does not fit onto the disc, the bit rate is corrected 
accordingly. 

Quality: Specifies the quality of the encoding process. The higher the quality, the 
better the finished video will look; however, encoding will take considerably longer. 

Smart Rendering: With Smart Rendering you can significantly reduce the encoding 
effort for MPEG files. During the production of MPEG files, only those parts of the 
movie that were changed in the program are re-encoded. Please note: The MPEG files 
contained in the movie must have the same format, i.e. the bit rates (variable or 
constant), audio formats, image resolutions and video formats must match. 

Anti-interlace filter: Activate this option only for playback on a TV screen, where it 
reduces horizontal flickering around fine details. 

Calculate video effects on GPU: To accelerate exporting, you can let video effects be 
calculated on the graphics card. At this time this applies to brightness, gamma, 
contrast, color, saturation, image size, cropping and position effects as well as various 
fades and mixes. Please note that external effect plugins and elaborate artistic effects 
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must be processed on the CPU and for this reason using this function will not yield any 
speed advantage. 

Note: This function is specifically optimized for NVIDIA graphics cards. You can, 
however, experience acceleration with other types of graphics cards, too. 

3D mode: If you have 3D material in your project which has been edited with 
Stereo3D, you can select here in which mode it should be burned to disc here. 3D is 
switched off by default. 

To return to the standard settings, press the Reset button. 

Via "Advanced" you can reach the "Advanced settings" dialog. Here you can make 
changes to all MPEG encoder settings. Read the \ "MPEG-1/2 encoder-settings" 
appendix (view page 192) and "MPEG-4 encoder settings" (view page 194) in the PDF 
manual or program help. 
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Export 
The "Export" button opens the export dialog which features the most important export 
options for your slideshow.  

 

 

Note that you will only export the current slideshow. Other slideshows in the project 
and the disc menu are not included. 

On Computer 
This option recalculates a slideshow including all objects, effects settings, transitions, 
texts, and other features into a video file and saves it on your computer. 

Select a certain quality (e.g. DVD quality) and a file format (e.g. MPEG -4). The dialog 
provides further information about the properties of your selection. 

Note: Only the most familiar and most often used formats are listed as options. "File 
-> Export slideshow (view page 167)" features many additional file formats. 
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On device 
This window lets you transfer your finished video to external devices. From within the 
list, you can create slideshows in lower, standard or HD resolution and transfer them 
to a connected mobile device for Android, iOS or Windows. 

Publish online 
This option uploads your movie directly to YouTube, flickr or Facebook (deluxe version 
only). YouTube® is likely the most famous portal for homemade clips. 

Community: Here you can select the platform: YouTube, flickr or Facebook. 

Title: Here you can enter the slideshow title. 

Description: Here you can enter a short description of your slideshow to inform other 
members of the community. 

Category: Pick a category for your slideshow. 

Publish: Decide whether your slideshow should be "Private", meaning  only for you 
and persons authorized by you, or freely accessible, meaning  "Public". 

Export settings: Set various quality settings. 

Photo book 
You can order images from your projects or from within the Media Pool as a photo 
book, calendar, photo mug or in another gift format. MAGIX Photostory Deluxe 
transfers the images to separate program CEWE Photoworld. 

Under "Projects", select whether you want to use photos from all opened slideshows 
and/or the photos selected in the Media Pool. 

When you click "Create", all selected photos for the photo book software will be 
copied into a separate folder. (You can change this folder under "Folders"). All the 
edits and optimizations that you have applied to the photos are included, and the 
photos remain this way when you order a photo book. 

Following this, the CEWE Photoworld software will open. Select your product and 
follow the program instructions. 

Note: The My CEWE Photoworld program must be installed to order personalized 
gifts from CEWE (photo books, prints, mugs etc.). The program is pre-installed along 
with MAGIX Photostory Deluxe. If it is missing, you can find it on the installation CD 
in the "Add-ons" folder or on the CEWE PHOTOBOOK website . 

https://cewe-photoworld.com/creator-software�
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Menus 
In this chapter you'll find the full menu list of your copy of MAGIX Photostory Deluxe 
and the corresponding functions. 

File Menu 
New 
Project 
Opens the welcome dialog (view page 25). Choose what you want to do next. 

Photostory Wizard 
This option opens the Photostory Wizard (view page 21) for creating a new slideshow. 

Open 

 
This menu item loads a previously saved MAGIX Photostory Deluxe project. 
Please note that the related files must be accessible. 

MAGIX Photostory Deluxe searches for the used sounds, pictures and videos under 
the path to where you last saved the disc project. 

Keyboard shortcut:  Ctrl + O 

Recently opened projects 
Project that you have recently opened in MAGIX Photostory Deluxe are listed and can 
quickly be opened with a click. 

Open automatically saved project... 
This option loads an automatically created slideshow backup. This type of automatic 
backup gets the file extension MV_ (underscore). This command is only intended for 
use in emergencies, e.g. if you unintentionally saved your change and wish to return to 
the previous version of the project. 

Keyboard shortcut: Alt + O 
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Manage slideshow 
Remove from project 
This option removes the current slideshow from the project. 

Keyboard shortcut: Shift + F4 

Rename 
You can enter a name for the current slideshow here. 

Attach 
This function attaches an opened slideshow to another one. This attaches it to the end 
of the opened slideshow and automatically applies the original slideshow's settings. 

Attach an opened slideshow: An already opened slideshow can be selected from the 
list and attached. This option is only available if your project contains multiple 
slideshows. 

Attach the last edited slideshow: All of the slideshows that were last edited are listed. 
This option is only available if other slideshows have been previously edited. 

Load and attach a slideshow: Click a folder and a dialog will open to select a 
slideshow. Navigate like in Windows Explorer to the folder that contains the desired 
slideshow. Double clicking on a slideshow file (*.mvm) opens it and attaches it to the 
current slideshow. 

Import slideshow file 
Use this option to load a slideshow into your project. 

Please note that all related photos must be accessible. MAGIX Photostory Deluxe 
searches for the used sounds, pictures, and videos from the path to where you last 
saved the slideshow.  

Keyboard shortcut: Ctrl + O 

Export slideshow file 
A dialog opens where you can specify the path and name of the slideshow. The 
slideshow can then be imported again into other projects. 

Note: The slideshow file (*.mvm) contains all information about the used media files, 
cuts, effects, and titles, but not the picture and sound material itself. This is found in 
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the recorded or imported media files that remain unchanged during the entire 
MAGIX Photostory Deluxe editing process. To save the full slideshow into a 
dedicated directory, for instance to continue editing on a different PC, please use the 
function "Copy movie and media into directory". 

Save 

 
The current disc project is saved with the name displayed in the project 
window. If you have not yet specified a name for your project, a dialog will open 
wherein MAGIX Photostory Deluxe asks you to do so. 

Keyboard shortcut: Ctrl + Alt + S 

Save as... 
A dialog opens where you can specify the path and name of the video, under which it 
is to be saved. 

Keyboard shortcut: Shift + S 

Import from camera 
Opens the import dialog (view page 92) for digital cameras, so you can insert images 
into MAGIX Photostory Deluxe directly from your memory card.  

Import from computer 
A dialog for importing media files opens. Choose between "Search" and "Automatic 
import". 

Search: A dialog for selecting media files opens. The selected files will be imported 
into the current slideshow after "Open" is clicked. 

Note: Media files can be dragged and dropped into the slideshow from the Media 
Pool much more conveniently. 

Import automatically: To copy photos from a digital camera to the computer, the 
accompanying MAGIX Photo Manager program will open. As soon as the program is 
ready, connect the digital camera with the computer. The imported photos can be 
conveniently dragged from the Media pool into the slideshow. Please also read the 
MAGIX Photo Manager help file by pressing "F1" from within the program. 

Note: Files from your digital camera are easier to import if you use the camera import 
tool.  
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Scan image 
Scan photo externally... 
Opens MAGIX Foto Designer for scanning photos. This function is required if there are 
problems when scanning with MAGIX Photostory Deluxe. 

Keyboard shortcut: Alt + Shift + A 

Export 
This provides all export formats supported by MAGIX Photostory Deluxe that aren't 
covered by burning. Refer to "Exporting" for more information. 

Video as AVI 
When exporting to AVI video you can set and configure the size and frame rate of the 
AVI video and the compression codec for audio (audio compression) and video 
(Codec). Please also observe the general information on AVI video formats (view page 
207) in the PDF manual. 

Keyboard shortcut: Alt + B 

Video as MPEG video 
MPEG stands for "Motion Picture Experts Group" and is a high-performance 
compression format for audio and video files.  

Details on the settings of the MPEG encoder can be found under "MPEG-2 encoder 
settings" (view page 192). 

Keyboard shortcut:  Alt + H 

Video as MAGIX video 
Exports the project in MAGIX video format. 

This format is used for video recording by MAGIX Photostory Deluxe video software 
and is optimized for digitally editing high quality video material. 

Keyboard shortcut: Alt + D 

Video as Quicktime Movie 
Exports the project in QuickTime Movie format. This format enables streaming 
playback of audio or video files via the Internet. 
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Note: The Apple QuickTime Library must be installed for QuickTime files (*.mov). 

Keyboard shortcut: Alt+E 

Video as MotionJPEG AVI 
Opens the export dialog for AVI video in Motion JPEG format.  This format is 
supported by digital picture frames, for example. 

Windows Media Export 
Exports the arrangement in Window Media format. This audio/video format is 
optimized for the Internet.  

You can also use it to archive your movies in high-quality when compared to 
MPEG-sized files. Windows Media is an alternative if you would like to view your 
movies primarily on your PC. Pocket PC and Smartphone movies are also created with 
the Windows Media Format.  

Depending on your requirements you can choose between different profiles. If the 
Windows Media Encoder 9 is installed (which can be downloaded free of charge from 
Microsoft) you can edit the profiles or add your own. 

Two pass: The video is compressed in 2 stages in order to export highly-compressed 
videos for the Internet optimally. 

Slideshow: Lets you create slideshows with audio soundtracks. The created files are 
very small despite their high image quality, since only still images (no transitions or 
movement effects) are displayed. 

In the dialog you can add the author name, copyright details, and a description.  

Keyboard shortcut:  Alt + F 

Advanced settings 
Here you'll find more on the advanced settings in the Windows Media Video Export 
section. You can enter precise details for the format you wish to create. Profiles from 
the system or from another file can also be imported. 

Video as MPEG-4 video 
MPEG-4 is the most advanced video format available at the moment. Unlike other 
formats, it provides very high-quality pictures with the same file size. 
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Details on the settings of the MPEG encoder can be found under "MPEG-4 encoder 
settings" (view page 194). 

Shortcut:  Alt + K 

Video as HEVC... 
HEVC is the successor format to MPEG-4. HEVC (view page 197)allows for the same 
image quality across file sizes, even when smaller file sizes are used. The improved 
image quality can be clearly seen, especially at lower bitrates. 

Shortcut: Alt + V 

Single frame as BMP file 
Exports the image located at the playback marker and displayed in the video monitor 
as a bitmap (*.BMP) file. 

Keyboard shortcut: Alt + M 

Single frame as JPG 
Exports the image located at the playback marker and displayed in the video monitor 
as a JPEG (*.JPG) file. 

Keyboard shortcut: Alt + N 

Output as media player 
You can export your movie as an HTML-enabled media player if you want to play it in 
an Internet browser or embed it on a web page. 

• Select the desired quality. 
• Click on "Save video". 

In target folder, an HTML and an MP4 file will be created for further use. 

Video 
Generates a media player with multimedia slideshow as a video file including all 
applied effects and background music.  

Select the desired quality and click on "Save video". In target folder, an HTM and an 
MP4 file will be created for further use. 
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Media: 
Generates a media player with all photos, videos and music individually without 
effects. 

Select the desired quality and click on "Save video". In target folder, an HTM and an 
MP4 file will be created for further use.  

Online 
This is a list of menu entries regarding all of the services that are available directly 
from within MAGIX Photostory Deluxe. 

Catooh – the Online Content Library 
If your project is missing pictures, videos, DVD menus, sounds, or samples, then you 
should have a look at the huge selection available at Catooh. There you'll be able to 
buy media in excellent quality for low prices: DVD menus, Slideshow Maker styles, 
decorative elements, 3D power effects, 3D transition series, MAGIX Soundpools, 
songs, ringtones... Perfectly suited to all MAGIX photo, video, and music projects. 

Import media from web... 
Opens the MAGIX Photostory Deluxe Media Browser  

Export to device... 
This command opens the dialog for outputting the completed video or its soundtrack 
to various mobile devices such as smartphones and tablet PCs.  

More information about this is available in the „Output“ (view page 163) chapter. 

Keyboard shortcut:  H 

Burn to CD or DVD 
Opens the Burn dialog (view page 139) to burn the current slideshow.  

Backup copy 
Files must be saved to be able to be easily retrieved in case of a hard drive crash or 
some other error. 

Copy project and media into folder... 
The project and all of the files it contains are saved together in one folder. Use this 
function to transfer an entire project to another computer. 
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Keyboard shortcut: Shift + Q 

Copy slideshow and media into folder... 
The slideshow and all necessary files can be saved in any folder.  

Keyboard shortcut: Shift + R 

Burn project and media 
Use this option to burn the project with all relevant slideshows and their files to CD or 
DVD.  

Even larger projects can be burned straight to disc. The project, if necessary, will be 
split up and burned automatically to multiple discs. A restore program which is burned 
to the first disc of this type of backup, guarantees easy re-recording of the backup. 

Burn slideshow and media to CD/DVD 
Use this option to burn the slideshow and all relevant files to CD or DVD.  

Even larger slideshows can be burned straight to disc. If necessary, the slideshow will 
be split up and burned automatically to multiple discs. A restore program which is 
burned to the first disc of this type of backup guarantees easy re-recording of the 
backup. 

Keyboard shortcut: Alt + Shift + R 

Burn project (image) again 
All necessary files, menus, and encoded video files needed to burn a CD/DVD will be 
temporarily stored on your hard drive. After your disc is burned, these are not 
automatically deleted. Use "Burn disc project (image) again" enables you to burn as 
many discs as you would like without having to encode the files again. 

Select the desired image. All necessary files are then transferred to MAGIX Speed 
burnR. 

Tip: Consult the program help file for more information on using MAGIX Speed 
burnR. 

Additional programs 
This menu item provides direct access to the tools and programs included.  
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Settings 
Slideshow... 
Opens the settings (view page 94) for the current slideshow. 

Project... 
Project name:Give your disc project a name. This name will be used as a preset title for 
the disc you are going to burn. The slideshows will also be given this name. 

Use 16:9 aspect ratio for current disc project: This option lets you edit the slideshow 
from the very beginning in 16:9 format. The video monitor's size changes to 
correspond to this. 

Cut new images to fit screen automatically: Images that do not correspond to the 
slideshow's ratio are adjusted automatically. The zoom factor is set in such a way that 
there are no black bars to the left or right or top to bottom. 

Program... 
This menu item opens the program settings (view page 95). 

Keyboard shortcut: Y 

Slideshow effect settings 
This menu item accesses the slideshow's effects settings (view page 62). The settings 
made here apply to the entire slideshow. 

Keyboard shortcut: M 

Reset program settings to defaults. 
Use this function to reset all program settings (view page 95) you made in 
MAGIX Photostory Deluxe to their original settings. 

Exit 
Closes MAGIX Photostory Deluxe. 

Keyboard shortcut: Alt + F4 
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Edit Menu 
Undo 

 
You can undo the last steps you made. This means that you can easily try out 
critical operations. If the result does not meet your expectations, then you 
can simply "undo" it and return to the initial status. 

Keyboard shortcut: Ctrl + Z 

Redo 

 
This command cancels a previous "Undo" command. 

Keyboard shortcut: Ctrl + Y 

Cut 

 
This function deletes the selected photo (or the selected object in the Timeline 
mode) and copies it to the clipboard. You can then use the "Paste" command 
to copy it into any slideshow. 

Keyboard shortcut: Ctrl + X 

Copy 

  
This command copies the selected scenes (or the selected object in Timeline 
mode) to the clipboard. From there you can paste it into any other slideshow 
using the "Paste" command. 

 

Keyboard shortcut: Ctrl + C 

Paste 

 
This command inserts the clipboard material (photo or object) into the 
slideshow.  

Shortcut:  Ctrl + V 
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Delete 

  
This command cancels the selected photo (or the selected object in Timeline 
mode). 

 

Keyboard shortcut:  Del 

Wizards 
This menu entry contains different aids for different tasks in MAGIX Photostory 
Deluxe. 

Photostory Wizard 
Opens the Photostory Wizard (view page 21). 

Divide slideshow 
You can divide (view page 114) up your whole slideshow into several individual shows 
using this wizard.  

Slideshow Maker 

 
This is where to open Slideshow Maker. 

 

Soundtrack Maker 
This command opens the MAGIX Soundtrack Maker. 

Musical editing adjustment 
Opens the musical editing adjustment to adjust (view page 116) the photo display to 
match the beat of the music. 

Cleaning Wizard 
Use this function to free up (view page 131) disk space for future projects.  

Travel route animation 
Opens the dialog to create travel route animations. (view page 119)  
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Exchange 

 
Replaces the selected object with an object selected in the Media Pool. 
Length adjustment moves the objects following it correspondingly. 

If photo objects are removed/exchanged, then the display duration will remain. 

Split object 
This command cuts a scene at the point where the start marker is positioned. This 
way, two free-standing objects are created.  

You can isolate a part of an object in order to delete it: 

1. Place the start marker where you'd like to have it by left clicking in the timeline. 
2. Select the video object by clicking on it and click on the cut button.  
3. Place the start marker at the end of the part you wish to remove and click on the 

cut button again. 
4. Select the middle object that was created and press the "DEL" key. 
5. Pull the object at the back to the front; it should automatically snap into place. All 

subsequent objects will be moved along in unison so that no gaps appear. 

You can also use this function to apply effects to a certain part of an object only. 

Keyboard shortcut: T 

Search empty sections 
With this wizard you can spot gaps (view page 114) in your slideshows quickly.  

Select all objects 
All objects in the project will be selected. 

Keyboard Shortcut:  Ctrl + A 
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Effects Menu 
Image optimization 
This places the image material in the right light, sharpens shaky recordings, and 
corrects tint, all conveniently from the Media Pool (view page 43). 

TV picture 
This submenu item performs various adjustments for the TV picture. Besides interlace 
and anti-flickering filters, you will find the option to adjust the image to the real 
proportions of the TV picture. A special algorithm ensures an optimal ratio between 
image size and image borders (anti-cropping). 

Interpolation for interlace material 
Choose this option to remove interlace artifacts from your video image. If, for instance, 
you extract freeze frames from a video, ridge structures appear in sequences which 
feature movement. 

Anti-flicker filter 
Choose this option for still pictures with detailed structures and high contrast. This 
filter reduces line flickering during TV playback. 

Border cropping adjustment: 
Select this option if the edges are cropped during playback on your television. Values 
stored in "Slideshow effects settings (view page 90)" will be applied. 

Distortion 
Image material can be transformed in various artistic ways; a broad palette of effects is 
available to you for this in the Media Pool. 

View & animation 
These effects allow properties like section, image size, position, and rotation of image 
and video objects to be specified in the Media Pool. 

Stereo3D 
This accesses the program's Stereo 3D functionality. Please read the corresponding 
chapter "Stereo 3D". (view page 132) 
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Design 
Add different decorations, speech bubbles, and animations to photos directly in the 
Media Pool to add life to your slideshow. 

Rotate right 

 
Rotates the photo 90° clockwise. 

Keyboard 
shortcuts: 

Ctrl + Alt + F to the right 

 Ctrl + Alt + G to the left 
 

Automatically cut to fit monitor 
This option enables photos to be adjusted to suit the current format. In this case, the 
picture is zoomed in to such an extent that the upper and lower parts of the photo are 
hidden and the annoying black bars to the sides disappear. The consequence of course 
is that portions of the image will be missing. 

Keyboard shortcut: Shift + A 

Display duration... 
Enter the display duration for the current photo here in [Minutes]:[Seconds]:[Frames]. 

Apply to area between the start and end markers: Applies the settings to all photos 
located between the start and end markers. 

Apply to all: The settings are applied to every photo in the current slideshow. The 
settings will not be applied to photos in additional slideshows in the project. 

Edit image (external)... 
The command "Edit image (external)" enables photos to be edited with the MAGIX 
Foto Designer graphics program. The command appears in the context menu for every 
image. The context menu opens by clicking the small FX button at the top edge of the 
photo box.A dialog window of the MAGIX Foto Designer wizard appears. This is a 
clever little helper that recommends several typical photo tasks from which you can 
simply select the specific task, mark with a cross, and then send your picture to 
MAGIX Foto Designer.  MAGIX Foto Designer opens and loads the selected 
picture.In MAGIX Foto Designer you are supplied with the necessary instructions for 
editing your photos. Have fun experimenting! 
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After editing has been completed, the modified picture will be used instead of the 
original material. 

Retouch redeye, select clippings, apply creative distortions ("flowing color"), enhance 
Internet photos, and much more. The integrated MAGIX Foto Designer makes it 
possible. Even unsuccessful recordings can be fit for presentation in the blink of an 
eye. Read more on this in the MAGIX Foto Designer help. 

Create panorama image... 
With only a single click you can create a panorama (view page 127) in 
MAGIX Photostory Deluxe. You can do this fully automatic or manually. 

Show/Hide 
Hides or shows the selected object. 

Transitions 
Here you can find all transitions from MAGIX Photostory Deluxe, sorted into various 
categories. One click on a category displays all of the transitions that are contained. 

To load a transition, drag it with a held-down mouse key onto an object. 

You can find additional information in the "Transitions" section. 

Picture-in-picture collages 
These work similarly to normal picture-in-picture effects, but more objects are used. 
Depending on the collage, arrange the selected objects one after the other and drag 
the collage onto the first object. 

Background design 
Select a color, a picture, or any video on your hard disk, which you would like to serve 
as the background for the photo displayed. This function is especially useful when 
photos have black bars around them, or if they are reduced in size. 

You can use the arrow to move quickly to the previous or next photo in the slideshow 
and adjust the background. 

Reset background 
Resets the background for the currently selected object.  
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Image stabilization... 
Opens the image stabilization dialog to help you correct blurry footage. Please read the 
"proDAD Mercalli 2.0" (view page 65) section. 

Title Editor 

 Title Editor (view page 104) 

Keyboard shortcut: Ctrl + T 

Save as title template... 
If you have designed special titles, these can be saved as a template. Titles will be 
saved in the titles folder in MAGIX Photostory Deluxe to make them easier to find in 
the Media Pool (under "Titles). 

Keyboard shortcut: Ctrl + Shift + E 

Convert to 3D title... 
The title object is transformed into a 3D object. You can choose a template in the 
Media Pool in "Title < 3D". 

Fade in date as title 
MAGIX Photostory Deluxe can add a time or date ("timecode") to the picture material. 
To add a timecode, right click the image and choose the "Fade in date as title" option 
from the context menu. 

If a photo file is involved (i.e. a photo created with a digital camera that contains EXIF 
data), then the date the picture was taken will be added. If a different kind of file is 
involved, the creation date will be used as the timecode. Next, the title editor opens for 
you to customize the entry. 

Sound optimization 
The "Audio cleaning (More information can be found in the section "Sound 
optimization" on page 85)" dialog will open to help you remove noise. 

Keyboard shortcut: Shift + W 

Adjust loudness of selected objects 
This function adjusts the loudness of all selected objects to fit the last activated object. 
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You can find more information about this under "Adjust loudness of selected objects" 
(view page 129). 

Volume settings 
If you have added background music to your slideshow or created a collage of several 
videos that will be played back simultaneously, you can specify the "foreground audio" 
by reducing the volume of all other audio tracks (view page 130).  The "Volume 
decrease of other tracks" dialog will open.  

Volume curve 
Display volume curve: Here you can edit the volume curve (view page 131) to 
decrease the volume in specific ranges. 

Reset volume curve: All adjustments to the volume curve are deleted. 

Effects settings 
Apply to all objects: Copies the current effects settings to all objects in the Arranger. 
Use the dialog to specify which settings should be copied. 

Apply to all following objects: Copies the current effects settings to all of the following 
objects in the Arranger. Use the dialog to specify which settings should be copied. 

Copy: Copies the current settings to a new object. Use the dialog to select which 
settings should be copied. 

Keyboard shortcut: Alt + Shift + K 

Insert: Inserts the current settings on a new object. Use the dialog to select which 
settings should be copied.  

Keyboard shortcut: Alt + Shift + U 

Reset: This "effect" is actually no effect. In fact it disables all applied effects.  

Keyboard shortcut: Alt + Shift + C 

Object properties 
This function displays all the information about the currently selected objects such as 
file name, position on the hard-drive, tempo, etc. You can also set a background color 
for the object to make it stand out and easier to find. 

Keyboard shortcut: Ctrl + E 
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Share Menu 
Here you will find many options for for quickly and easily publishing your data from the 
program on the web. Additionally, data transfer into other programs for specialized 
editing, if you have such programs installed, is enabled. 

Share online 
Youtube/Flickr/Facebook 
This is the direct connection used to upload your slideshows as videos from 
MAGIX Photostory Deluxe to Youtube, Flickr or Facebook. 

Upload current slideshow as video 
Loads current slideshow to the selected platform or community Enter the data for 
video into the fields provided, so that the search function for this portal can also find 
this video. 

MAGIX Photostory Deluxe partially uses the H.264 format for this, which is a 
component of the MPEG-4 codec. Because Flash directly supports this format and 
most communities and portals use it already, the slideshow doesn't have to be 
rendered again on each server. This avoids loss of quality. 

When HD material is uploaded, a resolution of 720p is used for the HD format. 

Upload all selected media in Media Pool 
Uploads the media selected in the Media Pool to the corresponding portal or the 
selective community. 

Additional options 
The additional options in the "Share" menu vary depending on the installed software. 
For example, you can edit photos or graphics in Xara Web Designer or Xara Photo & 
Grahpic Designer, the audio can be improved in MAGIX Audio Cleaning Lab, or you 
can add audio dubbing to your movie with MAGIX Music Maker. 
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Help Menu 
Help 
This command is available for almost every feature of the program, and it opens the 
"Help" file for the corresponding topic. Use this command to get help on any of 
MAGIX Photostory Deluxe's functions. 

Keyboard shortcut: F1 

Context help 
The mouse cursor will turn into an arrow with a question mark.  

Click on any button of the main screen, to open program help which will describe the 
control element in question. 

Shortcut:  Alt + F1 

PDF manual 
Opens the manual in PDF format. Similar to the Help feature that can be accessed by 
pressing F1, this manual contains all of the important information about the program. 

magix.info 
Do you have questions, need help, or are looking for expert tips and tutorial videos on 
using your MAGIX product? At magix.info you will find answers and solutions as well 
as workshops and a comprehensive user forum for software and multimedia queries. 

You can access magix.info online at www.magix.info 

Show introduction video online... 
The online introduction video is a great way to quickly familiarize yourself with 
MAGIX Photostory Deluxe. 

Display tooltips 
Tooltips are small information windows that open up automatically if the mouse 
pointer stops briefly on a button or some other area. They provide information about 
the function of the button. These information boxes can be switched on or off with this 
option. 
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Register online 
This option opens the MAGIX homepage for online registration where you can register 
as a MAGIX user. 

Registration grants you access to the MAGIX support website where various program 
updates and help programs can be downloaded. 

Update online 
This option connects directly to the MAGIX online update page where you can get the 
latest version of your program. 

Keyboard shortcut:  Ctrl + Shift + F12 

Free download 
Opens a dialog where you can install additional program content. For example, if 
you've installed a download version of the program. 

Crossgrade Offer 
If you have purchased MAGIX Photostory Deluxe, then you are eligible for special 
offers on other MAGIX products. Follow the link to the MAGIX website to learn more. 

Product information... 
Opens the MAGIX Photostory Deluxe website.  

Deactivate Program 
This menu item deactivates MAGIX Photostory Deluxe with immediate effect. After 
deactivation, it is possible to immediately install and activate MAGIX Photostory 
Deluxe on another computer  

About MAGIX Photostory Deluxe 
Displays copyright info and version number of MAGIX Photostory Deluxe. 
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Keyboard shortcuts 

Tip: In Windows, keyboard settings are changed using the Alt + Shift key 
combination. Those who often use keyboard shortcuts can accidentally change their 
keyboard settings, so that they keys don't correspond to the pictured symbols. To 
prevent this, you can remove the check mark found by going to "Control panel" > 
"Regional and language options" > "Languages" tab > "Details" > "Keyboard" > 
"Change keyboard combination" under "Change input layout". 

Media Pool 
Delete file Del 

Copy file Ctrl + Ins  

Insert file Shift + Ins 

Rename file Alt + R 

New folder Ctrl + P 

Program settings P 

Help F1 

Select files: 

Select multiple sequential images: Shift-click on the first and last file 
you wish to select 

Select multiple individual pictures: Ctrl-click on the images 

Select all images of the opened folder: Ctrl + A 
 

Slideshow 
Load/Save project 

New project Alt + Ctrl + N 

Load project Alt + Ctrl + O 

Save project Alt + Ctrl + S 

Save project as... Alt + Shift + S 

Delete project Alt + Shift + O 

New slideshow Ctrl + N 
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Load slideshow Ctrl + O 

Load restoration slideshow Alt + O 

Save slideshow Ctrl + S 

Save slideshow as... Shift + S 

Close slideshow  Shift + O 

Delete slideshow Shift + I 

Burn backup copy to disc Alt + Shift + R 

Recording 

Audio recording R 

Tools 

Select all (not in Storyboard mode) Ctrl + A 

Cut Ctrl + X 

Copy Ctrl + C 

Paste Ctrl + V 

Undo Ctrl + Z 

Redo Ctrl + Y 

Delete Del 

Slideshow Maker W 

Optimize photo Shift + X 

Audio cleaning Shift + W 

Create title Ctrl + T 

Cut 

Split object T 

Remove object beginning D 

Remove object end U 

Split slideshow Alt + W 
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Effects 

Edit photo Shift + Y 

Zoom 2 Ctrl + Alt + 1 

Zoom 3 Ctrl + Alt + 2 

Free zoom selection Ctrl + Alt + 3 

Fix image proportions Ctrl + Alt + 4 

Reset section Ctrl + Alt + 5 

Rotate to left  Ctrl + Alt + F 

Rotate right Ctrl + Alt + G 

Rotate 180 degrees Ctrl + Alt + H 

Transition (length) Alt + L 

Apply transition to all Alt + A 

Random transition Alt + Z 

  

Color shift 1/2/3 Shift + 1/2/3 

Reset video effects Ctrl + C 

Object properties  Ctrl + E 

Arrangement display 

Switch Storyboard/Timeline mode Tab 

Optimize view Shift + B 

Zoom range between start and end marker Ctrl + 1 

Zoom the entire slideshow Ctrl + 2 

Zoom image  Ctrl + 3 

Playback and marker placement 

Start/Stop playback Space bar, cursor up 

Stop at position (stop playback, move start 
marker to current position)  

Escape, Cursor down 
0 on the number pad 

Move start marker to the beginning Home 
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Move end marker to the end  End 

Slow wind left Left 

Slow wind right Right 

Fast wind left Ctrl + Left 

Fast wind right Ctrl + Right 

Full screen playback Alt + Enter 
 

Zooming 
Zoom Ctrl + mouse wheel 

Reset zoom (100%) Ctrl + double click 

Move section with the mouse Ctrl 

Full screen playback Alt + Enter key 
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Activate additional functions 
You can activate encoders/decoders for various file formats as required. 

Why is activation required? 
To import (decode) or export (encode) certain video and audio formats you will 
require a specific codec to be able to read in and export these formats. As soon as a 
corresponding decoder or encoder is needed, MAGIX Photostory Deluxe will notify 
you and ask you if you would like to activate it.  

The integration of decoders and encoders from third parties into programs usually 
costs the software publisher money. These codecs are therefore added to 
MAGIX  programs via a voluntary activation, which may be free or require a charge 
for expensive specialist codecs. It is therefore possible for MAGIX to provide an 
optimum price/performance ratio for your software in the future. 

Free activation (MPEG 2 & 4 codec) 
To be able to use the MPEG-2 and MPEG-4 codec, you will have to first activate it for 
free. 

Activation can be done online via telephone or via post/fax. The quickest and easiest 
way to order an activation code is via the Internet. 

Order activation code online 

Click on "Order online..." (Field 1). Your Internet browser will open. Once you have 
registered, the activation code will be sent to the email address you supplied upon 
registration. 

If your computer has no Internet access, you have the following options for activation: 

Order activation code in MAGIX Service Center 

Use this option to conduct activation from a different computer which has Internet 
access. 

Order activation code via telephone 

The telephone number and necessary details you will need to call to receive activation 
by telephone are displayed here. 

Order activation code via post/fax 
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After clicking on "Order via post/fax" (field 2), your user code will appear. This 
automatically assigns your personal activation code to your PC. Click on "Continue to 
order form" to transfer your user code automatically to the post/fax form. Now send 
the completed form as a print out to the address/fax no. mentioned.  Your activation 
code will be sent to you in just a few days via post or fax. It can also be sent by mail if 
an email address is state d. 

Enter activation code 

After receiving your personal activation code, you can use the activation dialog for the 
corresponding file format to start exporting for the respective format. if you receive the 
activation code via email, then copy it into the input field in the dialog and click  
"Activate...".  

Activate HEVC (fee-based) 
The HEVC codec requires a one-time, fee-based activation to be used. 

You will be asked to activate HEVC the first time you import a video created with the 
codec or export a project with the codec.   

1. Click "To the shop" if you want to activate the codec online. (Alternatively: Click 
"By Post/Fax..." to receive an activation code by post or email and follow the 
instructions that appear.) 
When activating online, the web browser where you can register your 
MAGIX Photostory Deluxe first (if you have not already done so) will open. You 
will then be forwarded to a website where you can request the corresponding 
activation to be carried out. 

2. Enter the requested information and complete the order. 
Normally you will receive the activation code within a few minutes. In some cases, 
this can take longer. 

Note: In the event the activation code does not arrive after a longer period of time, 
check to make sure the e-mail was not accidentally sent to your spam folder. 

3. Copy the activation code from the e-mail. 
4. Enter the activation code into the input field in the activation dialog. 
5. Click on "Activate...". 

The codec will be activated and the feature is now available in MAGIX Photostory 
Deluxe. 
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Activation problems 
The MAGIX website won't open 

Check your Internet connection; you may have to use manual dial-up. 

The form for ordering via post/fax won't open 

• Check that an adequate text editing program is installed and activated (for 
example, MS Word). 

I still haven't received an email with the activation code 

• Check that your inbox isn't full. 
• Have a look in your spam folder. 

You can always send questions via email to our support whenever you like. Please 
have the following information at hand so that we can assist you as quickly and as 
specifically as possible. 

• Complete product name 
• Exact version number (to be found in the about box in the "About" menu item of 

the "Help" menu) 
• Encoder/Decoder name 
• Your user code (accessible via the "Activate via post/fax" dialog) 

Problem: I have installed MAGIX Photostory Deluxe on a new computer, installed a 
new hard drive in my old computer (sound card, memory...), or installed it multiple 
times on the same computer. My activation code is no longer accepted! 

If the program cannot be activated again after it has been activated multiple times, 
please contact the MAGIX customer service. 
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Encoder 

MPEG-2 encoder settings (Standard) 
In the "Advanced Settings" you can make detailed adjustments to the MPEG-2 data 
flow. 

The advanced settings are divided into "Video", "Audio", and "Multiplexer".  

Video 

Tip: For more information read the MPEG glossary (view page 199). Many of the 
terms used here are explained in detail in the glossary. 

Bit Rate Mode: The bit rate indicates how much data is saved in the video per second 
(at playback speed). This makes the bit rate the deciding parameter with regard to the 
file size and quality of the video to be encoded. A higher bit rate means better quality, 
but also a larger file size. 
• Constant: The exact value entered in "Average bit rate" is applied which enables 

precise calculation of the video size.Constant: The exact value entered in 
"Average bit rate" is applied which enables precise calculation of the video size.  

• Variable: The value entered in "Average bit rate" is used as an approximate 
guideline for the value applied to the video. This means that the size of the video 
can only be estimated. 

• Constant quantization parameter: This parameter ensures that the video quality 
remains the same throughout. 

Average bit rate (kbps): The bit rate entered here is used as the average rate applied 
to the video. The size of the video to be exported can only be approximated. 

Maximum bit rate (kbps): This is the maximum bit rate for the video stream, i.e. the 
maximum number of bits the decoder is allowed to transfer per second. This 
parameter only takes effect in the "Variable" bit rate mode. 

CPB (Coded Picture Buffer): The entered value specifies the maximum amount of 
storage space for an encoded frame. Higher values can improve quality, but might also 
cause problems during export. If export is aborted, lower this value. The setting "0" 
means that the encoder has determined the disk space. 

Maximum GOP length: The maximum GOP (view page 201) length is determined 
here. High values mean improved compression. Lower values create stronger security 
protection and enable improved access to individual frames for processing the video. 
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Tip: A good rule of thumb is to enter the frame rate as the GOP length. 

GOP structure: The GOP structure is the sequence of the various frames. At the 
beginning of a GOP there is an I-Frame, at the end there are several B-Frames, 
followed by a P-Frame (view page 203). The sequence of B-Frames und P-Frames 
repeats until the end of the GOP. 

Example: A GOP with a length of 20 and the "IBBP" structure will look like this: 

No. 1 2 3 4 5 6 7 8 9 10 11 12 13 14 15 16 17 18 19 20 

Frame I B B P B B P B B P B B P B B P B B P B 
 

Profile: Profiles define the encoder properties that are supported. 
• SIMPLE: Intended to be used as the basic profile for applications with limited 

computational power, e.g. video conferences or mobile phone videos. This profile 
does not allow B-Frames, which first and foremost means more data traffic, but 
contributes to better reliability.  

• Main: This profile was originally intended for the broadcast industry and for 
backup purposes. It has become less popular since the development of the "High 
Profile" for this purpose. 

• HIGH: This profile is used for broadcast and backup applications and is also 
sometimes used in the HDTV industry (High Definition Television). This profile is 
used for Blu-ray discs. 

Note: You should only change this setting when there are problems playing back the 
generated video. 

Level: MPEG 2 defines various levels. The level determines which bit rate and 
resolution are possible for the video. With the "Auto level" option, the encoder 
determines the level automatically on the basis of the set video format, the specified 
bit rate and the profile. 

Coding quality: This is the easiest way to set the ratio between coding duration and 
quality. Select the setting which best suits your needs. 

Hardware acceleration: MAGIX Photostory Deluxe supports the use of "Quick Sync 
Video" hardware acceleration. This can noticeably speed up the encoding process. 

Smart Copy: If this option is activated, unedited MPEG 2 material with hard cuts is 
transferred without changes. This drastically accelerates the encoding process. The 
transfer always takes place on the GOP borders is not frame-precise. 
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HRD (Hypothetical Reference Decoder): When this option is activated, a virtual 
decoder checks the data stream for compatibility with the video standard during the 
encoding process. This ensures that the generated video is compatible with various 
playback devices, but it also slows down the encoding process. 

Audio 
Sample rate  (Hz): Here you can set the sample rate for audio encoding. For DVDs the 
standard is set to 48 kHz. If you change the settings here, it may result in not being 
able to play back the sound or the entire video. 

Channels: Determines the number of audio channels. 
• Mono: 1 channel, mono sound 
• Stereo: 2 channels, one for left and one for right. 
• Surround: 6 channels (5.1) 

Bitrate (kBit/s): The desired bit rate is entered here. 

Audio encoder: This is where you define how audio material will be coded, or whether 
it should be written to the exported file as an uncompressed PCM data. If PCM is used, 
you can no longer adjust sample rate and bit rate. 

Image settings 
Interlace: Specifies whether the video is coded in frames or fields (in interlaced 
scanning, also "Interlaced"). 
• Progressive 

The video is coded in frames. 
• Bottom field first 

The video will be interlaced. The lower lines (Bottom field) are used for the first 
field and upper lines for the second. 

• Top field first 
The video will be interlaced. The upper lines (Top field) are used for the first field 
and the lower lines for the second. 
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MPEG-4 encoder settings (standard) 
In the „Advanced Settings“ you can make detailed adjustments to the MPEG-4 data 
flow. 

The advanced settings are divided into "Video", "Audio", and "Multiplexer".  

Video 

Note: The preset values and status of the control element (locked/unlocked) depend 
on the selected export preset. 

Bit Rate Mode: The bit rate indicates how much data is saved in the video per second 
(at playback speed). This makes the bit rate the deciding parameter with regard to the 
file size and quality of the video to be encoded. A higher bit rate means better quality, 
but also a larger file size. 
• Constant: The exact value entered in "Average bit rate" is applied which enables 

precise calculation of the video size.  
• Variable: The value entered in "Average bit rate" is used as an approximate 

guideline for the value applied to the video. This means that the size of the video 
can only be estimated. 

• Constant quantization parameter: This parameter ensures that the video quality 
remains the same throughout. 

Average bit rate (kbps): The bit rate entered here is used as the average rate applied 
to the video. The size of the video to be exported can only be approximated. 

Maximum bit rate (kbps): This is the maximum bit rate for the video stream, i.e. the 
maximum number of bits the decoder is allowed to transfer per second. This 
parameter only takes effect in the "Variable" bit rate mode. 

CPB (Coded Picture Buffer): The entered value specifies the maximum amount of 
storage space for an encoded frame. Higher values can improve quality, but might also 
cause problems during export. If export is aborted, lower this value. 

Maximum GOP length: The maximum GOP (view page 201) length is determined 
here. High values mean improved compression. Lower values create stronger security 
protection and enable improved access to individual frames for processing the video.  
A general rule: The shorter the GOP, the more compatible the generated video file. 

Tip: A good rule of thumb is to enter the frame rate as the GOP length. 
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GOP structure: The GOP structure is the sequence of the various frames. At the 
beginning of a GOP there is an I-Frame, at the end there are several B-Frames, 
followed by a P-Frame (view page 203). The sequence of B-Frames und P-Frames 
repeats until the end of the GOP. 

Example: A GOP with a length of 20 and the "IBBP" structure will look like this: 

No. 1 2 3 4 5 6 7 8 9 10 11 12 13 14 15 16 17 18 19 20 

Frame I B B P B B P B B P B B P B B P B B P B 
 

Profile: Profiles define the encoder properties that are supported. 
• Main: This profile was originally intended for the broadcast industry and for 

backup purposes. It became less popular when "High Profile" was developed for 
exactly these applications. 

• HIGH: This profile is used for broadcast and backup applications and is also 
sometimes used in the HDTV industry (High Definition Television). This profile is 
used for Blu-ray discs. 

Note: You should only change this setting when there are problems playing back the 
generated video. 

Level:  H.264 defines different levels. The level determines which bit rate and 
resolution are possible for the video.  

With the "Auto level" option, the encoder determines the level automatically on the 
basis of the resolution of "AVC preset" video formats, the set bit rate and the profile. 

Coding quality: This is the easiest way to set the ratio between coding duration and 
quality. Select the setting which best suits your needs. 

Hardware acceleration: MAGIX Photostory Deluxe supports the hardware 
acceleration "Quick Sync Video" for AVCHD exports, AVCHD and Blu-ray discs. This 
can noticeably speed up the encoding process. 

Smart Copy: If this option is activated, unedited AVCHD material with hard cuts is 
transferred without changes. This drastically accelerates the encoding process. The 
transfer always takes place on the GOP borders is not frame-precise. 

HRD (Hypothetical Reference Decoder): When this option is activated, a virtual 
decoder checks the data stream for compatibility with the video standard during the 
encoding process. This ensures that the generated video is compatible with various 
playback devices, but it also slows down the encoding process. 
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Interlace: Specifies whether the video is coded in frames or fields (in interlaced 
scanning, also "Interlaced"). 
• Progressive 

The video is coded in frames. 
• Bottom field first 

The video will be interlaced. The lower lines (Bottom field) are used for the first 
field and upper lines for the second. 

• Top field first 
The video will be interlaced. The upper lines (Top field) are used for the first field 
and the lower lines for the second. 

AAC audio 

Note: The preset values and status of the control element (locked/unlocked) depend 
on the selected export preset. 

Sample rate: Here you can see the sample rate for audio encoding. 

Channels: Determines the number of audio channels. 
• Stereo: 2 channels, one for the left side and one for the right. 
• Surround: 6 channels (5.1) 

Bitrate (kBit/s): The desired bit rate is entered here. 

Audio encoder: Shows which audio encoder is being used. 

Image settings 
Interlace: 
• Bottom field first 

The video will be interlaced. The lower lines (Bottom field) are used for the first 
field and upper lines for the second. 

• Top field first 
The video will be interlaced. The upper lines (Top field) are used for the first field 
and the lower lines for the second. 
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HEVC encoder settings 
In the "Advanced Settings" you can make detailed adjustments to the HEVC data flow. 

The advanced settings are divided into "Video", "Audio", and "Multiplexer".  

Below is an explanation of all the settings that can be changed. 

Video 
Average bit rate (kbps): The bit rate entered here is used as the average rate applied 
to the video. The size of the video to be exported can only be approximated. 

Maximum bit rate (kbps): This is the maximum bit rate for the video stream, i.e. the 
maximum number of bits the decoder is allowed to transfer per second. This 
parameter only takes effect in the "Variable" bit rate mode. 

CPB (Coded Picture Buffer): The entered value specifies the maximum amount of 
storage space for an encoded frame. Higher values can improve quality, but might also 
cause problems during export. If export is aborted, lower this value. 

Maximum GOP length: The maximum GOP length is determined here. High values 
mean improved compression. Lower values create stronger security protection and 
enable improved access to individual frames for processing the video.  
A general rule: The shorter the GOP, the more compatible the generated video file. 

Tip: A good rule of thumb is to enter the frame rate as the GOP length. 

GOP structure: The GOP structure is the sequence of the various frames. At the 
beginning of a GOP there is an I-Frame, at the end there are several B-Frames, 
followed by a P-Frame. The sequence of B-Frames und P-Frames repeats until the end 
of the GOP. 

Level: HEVC defines various levels. The level determines which bit rate and resolution 
are possible for the video. With the "Auto level" option, the encoder determines the 
level automatically on the basis of the set video format, the specified bit rate and the 
profile. 

Coding quality: This is the easiest way to set the ratio between coding duration and 
quality. Select the setting which best suits your needs. 
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Audio 
Sample rate: Here you can see the sample rate for audio encoding. 

Bitrate (kBit/s): The desired bit rate is entered here. 

Multiplexer 
Streamable: The generated video is suitable for live playback on websites. 

HTML Start file: MAGIX Photostory Deluxe generates an HTML file with a video 
player that opens the HTML file and plays it back. 

MPEG glossary 
Motion estimation 
Motion estimation is a further element for reducing data used in MPEG encoding.  

Motion estimation also occurs in the B and P frames. The image difference that still 
exist after prediction (view page 203) are examined. Complex algorithms are used to 
search for an original occurrence of the macro block in the reference frame of each 
macro block of the P or B frame (these are units of 2x2 blocks specially combined for 
this purpose), which have been moved either by movement or by camera pan. They 
can then be left out in the P and B frame. Only the information by how far and to where 
the macro block has been moved is saved instead. This vector is called the motion 
detector. 

In the General encoder settings, you can specify the quality of the final MPEG video. 
This factor also influences the time required for encoding. The longer it takes, the 
better the quality. 

Bit rate 
MPEG is a format used for storage and transferring. With older formats (e.g. AVI) you 
could predict that 20 seconds of movie would result in 20 MB of data. The file size is 
this a direct measurement of quality.  

This is different for MPEG: The amount of data available can be used differently for 
different display modes. 20 MB can be 4 seconds of DVD Video or 5 minutes Internet 
streaming in thumbnail format. The quality of an MPEG video is measured by the 
width of the created data stream, the bit rate. This is the amount of the transmitted 
data per time unit; it is stated in kBit/s or bit per second. 
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Bits, not bytes are used, since the data word width has to address the transmission 
restrictions. 

The file size can be calculated from the average bit rate, if its length is known: 

F = (BRV + BRA) * t 

F=File size BRV= 
Video bit rate 

BRA= 
Audio bit rate 

t=Length in s 

 

Block 
For almost all image file editing techniques the image is subdivided into 8 x 8 pixel 
blocks (image points). This should be noted if you would like to used user-defined 
image resolutions (width/height), and they should always be a multiple of 8. 

Chroma format 
The color value of each image point consists of the color values for the primary colors 
red, green, and blue (RGB), and for traditional and technical reasons it is transformed 
into one brightness value (Y = 0.299*R = 0.587*G + 0.114*B) and two color difference 
values (U = R - Y, V = G -Y). 

The Y value alone produces the black and white picture. These signal components 
allow brightness and color information to be handled separately. The first data 
reduction occurs  when single rows comprising a picture are read. Because the 
human eye has a lower color resolution than a brightness resolution, the color 
components are recorded only for every other point of a row (4:2:2) for each four 
pixels grouped (4:1:0), i.e. color signal under-reading. 

4:2:2 This corresponds to the established TV standard. One piece of color information 
is transmitted per row for two pixels which corresponds to a 2/3 compression of the 
output data. 

4:1:0  This is the color coding used for DVDs and most other consumer video 
applications. For each 4 pixels grouped together on two rows, one unit of color 
information is saved. This corresponds to a output data compression of 1/2. 

Field 
A half-image, i.e. two halves which combine to produce a frame (see de-interlacing 
(view page 202)).  
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Frame 
A frame is a single image from a video sequence which also called a full image. PAL 
video, for example, contains 25 frames per second, NTSC 29.97 frames.  

Video recordings, with the exception of computer animations and still frames, don't 
contain full images. Instead, they have double numbers of half-images (fields) which 
are transmitted in an interlaced state. However, we still refer to frames, since many 
predecessors of MPEG compression are based on such frames. Video editing literature 
usually refers to frames. 

GOP 
Group of Pictures: The sequence of I frames and the P and B frames that belong to 
them. 

e.g. I B B P B B P B B I ... 

(This GOP has a length of 9, with 2 P frames and 2 B frames) 

I frames contain the entire image information of a frame, while P and B have part of the 
information. So-called prediction (view page 203) and movement approximation are 
methods used for reduction. 

The combination P B B is called a subgroup. 

I frames must appear in regular intervals in the data stream for image and sound to be 
synchronized. Between the I frames only a limited count of P and B frames is allowed. 
This explains a few things: Since P and B frames contain only differential information, 
these differences will be larger with time, since more and more changes takes place 
from frame to frame. A large count does not make much sense, since GOP has a 
maximum length of 15 (4P, 2B) in PAL and 18 (5P, 2B) in NTSC. (More than 2 B 
frames between P frames is not allowed). 

In a closed GOP, B frames of the last subgroup may contain only backward predictions 
or references to the preceding P frame, but no references to the following I frame, 
since it belongs to the next GOP. 

I frames 
Intra-frames: In these pictures, the entire image information of a frame is saved and 
only information from this frame is used ("intra-frame encoded"). In contrast to the I 
frame, P and B frames save only the differences between the current frame, and 
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preceding and/or following frame are also found in MPEG video (P frame = "predicted 
frame", B frame = "bidirectional frame", see Prediction (view page 203)). 

Interlace 
For historical reasons, pictures in a movie are always recorded and transmitted in the 
form of two fields, first the lines with even numbers and then those with odd numbers. 
These fields are alternatively displayed with a double-frame rate. The (lazy) eye of the 
viewer or the processing of the TV tube puts the two frames together to form one. 

   

The output image First field Second field 

You normally don’t have to worry about field processing. The video material goes 
through the entire processing chain as fields and is exported again as fields or burned 
onto DVD or shown on TV when played back on a DVD as a full picture. Only in 
certain rare conditions is it necessary to delve deeper into this process. Two problems 
can occur: 

Interlace artifacts 
To be displayed on a computer monitor the two fields must be combined to form a full 
screen.  

These two fields are not the same, since two fields are created during the recording 
(between which a 1/50 of a second gap is evident). Moving objects can therefore 
produce artifacts at the vertical edges. 

  

Typical interlacing errors 

You can use so-called "de-interlacing" to avoid these artifacts. A picture in between 
the two fields is created (interpolated). So if you want to create stationary pictures 
from movies, then you should definitely use a de-interlace filter. 
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Incorrect field rate 
If you move around the series of fields in a movie data stream you can see strong jitter 
and flicker effects. Picture objects move in a backward movement - two steps 
forwards, one back - since a delayed field is shown before the previous one. This can 
happen in the processing chain if you export video material improperly with the wrong 
field order and then import it into different material.  

We use MXV or MPEG "Top field first" format for all analog recordings ("odd" in other 
programs). DV-AVI on the other hand is saved with “Bottom Field First”.  

P frames and B frames 
P frames save only the difference between the current picture and the preceding I 
frame. The "P" comes from the term "prediction" which describes this process. 

B frames save the differences between the current picture and the I or P frame 
preceding and following. This includes the information that was the same before and 
remained the same after the current frame. Both directions are analyzed (indicates the 
"B" in the name, i.e. "bidirectional-predicted"). You can read more under prediction 
(view page 203). 

Prediction 
Prediction is a method of data reduction used by the MPEG format. The image 
elements already known from the previous or following frames are removed from the 
data stream. 

How does it work? 
The encoder has a precisely defined GOP, for example IBBPBBPBB. This sequence is 
transmitted together with the encoder, which always knows exactly which kind of 
frame comes next. I, P, and B frames are differentiated. 

Hint: When we talk about pictures, we mean frames of the video output, and I, P an 
dB frames are the frames of the encoded video. Just as in movement approximation, 
blocks (8x8 pixels) are united into macroblocks (16x16 pixels) during prediction. 

The first frame is always the I frame. It is completely encoded from the first picture. 
Afterwards, the 4th picture is analyzed for the creation of the first P frame. (As already 
said, the encoder, and later the decoder, will know that two B frames belong between 
them.) This image will also be completely encoded, and afterwards all macroblocks 
that haven't changed in comparison to the I frame will be deleted. They will be 
replaced by corresponding references for the decoder that tell it "you already know 
what should be shown here, and you can get it from the last I frame". 
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Now, the 2nd will be completely encoded, and all macroblocks identical to the first I 
frame and the following P frame will be removed. References to previous frames  are 
called backward predictions, and references to following frames are called forward 
predictions. The third picture will be edited in exactly the same fashion. 

The fourth picture we have already explained, and now we need the next P frame, or 
picture number 7. Pictures 5 and 6 are B frames again, which are compared to P 
frames to both sides of them (picture 4 and 7); these are followed by the last two B 
frames. These have a special place, since in closed GOPs, they may contain only 
backward predictions, and no references to the next I frame, because it belongs to the 
next GOP. 

Something else: Since the decoder is no prophet, the P frames are always transmitted 
before the B frames! The GOP explained above will be encoded and transmitted in the 
order it is written. 

Original 
GOP 

I0 B01 B02 P01 B11 B12 P02 B21 B22 I1  

Data stream I0 P01 B01 B02 P02 B11 B12 B21 B22 I1 ...  for closed GOPs 

 I0 P01 B01 B02 P02 B11 B12 I1 B21 B22 P11...  For open GOPs 

Due to this nested structure, it is easy to see that during direct editing of MPEG 
material, complicated computations have to take place! These are made easier using a 
frame table. A frame table contains a list, where the information of every frame in the 
data stream is found, identifying the type of frame it is.  

Using Movement prediction (view page 199) P and B frames are likewise reduced. 

Quantization scaling 
The single pictures in MPEG are saved using a compression method comparable to 
JPEG with bitmaps and associated with quality loss. For this single images are divided 
into 8 x 8 blocks (view page 200). 

Each one of these blocks is then transformed into an 8 x 8 matrix (a table with rows 
and columns) using a DCT (discreet cosinus transformation) mathematical method. 
Each of these values is produced using all 64 individual pixels of the block, but the 
values in the matrix are ordered in such a way that the image information is ordered 
according to its importance. 

This matrix will then be multiplied by another matrix, i.e. the quantization matrix. 
Exactly how and why this matrix must be created is the biggest secret of encoder 
programmers, since this determines the quality of the whole encoding process. What 
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is known is that the result should contain as many zeros as possible! These zeros 
correspond to the "unimportant" image elements mentioned and will not be 
transmitted in the data stream. 

Depending on the encoder parameters regarding the target bit rate, fewer or more 
values of the matrix will be declared unimportant by dividing the quantization matrix 
by the quantization scaling factor. Since only whole numbers are used, a division can 
produce a zero is the remainder is discarded. 

This factor is also a direct measure of the sought image quality of the MPEG data 
stream, since the "Q" in "Q" factor stands for quantization and quality. 
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Annex: Digital Video and Data Storage 

HDTV 
This acronym stands for "High Definition Television. 

High definition television is a general term applied to a series of television norms that 
differentiate themselves from normal television by increased resolution and an altered 
aspect ratio (16:9). This type of digital television offers cinema-like image quality and 
impressive sound quality. With doubled horizontal and vertical resolution the image 
quality of HDTV is approximately four times as sharp as previous standards (PAL, 
NTSC, SESAM). 

At this time MAGIX Photostory Deluxe supports two resolution standards: 

• 720p (1280x720 pixel) 
• 1080i (1920x1080 pixel) 

MPEG Compression 
MPEG means "Moving Picture Experts Group" and defines a workgroup which 
cooperates with the International Standards Organization (ISO) as well as the 
international Electro Technical Commission (ETC) to develop standards for video and 
audio coding.  

Generally, the graphic data rate of the digital video standard is 167 megabits per 
second, which, when not compressed, requires a far higher storage capacity than a 
DVD can offer. A one-sided DVD 5 with 4.7 GB storage capacity is enough for 4 
Minutes. For this reason, the available pictorial material must be effectively 
compressed – a function which is achieved with the MPEG procedure. 

This procedure is based on the simple fact that up to 96% of digital video data 
consists of repetition and can be compressed without visible degradation of the 
pictorial quality.  

Each MPEG compression is, however, a data reduction and as such connected with 
information loss. If the video consists of very extensive details, or if the content 
changes very fast, then the picture may blur (dependent on the strength of the 
compression and the quality of the encoder). 

Errors can also result from so-called compression artifacts such as small color defects 
or images that are too dark.  
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At average compression rates under 3 megabits per second it is probable that you will 
notice reduced quality. At rates around 6 megabit per second the degradation in 
quality becomes almost invisible.  

General notes on AVI videos 
The AVI format (Audio Video Interleaved) isn't actually a proper video format! Rather, 
it is a so-called "container", where the conventions for transferring audio and video 
files to the program are only loosely defined. The codec (coder/decoder) actually 
defines what storage format is used. A codec compresses audio/video data into its 
own unique format which can only be read by the codec itself and is decoded when the 
film is played.  

In concrete terms, a computer-generated AVI file can only be loaded by and played on 
a different computer if the same codec is installed on it. 

Many codecs (e.g. Intel Indeo® video) have now become standard components of the 
Windows installation. Others are not standard. If you are generating an AVI file for 
future play on another computer using one of these codecs, you should first install this 
codec on the other PC. The best method available is to copy the codec installer to your 
export directory and burn it every time you create a video disc (slideshow disc) for 
play on computers. 

You may encounter some problems when using older video editing cards with codecs 
which only function with the card’s hardware. Such AVIs can only be used on the 
computer which was used to create them. Try to avoid using this kind of codec. 

Digital Versatile Disc (DVD) 
Quality 
Featuring a resolution of 720 x 576 (PAL) and encoded with MPEG-2, 25 frames per 
second provides very good results. 

Writable data storage formats 
The recordable DVD market is currently split into three types: "DVD-RAM", 
"DVD+RW", and "DVD-RW". 

DVD-R/+R: This medium may only be written to once. The DVD-R may be specified 
with file structures for DVD video, DVD audio, or DVD-ROM. 
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DVD +RW: +RW drives allow re-writable DVDs to be created which may be read by 
almost any commercial DVD-ROM or DVD player. The companies involved are mainly 
Philips, Sony, HEWLETT PACKARD (as well as Ricoh, Yamaha and Mitsubishi). 

DVD-RW: This is a write/erase DVD technology promoted by Pioneer and Sharp. This 
format was developed by the Pioneer company and should be compatible with existing 
DVD players. 

DVD-RAM: DVD-RAM technology is based on either Phase Change, MOs, or hard 
disks, etc. and is now almost 100% incompatible with all available players. 

Due to the small storage capacity and incompatibility with DVD players, setting on 
this standard is not recommended. 

Note: MAGIX Photostory Deluxe supports DVD±R and DVD±RW, but not 
DVD-RAM. 

Blank discs: Single-sided recordable blank discs featuring a capacity of 4.7 GB and a 
duration of approx. 2 hours. 

Copy Protection 
Macrovision (APS): The movie industry claims that even DVD-ROM drives and 
decoders or diagram cards with composite outputs or s-video outputs must support 
the Macrovision analog copy protection (APS). Only some older DVD players do not 
possess APS.  

APS adds additional signals to a DVD’s stored graphical data. The data is almost 
unchanged. These supplementary signals disturb the synchronization and the 
automatic recording regulation of most video recorders to prevent recording of the 
video. They are not noticeable on the television or the monitor, however. 

Content Scrambling System (CSS): CSS prevents saving and duplication of DVD video 
tracks to hard disk. The VOB streams of DVDs without CSS can otherwise (like other 
video files) be loaded via the Import Video button 

There are further types of copy protection besides APS and CSS which ensure that 
retail DVDs cannot be copied without distortion 
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Blu-ray Disc 
Since early 2008, Blu-ray Discs are viewed as successors to DVDs and offer especially 
high storage capacity of up to 27 GB in a single layer (double-layer up to 54 GB) with 
very few write errors. 

The term Blu-ray Disc comes from the blue color of the laser. Because a color cannot 
be registered as a trademark, the letter "e" was removed from the word "blue". 

The high storage capacity of the Blu-ray Disc suits high definition videos and 
slideshows in high quality perfectly, since these are characterized by large file sizes 
(depending on material approximately 40 MB/sec) and very high memory use. The 
MPEG-2 codec is used to create video. 

Companies that were involved in developing Blu-ray technology have united 
themselves into the Blu-ray Disc Association (BDA). 

Blu-ray Discs come in three varieties: 
• Only readable BD ROM (comparable to DVD video), 
• rewritable BD-RE (comparable to DVD±RW or DVD-RAM),  
• and as a disc that can be written to only once BD-R (comparable to DVD±R). 

AVCHD disc 
Use this format to create a high-resolution video. You can burn Blu-ray (BD-R/RE) 
blanks as well as conventional DVD±R/RWs. In contrast to Blu-ray Discs (view page 
209), MPEG-4/AVC codec (view page 194) is applied as the video format, which 
requires less memory at a comparable image quality. 

Compatibility 

AVCHD disc on Blu-ray blank: Since this is a BD-conformant format, the disc created 
can be played back in any conventional Blu-ray player. Playback problems can almost 
always be traced to incompatibilities between Blu-ray blanks and Blu-ray players. In 
this case, consult the instructions for your Blu-ray player or ask the manufacturer 
which blanks are compatible with the device. 

AVCHD disc on DVD blank: The DVDs created with AVCHD video are not supported 
by all Blu-ray players. The behavior of the devices is quite different. Normal DVD 
players cannot replay AVCHD discs, since the AVC format is not supported. 

For this, the playback device needs to be able to support the following formats: 
• AVCHD disc: AVCHD 1.0 
• AVCHD disc with 50p frames: AVCHD 2.0 
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If you still have questions 

Tips for Program Help 
When the program is open, you can access the Help feature by pressing F1 on your 
keyboard. The program Help contains tips on how to use the program and lots of 
additional information. Many important terms are indicated in the text in italics. Simply 
click on these terms for a more detailed explanation of what they mean. 

Context Help: Press the "F1" key on your keyboard at any point in the open program 
and Help will open with the matching help topic. 

Search function: This feature can be used to look for specific words in the Help 
section. Enter either the individual word or use logical operators (e. g. OR, AND, 
NEAR) to refine your search if you have several search words. 

• OR (between two words): all topics which contain both words or one of the 
words will be listed. 

• AND (between two words): only those topics will be listed which contain both 
words. 

• NEAR (between two words): only those topics will be listed which contain both 
words. A maximum of 6 additional words are allowed between two search 
words. 

• NOT (before a word): topics which contain this word will not be listed. 

Print: The print function can be used to print out specific Help topics or entire topic 
sections. The print button is located at the very top of the toolbar in the Help window. 

MAGIX News Center 
The MAGIX News Center features links to current online tutorials and tips & tricks on 
the software application examples. The "News" is indicated by color according to 
content:  

• Green indicates practical tips & tricks for the software 
• Yellow reports the availability of new patches and updates 
• Red for special offers, contests and questionnaires 

If no new messages are present, the button will appear gray. When the MAGIX News 
Center is clicked, all of the available information will be displayed. Click the messages 
to reach the corresponding website. 
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Glossary 
A 
audioid 
audioid is a process used to determine the title and artist name base on musical 
properties. An Internet connection is required to access the audioid database. 

AVI 
The AVI format (Audio Video Interleaved) isn't actually a proper video format! Rather, 
it is a so-called "container" for which the conventions for transferring audio and video 
files to the program are only loosely defined. More in this topic can be found in General 
notes on AVI videos. (view page 207) 

B 
Browser 
A browser (also known as web browser, or Internet browser) is a computer program 
that displays websites. The best-known browsers are Internet Explorer, Firefox, Safari, 
and Opera. 

Button 
Refers to an element of the graphic user interface of a program. The button initiates an 
action in the program via left mouse click. 

Button 
Refers to an element of the graphic user interface of a program. The button initiates an 
action in the program via left mouse click. 

C 
Cache 
Simply stated, this is a temporary folder where frequently accessed files are saved so 
that they can be quickly launched while you are working. 

CC 
CC stands for "Connectivity Co-ordination" and describes how the change of a domain 
name from one provider to another occurs (domain transfer). 
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CDA 
Short for "audio CD" produced in accordance with the so-called "Red Book" standard. 
It contains audio files (music) and can be played in CD-ROM drives as well as in 
regular CD players in stereos. 

Clip level 
Signifies the volume level at which the recorded signal is overmodulated, or "clipped". 

Clipboard 
The clipboard is used to temporarily store objects during execution of commands like 
"copy" and "cut". 

Clipboard 
The clipboard is used to temporarily store objects during execution of commands like 
"copy" and "cut". 

Context menu 
Context menu can be reached by right clicking on a selected object. It offers functions 
which are available and can be expected in the given context. 

Copyright 
Protection of intellectual and creative property against unauthorized copying. 

Copyright 
Protection of intellectual and creative property against unauthorized copying. 

CPU 
Central processing unit: The name for the main processor of the computer (CPU). 
Modern computers have even two or more processors, or one processor with several 
cores.  

D 
Dialog 
A dialog opens in a new window and lets the user interact with the program. This 
means that the dialog can present information to the user and/or expects to receive 
input from the user. 
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A dialog can contain various user elements which can be manipulated by a simple 
mouse click. Keyboard entries are also possible. 

Disc project 
A project includes everything that you want to put on your CD and DVD. This 
normally contains one or more slideshows and includes a menu structure/menu 
design which allows you to choose a slidehsow later on the CD or DVD. 

Disc types 
The disc types determines the format and medium (CD, DVD, Blu-ray disc, etc.) to 
which the current project will be burned. 

DNS 
The abbreviation DNS stands for Domain Name Service and refers to a provider of 
Internet services that registers domain names for customers. 

Domain 
A domain is the website's Internet address. It consists of the name of the Internet 
protocol (usually http://), the computer or network name (such as www), the 
second-level domain (such as magix), and the top level domain (like .com, .net). 

Altogether we have: protocol://networkname.second-level-domain.top-level-domain 
(such as "http://www.magix.com"). 

Domains are allocated by a country's so-called NIC (Network Information Center). In 
Germany the DENIC is responsible for the release of domains. 

Domain transfer 
See CC. If you already have a domain, you can move it from your previous provider to 
another provider. 

Drag & drop 
Enables files and objects to be moved freely between various applications (or within an 
application) by dragging the object and letting it drop using the mouse cursor. 
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F 
Fader 
Used for visual input of values. Similar to volume control on a mixing board, you can 
control various parameters by sliding the fader. A very common example for this is the 
zoom slider that lets you see a picture in more detail. 

Field 
A half-image, two of which combine to produce a frame (see interlace). 

Flip menu 
Drop down menus create menus consisting of lists of selectable choices. They look 
very similar to text input fields, but have a button with a downward-pointing symbol 
on the right-hand side. 

Frame 
A frame is a single image from a video sequence which also called a full image. 

A PAL video contains 25 frames per second; NTSC contains 29.97 frames. 

H 
Handles 
Handles are the five little rectangles at the edges of selected objects. All curve points 
can be moved by holding down the left mouse button. 

Length handles: Bottom right and bottom left. You can use them to change the length 
of an object. 

Transition/Fade handles: Top right and top left. These can be used to softly fade an 
object in or out. 

Volume/Brightness handle: Above-center. You can use it to adjust the volume or the 
brightness. 

Hard disk 
Storage medium with the largest storage capacity where the operating system(s), 
programs, and files are saved. A hard disk can be built into the computer, but there are 
also external hard disks which can be used with different computers via a USB 
connection (portable drives or external hard disk). 
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Hard disk drive 
Storage medium with the largest storage capacity where the operating system(s), 
programs, and files are saved. A hard disk can be built into the computer, but there are 
also external hard disks which can be used with different computers via a USB 
connection (portable drives or external hard disk). 

Hardware 
The all-encompassing name for all internal components of a computer. For example 
hard disk, graphics card, mainboard, etc. External peripheral devices are also 
considered hardware, i.e. printer, scanner, monitor, etc. The synchronization of single 
hardware components is coordinated by the software. 

HDD 
Storage medium with the largest storage capacity where the operating system(s), 
programs, and files are saved. A hard disk can be built into the computer, but there are 
also external hard disks which can be used with different computers via a USB 
connection (portable drives or external hard disk). 

HDTV 
This acronym stands for "High Definition Television. 

HTTP 
Stands for Hyper Text Transfer Protocol and is used for transferring websites onto the 
Internet (from web server to the browser). For this reason, the abbreviation http:// 
always comes before the Internet address. This is automatically inserted and does not 
have to be entered when entering the Internet address. 

Hyperlink 
Hyperlinks (or in short "links") are references to other websites/online documents (or 
other computer networks). They build the base of the World Wide Web (WWW) as it 
is only via these hyperlinks that networking or interlinking between the billions of 
website out there is actually possible. 

I 
ID3 tags 
ID3 tags contain title information that can be added to a music title. This includes the 
title, artist, album, as well as the genre, year of release, and other criteria that can help 
searching through a database. The database is created using this information. 
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Info: Title information will only be saved for MP3s in the so-called ID3 tags (Identify 
an MP3), but other formats offer similar possibilities, like "Vorbis comment" for the 
OGG Vorbis format, for example. 

Image 
An image is a representation of a CD, DVD, hard drive, or another storage medium 
that is saved as a file. 

The difference from a copy or backup is that an image contains information about the 
structure of the original storage medium, and not just individual files. This enables 
01:01 copies of complete storage media to be created. 

Caution! Copyright laws forbid copying of commercial CDs/DVDs, and for this 
reason, this process can be prohibited by copy protection. 

IMAP 
Stands for Internet Message Access Protocol and is an advanced process of receiving 
emails. 

Interlace 
Describes the creation of a full image from 2 half-images (fields). 

In this process, even and odd lines are alternately assigned to one of the two fields. 

The human eye perceives both of the projected half-images as a single full image, so 
that despite the slow image repetition rate (25 Hz for PAL, 29.97 for NTSC) a 
subjectively fluid image is seen. 

Intro 
"Intro" means the introduction or opening credits of a movie. 

J 
jpx 
A format developed by MAGIX which is used for photo editing. It enables free 
experimentation with effects without altering the original file. The effects settings are 
also displayed when the photos are opened using a different MAGIX program. 
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M 
Menu 
Menus contain practically all the program functions. They can be opened using a 
simple mouse click on the corresponding menu. Keyboard shortcuts, if available, are 
also found at the end of menu entries. 

The graphical surface of a CD/DVD will also be represented as a menu. 

Menu bar 
Almost every program has a menu bar. It can normally be found underneath the title 
line of the program. A simple mouse click opens a corresponding menu. 

MIDI 
MIDI files do not contain the actual sounds like audio files, but only the note control 
information which can be interpreted during playback by the synthesizer chip on the 
sound card or an external synthesizer. 

Motherboard 
This is the centerpiece of hardware components of a computer. All other hardware 
components like CPU, RAM, hard disk, additional drives, graphics cards, as well as 
other cards for specialized uses are connected to the motherboard.  

Motherboard 
This is the centerpiece of hardware components of a computer. All other hardware 
components like CPU, RAM, hard disk, additional drives, graphics cards, as well as 
other cards for specialized uses are connected to the motherboard.  

Motherboard 
This is the centerpiece of hardware components of a computer. All other hardware 
components like CPU, RAM, hard disk, additional drives, graphics cards, as well as 
other cards for specialized uses are connected to the motherboard.  

MOV 
MOV is a video and audio format developed by Apple, which has since become widely 
used with Windows. QuickTime supports lots of compression technology, which make 
it possible to optimize audio and video and even graphics for the Internet and 
multimedia/video applications. Conventional (hardware) DVD players are not able to 
play this format. 
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MP3 
MP3 (actually MPEG-1 layer 3) is currently the most important standard for 
compressing audio files. 

MPEG 
MPEG is short for "Moving Picture Experts Group" and refers to a committee 
concerned with the standardization of video and audio data compression as well as 
container formats. 

MS audio 
A process developed by Microsoft for compressing audio files with properties similar 
to those of MP3. 

MXV 
This is the MAGIX video format for quicker processing with MAGIX products. It offers 
very low loss of quality, but it cannot be played via conventional DVD players. 

N 
Noise Sample 
Sample of a noise that is to be removed 

NTSC (USA, Japan) 
NTSC stands for "National Television Systems Committee". This is a US institution 
that defined the first color carrier system for TV which is now used in most of America 
and some East Asian countries. 

The image repetition rate for NTSC is 29.97 Hz. 

Numeric keypad 
Also known as the numpad, or the number block. 

O 
OGG VORBIS 
This is a new, royalty-free format with similar properties to MP3. 
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P 
PAL (Europe) 
Phase Alternating Line, or PAL, is a process for color transmission for analog TV that is 
primarily used in Europe, but also in Australia, South America, and many African and 
Asian countries.  

The image repetition rate for PAL  is 25 Hz. 

Play marker 
The play marker is a red vertical line which moves from left to right during playback. It 
indicates the current play position.  

Playlist 
Arrange your songs in playlists from various sources in different formats and in 
whatever way you like, sometimes updated daily. 

Important: Playlists are only links to songs on your hard drive or in your CD drive.  

When you add a song to your playlist whose real source is a CD in your computer's 
drive, the song will no longer be playable when the CD is removed from the drive. 

Similarly, when you move a folder on your hard drive, the playlist will no longer be able 
to play the song, since the link is no longer valid.  

For the latter, however, there is a simple solution: If you know where the song has been 
saved, then you can redefine the path. A corresponding dialog window is provided for 
this purpose. You can reset the path by navigating through the Explorer folders. The 
playlist is now correct once again.  

Plug-in 
Plug-ins are additional programs that expand the functionality of the main program. 
They are inserted into the main program. 

Podcast 
Think of a podcast as something like a radio station on the Internet. Regular Internet 
radio stations "transmit" in real time, which means that you can simply listen to the 
program that's playing and edit it. Podcasting is different. The programs are 
preproduced and loaded to an Internet server for downloading. As a listener you can 
subscribe to the podcast and the files will be downloaded at a specified time for you to 
listen to them whenever you like, for example on the go via your portable player. 
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Podcasting 
Podcast is the name for a relatively new Internet transfer form. It is made up of "pod" 
from "iPod", the name of a popular portable MP3 player, and the term "casting" for 
broadcasting content to a wide group of listeners/viewers. 

A podcast is therefore something like an online radio station. "Broadcasting" web radio 
stations means you can only listen to and record the currently broadcast radio station. 
Podcasting is different. You as the listener can subscribe to the podcast and the files 
will be downloaded at a specific time and you can listen to them whenever you like, for 
example, on the move with your portable player. The shows are pre-produced and 
placed on an Internet server for download.  

POP3 
Stands for Post Office Protocol (version 3) and is used in standard email programs for 
receiving email (for example, Outlook Express). POP3 enables email to be collected by 
the provider's email server and loaded into your email program. 

Project 
A project includes everything that you want to put on your CD and DVD. This 
normally contains one or more slideshows and includes a menu structure/menu 
design which allows you to choose a slidehsow later on the CD or DVD. 

Project 
A "Disc project" includes everything that you want to put on your CD and DVD.   

This normally contains one or more movies and includes a menu structure/menu 
design which allows you to choose a movie later on the CD or DVD. 

Provider 
A provider or ISP (Internet Service Provider) offers Internet services like webhosting or 
domains (DNS). In relation to the MAGIX Website Service, MAGIX is the provider. 

R 
RAM (Random Access Memory) 
This is a hardware component of a computer. RAM is needed to temporarily save files. 
This type of storage is erased when the computer is shut down or reset. The larger this 
storage is, the faster you can work with programs to change and save files. 
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Ratio 
The aspect ratio is the ratio between the height and width of a rectangle. In practice 
these are photos, screens or projection screens. This method can also be used to 
describe the aspect ratio of pixels. 

Here are some examples of typical aspect ratios: at home 4:3, 16:9 (typical for TV 
sets), or 16:10 (widescreen flat screens, widescreen notebooks), 3:2 for 35 mm films 
and photos. In cinemas you mostly find 1.85:1 

Red Book 
Specific standards have been established for the different CD types in order to unify 
their data structure and to make them compatible with the different CD drives. Their 
names refer to the color of the books where these standards were written.   

The term "Red Book" is common language for the Compact Disc Audio Standard. The 
requirements listed here have to be observed for industrial CP production. Audio CD 
players only read CDs created according to the Red Book format. It is therefore 
necessary to first convert PC files into this format before writing them onto an audio 
disc compatible with any audio CD player. 

Restore 
Restoration of files originating from a backup is called "Restoring". 

RM 
RealMedia includes all of the media formats from software developer RealNetworks. 
RealMedia especially refers to the "RealVideo" video format and the "RealAudio" 
sound format. The quality of RealVideo files is comparably good at high compression 
rates, but does have some loss of quality. These formats cannot be played back by 
(hardware) DVD players. 

S 
Screenshot 
A screenshot is an image composed of all visible screen elements (messages, open 
dialogs, etc.) at a certain time. By pressing the "Print screen" key on the keyboard, this 
image is saved into the clipboard. Next, open a program which can edit images and 
select "Insert" (shortcut "Ctrl+V") in a new document to add the screenshot for editing 
and saving. 

Note: Press "Alt + Print screen" on the keyboard to capture the active window only. 
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Slider 
Used for visual input of values. Similar to volume control on a mixing board, you can 
control various parameters by sliding the fader. A very common example for this is the 
zoom slider that lets you see a picture in more detail. 

Slideshow 
An arrangement of various objects (photos, text, sound, etc.) is called a slide show. 
Slideshows can be saved separately as "MVM" files. 

SMTP 
Stands for Simple Mail Transfer Protocol and enables the exchange of emails across 
computer networks. 

Software 
The name for all non-physical functional components of a computer. This primarily 
includes computer programs and files that are meant to be used by computer 
programs. 

Submenu 
Along with normal entries, a menu can contain submenus that offer additional 
functions. These provide a better overview of the menus. 

Super Video CD (SVCD) 
The Super Video CD (SVCD) is a technological advancement of the video CD. SVCDs 
are also like VCD-specified CD-ROMs which can be played using either a Super Video 
CD player (connected to the television), or directly with the CD-ROM drive of a 
computer. Many DVD players can also play SVCDs. MPEG-2 and the increase of the 
data transfer rate  makes it hard to tell videos from videos in DVD quality apart. 

Resolution: SVCDs use the better MPEG-2 encoder in a standardized resolution of 
480 x 576 (PAL). The MPEG-2 format offers a maximum resolution of up to 720 x 
576 points and improved compression methods characterized by excellent image 
definition and homogeneity. 

Hard disk capacity: An average 90-minute movie must be spread across 3 CDs. On 
one SVCD you can get about 30 minutes of good-quality movie. 

Encoder setting: Compared to the VCD with 1.3, the data transfer rate is doubled to 
2.6 Mbit/s. 
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MPEG-2 format introduces the so-called variable bit rate (VBR). In contrast to the 
constant bit rate (CBR) of the MPEG-1 encoders, this encoder has the option of using 
more bits for movement-intensive sections, as well as saving bits if picture content 
remains the same. 

T 
Toolbar 
Here you will find small buttons that provide a function when clicked. For example, you 
can cut out a selected object by clicking on the scissors. 

Toolbar 
All basic functions of the corresponding program can be found here. The 
corresponding functions can be called up via mouse click. 

Top-level domain 
Top-level domains (TLD) are always those separated by a dot at the end of an Internet 
address (for example, "http://www.magix.com" < here, .com is the top-level domain). 
Among these are also country top-level domains, such as .co.uk, .us, .de as well as 
so-called generic top-level domains like .net, .org, .biz, and so on. 

Traffic 
Traffic (data transmission) occurs within your MAGIX Website Service as soon as 
data is transferred across the Internet: for example, when uploading or downloading 
files to your website or when someone else opens your website. 

U 
Universal Plug & Play; UPnP 
Universal Plug ‘n’ Play (UPnP) is a network protocol which enables data exchange 
between different devices (PCs, hi-fi systems, video cameras, PDAs, and webservers). 
UPnP allows various devices to participate in network-wide communication, i.e. the 
initialization of functions and other device functions. Long-winded configuring or 
installing of drivers is not required as the devices can handle their own functions and 
data sources by themselves. Find out more at www.upnp.org. 

Hint: To work with UPnP you have to activate it first. This can be found under 
"Options" ("Y" -> UPnP).  
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URL 
URL stands for Uniform Resource Locator and describes where a source can be found 
online (for example, a website). The address or the path to the storage location of a file 
on your computer is known as a URL. Often the term URL is used as a term for the 
domain. The URL for the MAGIX website is: http://www.magix.co.uk 

V 
VST and DirectX plug-ins 
Plug-ins are additional programs that expand the functionality of the main program. 
They are inserted into the main program. 

Two standards exist for audio editing: VST (Steinberg) and DirectX (Microsoft). VST 
has asserted itself stronger in the current market.  

W 
Wave file 
Wave (*.WAV) is a standard uncompressed audio format. 

Webhosting 
This means that an Internet Service Provider makes domains and webspace available 
to its customers. With the MAGIX Website Service, MAGIX provides webhosting to 
its customers. 

Webmail 
Webmail enables the customer to view and receive the contents of their email inbox 
without having to install email software on their computer. Customers of the MAGIX 
Website Service can use MAGIX Webmail for this. 

Webmaster 
A webmaster is responsible for the administration and maintenance of a website. 
Often, the webmaster is also the owner of the website as well as the domain that 
belongs to it. Once you have registered a domain in the MAGIX Website Service, an 
email account will automatically be set up, for example: 
"mailto:webmaster@domainname.co.uk". 

Webserver 
Webserver refers to the computer on which your host saves your website's pages and 
which makes your pages accessible on the Internet 24-hours a day. 
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WMA 
A process developed by Microsoft for compressing audio files with properties similar 
to those of MP3. 

WMV 
Windows Media Video (WMV) is a trademark video codec from Microsoft. If you 
have Windows installed on your PC, then playing WMV files shouldn't be a problem. 
Only a few (hardware) DVD players are able to play this format. Read more about this 
in your DVD player's manual. 

This video format is very good for web videos as it allows relatively high compression 
rates. 

World Wide Web (WWW) 
WWW stands for "World Wide Web" and is the most used service of the Internet. On 
the WWW, web browsers (for example, Internet Explorer) are used to display 
information via websites. The process is colloquially called "Surfing the Internet". 

Z 
Zip 
ZIP is a file format for archiving your files. The original file is reduced and then restored 
to its original size after it is unpacked without losing any quality. 
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